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Release Notes Summary

8.4.0
We are proud to announce the release of WordFast 8.4.0. This version is a minor release that introduces
improvements and addresses critical issues.

8.4.0

New Features
• No new features or improvements for 8.4.0

Known Issues
• MacOS: Issue with Catalina/Big Sur reporting keystroke logging during opening of application

• TXLF Editor column outlines get hidden when windows display settings are set to 125%
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1. Conventions
The images and topics contained in this guide are not representative of every product installation. Each product
installation is configured to meet the needs of the intended users, who may or may not require certain features
and options. Therefore, the features and options covered in this guide may differ from those available on your
product installation.

Typographical Conventions
The following table explains the typographical conventions used in this guide.

Bold Indicates user interface controls, commands, and keywords in body text.

italic Represents an input field where user input is expected.

<…> Indicates generic parameters that must be replaced by specific code or text, usually through user
input.

TYPOGRAPHICAL CONVENTIONS

Icon Conventions
The following table explains the icon conventions used in this guide.

Note:
This icon designates a note, helpful suggestion, or reference relating to the surrounding text.

Best Practice:
This icon designates a suggestion for best practice relating to the surrounding text.

Alert:
This icon designates a warning or alert relating to the surrounding text. In this situation, the user
should exercise caution to avoid an undesirable result.
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2. About Wordfast Pro
Wordfast Pro is the latest standalone, multi-platform TM tool designed to address the needs of translators,
language service providers, and multi-national companies. It offers a complete translation environment that stores
your translated content for reuse on future projects, thereby maximizing efficiency, increasing overall consistency
and reducing translation costs.

• Cross-platform compatibility — Browser-based tool runs natively on Windows, Mac, and Linux.

• Target-only Live Preview — After translation, provides a preview to proofread a target-only version with
layout and formatting.

• Segment filtering — Filters segments based on terms, regular expressions, match scores, notes, and
other attributes.

• Configure multi-lingual translation projects — Supports translation into multiple target languages and
can send as a single package or separate packages based on language pairs.

• Export and import translation packages — Allows configuration and export of translation packages for
fast, seamless translation management.

• Format flexibility — Supports virtually any file format, including MS Office, Adobe InDesign, FrameMaker,
PDF, HTML, XML, SDL Trados Xliff, MemoQ Xliff, and more.

• Chain files — Allows combination of multiple files into a single file to improve the consistency of repeated
segments and facilitate file management.

• Unlimited TM and glossary access — Accesses an unlimited number of TMs and glossaries
simultaneously and prioritizes as primary or secondary.



 

Copyright © Wordfast, LLC 2023.   Page 10 of 236

3. Get Started
This section provides basic information to get started with Wordfast Pro, a stand-alone desktop application you
install on and access with your local computer.

System Requirements
Supported Operating Systems Microsoft Windows 7+ 64-bit, Mac OS X 10.11+ 64-bit, and Linux 64-

bit

Java Runtime Environment If not present, Wordfast Pro automatically installs Java Runtime
Environment during the application installation process

License and Registration Activation of the full Wordfast Pro installation requires a license and
registration

Minimum System Memory 4 GB RAM

Minimum Screen Resolution 1366 x 768 pixels

Installation
Activation of Wordfast Pro requires a license and online or offline registration.

 An unlicensed version of Wordfast Pro working in Demo mode is limited.

• You can only create bilingual projects.

• You can only store up to 500 translation units (TUs) in a Translation Memory (TM). To remove
this restriction, purchase a license and activate the licensed application.

To install Wordfast Pro:

 1. Download the Wordfast Pro Windows Installer Package from www.wordfast.com, based on your operating

system.

 2. In your Downloads folder, double-click the .MSI, .DMG, or .TGZ file to open the Wordfast Pro Setup Wizard.

 3. Complete all steps to align with your configuration, then click Finish.

Wordfast Pro opens in Demo mode. It still requires manual or online activation. Refer to Activation.

Activation
You can activate Wordfast Pro either manually or online. Both methods require an activation key. When you
purchase a Wordfast license, you can generate an activation key at www.wordfast.net by logging in with your
login email and password. Copy and save the activation key.

To activate Wordfast Pro:

 1. Open Wordfast Pro.

http://www.wordfast.com/
http://www.wordfast.net
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2. On the Sidebar, select the Open General icon  to open the Wordfast Pro 5 application dialog.

 3. Select Online Registration or Manual Registration, then follow the activation instructions.

Option Description

Online Registration Enter the Activation Key, then select Activate.

Manual Registration 1. Enter the Activation Key, then select
Generate.

2. Copy the generated text into an email and send
it to the email address provided on the screen.

3. Save the license file from the return email.
4. Select Browse to the license file.
5. Select the license file, then select Activate.

 After you activate the software, you can select either registration option to view the number of days
remaining on your license.

 4. Restart Wordfast Pro.

The Wordfast Pro activation process is complete.

 

To resolve any license issues, select the Open General icon , then select Feedback.
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Licensure
You can view license information after you have activated Wordfast Pro.

On the Sidebar, select the Open General icon  to view product information, your current license
information, Wordfast Pro update info, and to provide application feedback.

 Wordfast Pro automatically monitors for updates. If an update is available, you receive notification
after you open the application.

Option Description

About Use to review product information, including your current version number.

Online Registration Use to activate your Wordfast Pro license online.

Manual Registration Use to manually activate your Wordfast Pro license through e-mail.

Update Wordfast Pro Use to check for updates to the application and to add languages for the
application's Hunspell spelling dictionary.
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Option Description

Feedback Use to send feedback about software issues. Be as specific as possible, providing
the exact steps you took when the issue occurred. When sending feedback from the
Wordfast Pro desktop, the values from Name and Your Email are remembered and
saved after sending the report.
Please do not submit software usage questions to Feedback.

For software usage questions, select the Help icon  to review the online help. If
you still have questions after reviewing the online help, log in to your user account
at www.wordfast.net and submit a Hotline request.

Start Wordfast Pro
After you install and activate Wordfast Pro, it is ready to use.

To start Wordfast Pro:

 1. Double-click the Wordfast Pro icon on the desktop or select Wordfast Pro from the Windows Start menu.

Wordfast Pro opens to the Project List view.

 2. (Optional) Select another view if you have created a project and are ready to begin translation or review.

http://www.wordfast.net
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4. Explore the User Interface
Wordfast Pro allows users to coordinate and automate the translation and review process through an intuitive,
stand-alone user interface.

Wordfast Pro uses a Sidebar to navigate among views. Click the icons to change from one view to another.

Sidebar Icon Action

Click to open the General view.
The General view includes general product information, as well as a form to
provide product Feedback.
In Wordfast Pro, you will also find product registration and software update
information here. See Activation or Licensure for more information.

Click to open the Project List view.

Click to open the Current Project view.

Click to open the TXLF Editor view.

Click to open the Quick Tools view.

Click to open the Preferences view.
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Sidebar Icon Action

Click to collapse the Sidebar. This action hides the icons and increases the
workspace.
Click  to expand the Sidebar.

The default view is the Project List view. 

When you begin working on a project from the project list, the result is the Current Project view. 

Each view is explained in more detail in the subsequent sections.

Project List View
The Project List view displays a list of your active projects.

Item Action

Sidebar Click icons to switch among user views. User views include General application
information, Project List, Current Project, TXLF Editor, Quick Tools, and
Preferences.

Action Button Perform a specific task.
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Item Action

Action Bar Access all action buttons associated with a specific user view and tab.

Project List View all files associated with a specific project.

Current Project View
The Current Project view displays a list of the TXLF files that are included in a selected project. Double-click a
file from the list of TXLF files to open the TXLF Editor.

Item Action

Sidebar Click icons to switch among user views.

Menu Tab Access the various tools of the application. Each user view contains different
tabs.

Action Button Perform a specific task.

Action Bar Access all action buttons associated with a specific tab.
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Item Action

Collapsed Items Access any remaining tools that do not fit in the window.

File Filter Create filter criteria to refine the file list.

Language Pair Access the file list associated with a specific source and target language pair.

File List Access a specific file within the language pair.

Project Progress Bar View the percentage of work completed on a project.

File Progress Bar View the percentage of work completed on a file.

You can view file information, filter criteria, and sort files using the provided search options.

Item Action

Files Lists the files available in the current project. Type a file name in the box to
locate a file in the project list.

Word Count Displays the total word count of each file in the project.

TXLF File Location Displays the directory path to the stored file location. Type a path name in the
box to locate a file or to group files in a particular path.

Creation Date Displays the date and time the file was created based on the user's system
settings.

Last Saved Displays the date and time of the most recently saved the file.

Complete Displays the file progress bar with completion percentage.

Clears filter criteria.

Sorts filter criteria in ascending or descending order.

Change the sort order. The sort options are Files, Word Count, Translations
Status, Complete, and Last Saved.

TXLF Editor View
The TXLF Editor view is your default translation and review workspace.

You can choose from two layouts for your TXLF Editor workspace.

• Table view—This layout displays the source segment to the left and the target segment to the right.

• Stacked view—This layout displays the source segment row directly above the target segment in a
spanned row.

You can select either layout view by selecting the drop-down menu for the Switch Editor Layout action on the
File tab.
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Item Action

Sidebar Select the icons to switch among user views.

File Name Tab View an open or chained file.

Action Button Perform a task.

Menu Tab Access a specific function and its Action Buttons.

Filter Bar Filter how segments are sorted and displayed.

Action Bar Access all Action Buttons associated with a specific tab.

Table Filter Create filter criteria for searching in the open file.

Collapsed Items Access any remaining tools that do not fit in the window.

Preview Pane View the translated content in its original format for MS Word .DOC
and .DOCX files, MS PowerPoint .PPT and .PPTX files, Markdown .MD
files, MS Excel .XLS and .XLSX files, or JSON .JSON files.

Editor Pane Access editor tab content or interact with it using menus and sub-menus.

Source Column View numbered text segments that will be translated in the Target Column.
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Item Action

Target Column Use as primary work area for translation entry with or without leveraging a
translation memory (TM).

Terminology Pane Search the source or target glossaries, or add terms to terminology
glossaries, if enabled.

Segment Score Column View the TM match score represented as a percentage.

Status Column View the status of a segment by its status icon.

Segment State Column View the state of the translated segment. Toggle between Needs
Translation and Translated.

Progress Bar View the progress of the total translation based on the number of
translated segments. If you have chained files, the percentage includes all
the segments in the chained file.

 When the Preview, Editor, or Terminology panes are resized, Wordfast will remember the settings the
next time it is run.

TXLF EDITOR VIEW

Filter Criteria
Use filter criteria to narrow your search for segment content.

Option Action

Source or Target Select from drop-down menu to search source, and or target segments, or
user attributes.

Match Case Make your search case-sensitive.

Regex Select to search on regular expression or wild card characters.

Text Filter Filter segments based on text search.

Activate the filter action.
Activate the cumulative filter action for all search fields.
Reset the toolbar filter fields.

Sort Select from drop-down menu to order the remaining search list.

Configure the maximum word count for the segment filter.

Special Filters are a drop-down list of all available search filter criteria:

• 100% match segments: segments matching completely in the TM

• Aligned segments: segments that contains aligned score coming from aligner tool

• All except 100% and Context match segments: segments with partial TM match, no match, or modified
segments
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• All except 100%, Context match and Auto-propagated segments: segments that are modified, fuzzy,
MT, no match, Align and Client provided scores

• All except 100%, Context match and Translated segments: segments that are fuzzy, modified, MT, no
match, Align and Client provided scores with state Needs Translated Segments

• All except 100%, Context match and Auto-propagated and Translated segments: segments that are
fuzzy, modified, MT, no match, Align and Client provided scores with state Needs Translated Segments

• All except Duplicate segments: will show one instance of repeated segments

• All except auto-propagated: all statuses except the segments that are auto-propagated

• Auto-propagated segments: all auto-propagated matches

• Client provided segments: segments provided by the client TM

• Committed segments: segments with translated content committed to the TM

• Context match segments: all 100+% context matches. Context matches provide more refined matches
that are based on contextual references in the TM. For example, a segment is considered a context match
when the previous and next segments also have a 100% match against the TM.

• Do not write to TM segments: this is a status in editor to mark segments that should not be written to TM

• Duplicate segments: segments being duplicated in the file

• Edited 100% match segments: segments that contains 100% matches that are edited

• Edited context match segments: segments that contains context matches that are edited

• Edited fuzzy match segments: segments that contains fuzzy matches that are edited

• Edited MT segments: MT segments that have been edited

• Edited source segments: source segments that have changed

• Empty target segments: segments without a translated target

• Excel Sheetname Segments: segments that contain sheetnames from an Excel file

• First instance of Duplicate Segments: shows first instance of a segment that has more than one segment
with the same source

• Fuzzy match segments: segments with partial TM match

• Locked segments: segments that cannot be edited

• Merged segments: segments that have been merged

• Modified segments: all modified segments. By default all modified segments are highlighted in pink

• Needs translation segments: untranslated segments

• No match segments: segments with no match in the TM

• Reviewed state segments: segments marked as reviewed

• Segments merged across paragraph: segments have been merged across a paragraph

• Segments with Transcheck warnings: segments with Transcheck warning status

• Segments with history: segments that have been edited and has a segment revision history viewable in
the Segment History tab

• Segments with notes: segments containing comments

• Segments with repetitions: segments with repeated text strings

• Segments with tags: segments that contain tags

• Short segments: segments of fewer than {#} words, paragraphs or other blocks

• Signed off state segments: segments are signed off

• Split segments: segments that have been split into more than one segment due to length

• TU Autocorrected Segments: segments that have a target have replacement TUs applied
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• Translated state segments: segments that have been translated

• Unedited MT segments: Machine Translated segments that are unedited

• Unique segments: segments that are not repeated

TXLF EDITOR VIEW

Segment Status
You can quickly identify the status of a segment in the TXLF Editor view by its status icon.

Status Icon Segment Status

A non-linguistic error occurred in the segment during a Transcheck test.

The segment is locked, so you cannot edit it.

The segment is do not write to TM, so you cannot commit it to the translation memory.

The segment repeats more than once in the current file.

The segment has a note associated with it.

The content of the source segment was edited.

The segment was split.

The segment was merged.

Segments across a paragraph were merged.

TXLF EDITOR VIEW

Segment State
The Segment State allows you to view, set, or change the state of a translation segment in the TXLF Editor view.
Untranslated Target segments are automatically set to Needs Translation. Once a translation is committed to the
translation memory, the application considers the translation to be complete and changes the state to Translated.
Changes to the Segment State will also change the total translation completed percentage on the Progress Bar.

Segment
State Icon

Segment State Description

Needs Translation — This state means that the segment is not finished and is therefore not
included in the calculated progress shown on the Progress Bar.

• All untranslated target segments are set to Needs Translation, or select Mark All Needs
Translation to change all segments to Need Translation. After translating the segment,
select this icon to change the state to Translated.

• If you commit a segment to the translation memory, or select Mark All Translated, this
state will automatically change to Translated.
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Segment
State Icon

Segment State Description

Translated — This state means that the segment is finished and is therefore included in the
Progress Bar. Select this icon, or make a change in the translated segment, to change the state
back to Needs Translation.

• Segments that are leveraged with Exact and Context matches are set to Translated by
default and are included in the Progress Bar percentage.*

• As you translate, when you commit segments to the TM by selecting Next Segment or its
shortcut key (ALT + DOWN), the segment state will change to Translated.**

The Segment State allows you to view, set, or change the state of a segment in the TXLF Editor view. Changes
to the Segment State will also change the Translated completed percentage on the Progress Bar.

 * You can change this default setting on a project-by-project basis in Preferences. Select
Translation Memory in the Current Project Preferences section. Clear or check the preferred
check boxes in the Segment state section.

 ** You can change the Next Segment action so that the segment state does not change to
Translated. In Preferences, select Segment in the General Preferences section. Clear the check
box for Commit changes the segment state to Translated in the Segment actions section.

TXLF EDITOR VIEW

Progress Bar
The TXLF Editor view displays translation information and status in the Progress Bar at the bottom of the
window.

Item Description

Source and Target
Languages

View the source and the target languages in the open translation file.

Filtered Segments Total View the number of filtered segments in the open translation file. When filter
criteria is cleared the Filtered Segments Total is removed from the status.
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Item Description

Translated View the percentage of filtered segments that are translated versus the total
number of filtered segments in the open translation file. The words done total
is calculated from all the translated segments from the filtered table. When filter
criteria is cleared, the Translated % is removed from the status.

Segments View the number of segments completed versus the total number of segments in
the open translation file.

Segment (Src/Tgt/Max) View the character breakdown in a segment. This breakdown includes the
number of characters in the source and the target segments, and the maximum
number of characters allowed in the target. Hover over this portion of the toolbar
to view the progress in a larger display window.

Note: A red box flashes around the Max segment value if the number of
characters exceeds the maximum allowed.

Paragraph (Src/Tgt/Max) View the character breakdown in a paragraph. This breakdown includes the
number of characters in the source and target paragraphs, and the maximum
number of characters allowed in the target paragraph. Hover over this portion of
the toolbar to view the progress in a larger display window.

Note: A red box flashes around the Max segment value if the number of
characters exceeds the maximum allowed.

Percent Translated View the total progress of the translation in a file or in a group of chained files. If
you have chained files, the percentage complete will be the total for all the files as
if they were one.

Help and Feedback

HELP AND FEEDBACK

Help

Select the Help icon  to access the online help for answers about how to use the software. If you still have
questions after reviewing the online help, log in to your user account at wordfast.net and submit a Hotline
request.

HELP AND FEEDBACK

Feedback

To send feedback about a software issue, select the Open General icon , then select Feedback. Be as
specific as possible, providing the exact steps you took when the issue occurred. Please do not submit questions

http://www.wordfast.net
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related to software usage to Feedback. Instead, log in to your user account at wordfast.net and submit a Hotline
request.

http://www.wordfast.net
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5. Manage Projects
When Wordfast Pro opens, the default view is the Project List view. This view displays all your active translation
projects, and is where you manage the translation process for each project. On the Projects tab you can perform
many project operations, including creating projects, opening and closing projects, adding and removing projects,
and importing translation packages. After you create a project, you can keep a project on the projects list for
as long as it takes to complete it. A project stays in the projects list until you remove it. You can filter the list
of projects to display them by a variety of criteria including name, location, source or target language, and
completion percentage.

 You can add a project to the projects list again, even after you remove it. Wordfast does not erase
removed projects, so you can retrieve them from the project folder on your computer using the Add
Project action.

 
To bypass the typical project creation process, create a Quick Project with the Open TXLF action.

Open a TXLF File
A TXLF file contains text segments in a source language and a target language. In Wordfast Pro, to translate
the content in a TXLF file, you must create a project. A project may contain one TXLF file or multiple TXLF files.
This section describes how to create a Quick Project by opening existing TXLF files. To set up a new project and
prepare new TXLF files for translation, refer to Create a Project.
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To open a TXLF file:

 1. Choose one of the following actions:

• Select the Project List icon  on the Sidebar to open the Project List view. Select Open TXLF, then
browse to select a file.

• Drag-and-drop one or more TXLF files to the project list.

 2. If you used drag-and-drop, determine if you want to remember your choice on the Quick Open TXLF dialog,

then choose one of three possible actions.

a) (Optional) Select Remember this choice to use your selected option each time you choose the Quick
Open TXLF action without displaying the dialog again. Use General Preferences > General to show this

dialog again, after you choose to Remember this choice.

b) Select Open in New Project to use the standard Project Creation dialog.

c) Select Open in Quick Project to open the TXLF file in TXLF Editor as a temporary Quick Project.

d) Select Cancel to disregard the TXLF file open action and close the dialog.

 3. If you chose to open the Quick Project, make your edits in the TXLF Editor, then save your changes and

select Close.

 4. Select Save Project to retain the project in the project list.

 5. In the Save Project dialog, modify the project details.
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Required fields are marked with a red asterisk.

a) Enter the Project Name.

b) Browse and select the file location in the Save Project To field.

c) Select Save.

Create a Project
In Wordfast Pro, every translation begins with a project. Projects act as repositories for all related content, along
with associated translation memories (TMs) and glossaries.

 
You must create a project before you begin translation, unless you use the Open TXLF action.

 A project also requires file format filters to convert the source content into segments prior to beginning
the translation process.

To create a project:

 

1. Click the Project List icon  on the Sidebar to open the Project List view.

 2. Click Create Project.

 3. On the Project Creation dialog, enter a project name.

Required fields are marked with a red asterisk.
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 4. (Optional) If you want to reuse the profile of a previously created local project, select it from the Reuse Project
drop-down list.

 Project reuse removes all existing translation memories, glossaries, and blocklists from the new
project. On the Reuse Project Warning dialog, click Yes to agree to reuse the project.

 5. Enter the Save Project To location or click Browse... to select the location for your project.

 6. Select Source Language and Target Language(s) from the drop-down lists.

 You can refine the source language and target language drop-down list results by starting to type a
language name.

 7. On the Editor pane, click the Translation Memory tab, if it is not already active.

 8. (Optional) Click Create to add a new local TM for your project.

a) On the Create TM dialog, enter a unique name for the TM.

b) Select a target language to create a language pair, then select the location for the TM on your local disk.

c) Select either primary or secondary priority from the drop-down list to determine the TM you leverage first.

 You can select only one TM as the primary. The primary status dictates that the content of that TM
overrides any content in secondary TMs.

d) (Optional) To prevent any edits to the TM, select Read-only.

e) Click OK.
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 9. (Optional) To add an existing TM to your project, click Add, then select a local, remote, or a project-specific

TM from the drop-down menu.

 To use a free online tool for work and production that integrates with Wordfast Pro, use Wordfast
Anywhere (WFA) as your remote, unlimited, and private TM.

a) Add Local — Select a location on your local disk.

b) Add Remote — Enter the TM Server, WF Server, or WFA Server details on the Connect to Remote TM
dialog. Refer to Connect to a Remote TM .

c) Add Project TMs — Enter the details on the Add Project TMs dialog by selecting the project.

 The source language, target languages, and list of TMs auto-populate, based on the project you
select. Remove the target languages or TMs that you do not want to import from the target languages
and list of TM fields.

 10. (Optional) To import an existing TM to your project, click Import.

a) On the Import Translation Memory dialog, select the import File Type: TMX or WF TXT TM format from

the File Type drop-down list.

b) Click Browse to locate and select the project file that contains the TM that you want to import.

c) Select either the Create a new TM or Import into existing TM option. Refer to Import a Local TM.

d) If the TU already exists, select an overwrite option from the drop-down list.

e) Select Delete all TUs from existing TM if you want the import to overwrite and create a clean TM.

f) Click OK.

 11. (Optional) To edit an existing TM in your project, click Modify.

a) On the Modify Local Translation Memory dialog, modify the name of the TM or its priority.

b) Select whether you want to protect the TM as read-only.

 12. (Optional) On the Editor pane, click the Glossary tab.

 13. (Optional) Click Create to add a new local glossary for your project.

a) On the Create Glossary dialog, enter a unique name for the glossary.

b) Select a target language from the drop-down list, then select the location for the glossary on your local disk.

c) If you want to prevent any edits to the glossary, select Read-only.

d) Click OK.

 14. (Optional) To add an existing glossary to your project, click Add, then select a local, remote, or a project-

specific glossary from the drop-down list.

a) Add Local — Select a location on your local disk.

b) Add Remote — Enter the TMGR Server, WF Server, or WFA Server details on the Connect to Remote
Glossary dialog. Refer to Connect to a Remote Glossary.
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c) Add Project Glossary — Enter the details on the Add Project Glossary dialog by selecting the project.

 15. (Optional) To import an existing glossary to your project, click Import.

a) On the Import Glossary dialog, select the import File Type from the drop-down list: TBX or Tab delimited.

b) Click Browse to locate and select the project file that contains the glossaries that you want to import.

c) To configure a glossary creation option, select either Create a new glossary or Import into existing
glossary. Refer to Import a Local Glossary.

d) Select an overwrite option for preexisting terms.

e) Select Delete all terms from existing glossary if you want to ensure the import overwrites a clean

glossary.

f) Click OK.

 16. (Optional) On the Editor pane, click the Blocklist tab.

 17. (Optional) Click Create to create a new local blocklist for your project.

a) On the Create Blocklist dialog, enter a unique name for the blocklist.

b) Select a target language for the blocklist, then select the location for the blocklist on your local disk.

c) If you want to prevent any edits to the blocklist, select Read-only.

d) Click OK.

 18. (Optional) To add an existing blocklist to your project, click Add, then select a local or remote blocklist from the

drop-down list.

a) Add Local — Select a location on your local disk.

b) Add Remote — Enter the details on the Connect to Remote Blocklist dialog. Refer to Connect to a

Remote Blocklist.

 19. (Optional) To import an existing blocklist to your project, click Import.

a) On the Import Blocklist dialog, select the import File Type: TXT.

b) Click Browse to locate and select the project file that contains the blocklist that you want to import.

c) Select the blocklist creation option: Create a new blocklist or Import into existing blocklist. Refer to

Import a Local Blocklist.

d) Select an overwrite option for preexisting terms.

e) Select Delete all terms from existing Blocklist if you want to ensure the import overwrites a clean

blocklist.

f) Click OK.

 20. On the Source Files tab, choose a method to add project source files.
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You can drag-and-drop files from a folder to the Files panel.

 To copy source files into the Source File folder within the Project folder on your computer, select
Copy Source or TXLF Files into Project Folder Structure in your General Preferences.

a) (Optional) Add File — Click to browse to the source file.

b) (Optional) Add Folder — Click to browse to the folder location for source files.

c) (Optional) Create Filter — Click to create a conversion filter the source files. You can create multiple filters.

 21. (Optional) On the Reference Files tab, choose a method to add supporting documentation.

a) (Optional) Add File — Click to browse to the source file.

b) (Optional) Add Folder — Click to browse to the folder location for source files.

 22. (Optional) Select any additional Options.

Run analysis report on
documents

Analyzes source files against TMs and generates a report. You can also view this
report on the Reports tab, after opening the project.

Pre-translate TXLF files Populates TM leveraged segments when TXLF files are open.

Use primary MT on no
match segments

Leverages primary machine translation (MT) when there are no matches with the
local and remote TMs. This option is only available if you selected Pre-translate
TXLF files.

 23. Click Create Project to analyze the files and display the project creation summary.
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 24. (Optional) On the Wordfast dialog, select Open created project.

 25. Click OK.

The project is created.

Open a Project
Once you create a project, the next step is to open it. You cannot open files for translation without first opening
the associated project.

To open a project:

 1. In the Project List view, select a project name from the list.

 2. Click Open Project or double-click the project name to open it.
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The project opens in the Current Project view. A list of the project's language pairs and the associated
translation files displays on the Project Files tab.

Modify a Project
You can change the project name and target language using the Modify Project action.

To modify a project:

 1. In the Project List view, select a project, then click Modify Project.

 2. (Optional) On the Modify Project dialog, enter a different name in the Project Name field. 



5. Manage Projects Wordfast

Copyright © Wordfast, LLC 2023.   Page 34 of 236

 3. (Optional) In the Target Language(s) field, add a language by selecting one from the drop-down list. Deselect

a language to remove it.

 4. Click OK.

The modifications are active and the project list displays the changes.

Remove a Project
To remove a project:

 You can add a project to the Project List again, even after you removed it. Wordfast Pro does not
erase removed projects, so you can still retrieve them from the project folder on your computer using
the Add Project action.

 
1. Click the Project List icon  on the Sidebar to open the Project List view.

 2. Select the project from the list, then click Remove Project.

 3. On the Remove dialog, click one of the action buttons.

Remove from the list only Remove the project from the Projects List but retain
project resources in the project folder on your computer.

Remove from the list and move the following
resources to Archive folder

Move the project TXLF, reference, and source files to
the Archive sub-folder within the project folder on your
computer.

 4. Click OK.

The project is no longer in the Projects List.
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Package Files
A package file contains all of the required information to work on a translation project. You can use a package file
to share content and files among different Wordfast Pro (WFP) users. The package file can contain complete or
incomplete projects.

A package file generally includes:

• Source files

• All target translatable files

• Instructions

• Background information

• Reference files

• Comments

• Connection to at least one Translation Memory (TM)

• Connection to at least one glossary and blocklist

To access a package file from another user, import the file into WFP. Wordfast connects the imported files to
translation memories and glossaries. It provides you access to all translatable files and additional resources,
including TMs and glossaries, without any additional setup or configuration.

To share a completed project with other users, export it as a package file.

PACKAGE FILES

Import Package Files
Package files allow different Wordfast Pro users to share files. When you import a package file, you automatically
connect the files to translation memories and glossaries. You also gain access to all translatable files and
additional resources. This eliminates the need for manually creating a project.

To import package files:

 

1. Click the Project List icon  on the Sidebar to open the Project List view.

 2. Click Import Package.

 3. On the Import Package dialog, click Browse to locate and select the package file.

Required fields are marked with a red asterisk.

 Alternatively, you can drop a package file into the white space on the Import Package dialog to begin
the import process.
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 4. Choose one of the following:

• Update a project by clicking Update an existing project and its options.

• Create a new project by clicking Create a new project and its options.

 5. (Optional) Select Open project after importing to open the project in the Current Project view when the

import completes.

 6. Click Import.

The package file is imported.

PACKAGE FILES

Export Package Files
Use Export Package to share a complete project package with other Wordfast Pro users.

To export package files:

 

1. Click the Project List icon  on the Sidebar to open the Project List view.

 2. Select a project from the list of projects , then click Export Package.

 3. On the Export Package dialog, select either Entire Project or Specific target languages and resources.
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Entire Project Click to export all target languages and their associated resources.

Specific target
languages and
resources

1. Click to export specific target languages and associated resources.
2. Click items from the drop-down list for further options to deselect specific

Target Language and resources for exclusion from the export.

 4. Choose an existing name from the Select Naming Convention drop-down list or enter a name of your choice

in the Custom Name field.

 
The Preview field provides the name of the file as it will export below the Package Name fields.

 5. Select a save location for the project package, then click Export.

The exported project package is built and saved to the folder location.



5. Manage Projects Wordfast

Copyright © Wordfast, LLC 2023.   Page 38 of 236

PACKAGE FILES

Import SDL Package Files
You can import an SDL package file for conversion of SDL source files to a compatible Wordfast Pro format.
Imports include scores for source content, but do not include translation memories, glossaries, and reference files.

To import SDL package files:

 

1. Click the Project List icon  on the Sidebar to open the Project List view.

 2. Click Import SDL Package or drop the SDL Package file into the application window.

 3. On the Import Package dialog, click Browse to locate and select the SDL Package file.

 If the SDL Package file contains unsupported target languages, a warning message notifies you.
Click OK.

 4. Enter the new Project Name.

 5. Browse to and select the save location for the new project.

 6. (Optional) Select Open project after importing to automatically open the project in the Current Project view

after import. If this option is not selected, the project displays in the Project List view.

 7. Click Import.
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The SDL Package file import completes.

PACKAGE FILES

Export SDL Package Files
Use Export SDL Package to export an SDL package.

To export package files:

 

1. Click the Project List icon  on the Sidebar to open the Project List view.

 2. Select a project from the list of projects, then click Export SDL Package.

 3. On the Export Package dialog, select the location of the original package and the location for the exported

package.

 When exporting the SDL package, the Select original package: text box automatically selects the
file path of the original imported package file location based on the previously used SDL package
location. If the selected project was not imported from the SDL package then the Select original
package: text box will be blank.

The exported project package is built and saved to the folder location.
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6. Manage Project Files
When you open a project, the view changes to the Current Project view. On the Project Files tab, the language
pair of the project displays the list of translation files.

Add Files
You can add files to an existing project using the Add Files option on the Project Files tab.

 • If one or more of the source files have a different language code, you will receive a prompt to
modify the project and add the new target language.

To add files to a project:

 

1. Click the Project List icon  on the Sidebar to open the Project List view.

 2. Select a project from the project list, then click Open Project.

 
3. Click the Current Project icon  on the Sidebar to open the Current Project view.

 4. Click Add Files on the Project Files tab.

 5. Browse to and select one or more source files on the Open dialog.

 6. Click Open.
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 7. On the Files Report dialog, click OK.

Add a Folder
You can add a folder containing multiple files to an existing project using the Add Folders option on the Project
Files tab.

To add a folder to a project:

 1. In the Current Project view, click Add Folders on the Project Files tab.

 

To activate the Current Project view, you must first open a project. Click the Project List icon 
on the Sidebar and select a project from the Project List view, then click the Current Project icon

 .

 2. Browse to the folder, select it, then click Select Folder. During the import process, you might be asked to

define conversion filters for unknown file types.

 3. View the statistics about the added files on the Files Report dialog, then click OK.

Open a Source File
You can view a source file in its original format.

To open a source file:

 1. In the Current Project view, select a file from the list, then click Open Source File.

 2. View the source file when its default application opens.

 
If the default application is not set, choose an application when prompted to do so.

Close a Project
When you are finished working on a project, close it before you open another.
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You can only have one project open at a time.

 • In the Current Project view, click Close Project.

Conduct a Bilingual Export
Use Bilingual Export to export the TXLF file with highlighted glossary terms into a .DOC or .DOCX format. This
allows you to edit and spell check the file using Microsoft Word, rather than the internal spell check. You can also
complete a bilingual export or import outside the Project List view using Quick Tools.

 Bilingual exports require you to set Bilingual Export Options in Preferences > General
Preferences.

To conduct a bilingual export:

 1. In the Current Project view, select a file, and click Bilingual Export on the Project Files tab.

 
You cannot select files that are already open for bilingual export in TXLF Editor view.

 2. Select the destination folder for the exported documents, then click Select Folder.

The session log is displayed. This log and the exported bilingual Word documents are saved in the selected
folder.

 3. (Optional) Open the bilingual export report and review the results.
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Analyze Project Files
Project analysis compares source files to a connected translation memory (TM) to leverage reusable content. Use
the Analyze action to assess files prior to translation or to pretranslate files.

To analyze project files:

 1. In the Current Project view, click Analyze on the Project Files tab.

 2. On the Project Analyze dialog, select the language pairs and files for analysis.

 Verify that the TXLF file you want to analyze is not open in TXLF Editor. You cannot analyze an open
file.
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 3. Select options below the Analysis Options heading.

Option Action

Pretranslate Select to create translated TXLF files, based on Pretranslate options.

Note: Selecting Pretranslate is an optional step. The percentage defines the
minimum leverage required to pre-translate a specific segment.

• % matches—Select the percentage of matches to pre-translate from the
list.

• Select one of the following actions from the drop-down list:

◦ Copy all tags on segments when there is no TM match

◦ Copy segment source to target when there is no TM match

◦ Do nothing

• Select Use primary MT on no match segments to leverage machine
translation (MT) matches for all segments that do not have a TM match. If
you have TM matches, but do not select the TM before you click Analyze,
the MT overwrites all target segments.

Calculate analysis
report percentage by

Select an option from the drop-down menu to set the calculation percentage by
either words or segments.

Calculate internal fuzzy
matches

Select to set the calculation percentage for internal partial matches, then
optionally select Include internal fuzzy matches with TM matches.

Lock segments with
100% matches from
being edited

Select to prevent the edit of 100% matches and the overwrite of the TM with
those edits.
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Option Action

Do not allow segments
to be merged

Select to prevent the merging of translation units (TUs) during analysis.

Do not allow sources to
be edited

Select to prevent an overwrite of the source segment with new edits.

Ignore translated
segments from report

Do not consider target segments identified in the Analysis report.

Ignore translated exact
segments from report

Do not consider exact match target segments identified in the Analysis report.

 4. Select the format for the output report below the Report Settings heading.

a) (Optional) Click Show only analysis report summary.

b) (Optional) Click Export Report, then complete the required fields and select a location.

 5. Select a TM below the Translation Memory heading.

 6. Click Analyze.

 7. On the Report File dialog, view the project files analysis.

 8. Click OK.

Run a Transcheck Report
Use a Transcheck Report to verify target segments and identify a variety of common errors within segments in the
translated files.

 If you have specific terms you want Transcheck to ignore, you can mark those segments for exclusion
in the Transcheck Report using the Transcheck All action. This reduces false positives during
Transcheck error detection.

To run a Transcheck Report:

 1. In the Current Project view, click Transcheck Report on the Project Files tab.

 2. On the Project Transcheck dialog, select one or more files.
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 3. To select the Transcheck Tests you want to conduct, click the underlined Preferences > Transcheck path

name in Transcheck Tests. This link opens the Preferences dialog where you can configure the preferred

settings for each Transcheck.

 Consistency checks are accessible through the Project Transcheck dialog. Or click the Preferences

icon  on the Sidebar, then click Transcheck under Current Project Preferences.

1. Source Consistency — Use to search for segments with the same target translation, but with
different source segments.

2. Target Consistency — Use to search for segments with same source segments, but with
different target translations.

Select the appropriate check boxes to ignore differences such as case, numbers, tags, and white
space for source and target file consistency checks. Click OK to return to the Project Transcheck
dialog.

 4. Enter the Report Name and browse to select the Report Location folder, or accept the default settings.

 5. (Optional) If you want to enable the Glossary or Blocklist checks, select the location of the Glossary or

Blocklist from the list on each tab.

 6. Click Run Transcheck.
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A Report Summary is saved to the chosen location. Once complete, a Transcheck report finished message
displays with the number of segment errors found, if any.

Generate a Segment Changes Report
A Segment Changes Report provides you with the history of changes to a segment. You can run a Segment
Changes Report on one or more project files.
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To generate a segment changes report:

 1. In the Current Project view, select one or more project files from the list on the Project Files tab, then click

Segment Changes Report.

 2.  On the Segment Changes Report dialog, select the languages or files to include in the report.

 3. Select options from the Report Settings panel.

Option Action

Show Columns Select the columns you want displayed by clicking the appropriate check boxes.
Comments, ratings, and notes each have their own column. Blank columns
indicate the feature you selected is not available or there is no data related to that
option for the segment.

• Notes, Comments, and Ratings—Translators and reviewers each have
their own notes column. Only reviewers can add comments and ratings.

• Post Edit Distance—Compares new target content to prior target content
and determines how different they are, down to character additions and
deletions.

• Segment State—Displays the current and previous states of the segment
across linguistic and review phases.
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Option Action

Enable Diff Highlight Select to compare differences between new target content to prior target content.
Red strike-through highlights indicate deletions and green highlights indicate new
content.

Include 'State' only
change segments in
report

Select to show segments that have state only modifications in the Target
Revisions table.

Show all segments
(includes unmodified)

Select to download all segments in the Segment Changes Report, regardless of
any change to the target segment.

Show latest changes in
each phase

Select to include the latest content from a specific workflow phase, regardless of
total number of revisions for that phase.

Filter Phase-name(s) Filter content in the report by a specific workflow phase by selecting that phase
from the drop-down list. You will need to select this option or the next one prior to
export.

Filter Process-name(s) Filter content in the report by a specific process, such as No Review or Review
from the drop-down list. This option can be inclusive, so you can select several
processes. You will need to select this option or the one previous prior to export.

Include all phases
before selected phase-
name(s)

(Optional) Select this option to include all phases prior to the selected phase
name.

Custom Report Name (Optional) Enter a unique name for the report if it requires customization.

Report Location Browse and select the file location for saving the segment changes report.

 4. Click Export.

 5. On the Segment Changes Summary dialog, verify the names of the files you chose to include, then click OK.

 6. Open the Segment Changes Report in a new browser window, then close the browser window when you are

done.
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Generate an Export Notes Report
The Notes Report contains all notes added to the bilingual project files. It can be exported to HTML or MS Word.

To generate an Export Notes Report:

 1. In the Current Project view, click Export Notes Report on the Project Files tab.

 2. On the Export Notes Report dialog, select one or more project language files.

 3. Browse and select the Report Location destination, then click Export.

 4. On the Export Notes Summary dialog, click OK.

The notes report saves to the specified location.

Clean Up a Project
After you have translated project files, you can clean them and update the translation memory (TM). The Clean
Up action converts the bilingual TXLF files into translated target files with the file format of the source.
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To clean up the project and update the TM:

 1. In the Current Project view, click Cleanup on the Project Files tab.

 2. On the Project Cleanup dialog, select a language or languages.

All Language Pairs Click to clean up all language pairs for the project.

Specific Language Pairs Click to clean up only the language pairs you specify from the drop-down list.

Single Language Pair Click to clean up only one language pair you select from the drop-down list.

 3. Specify the location for the translated files from the drop-down list.

 4. (Optional) Select Create subfolders by language.

 5. (Optional) Select Add language suffix to the translated file name.
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 6. Select TM Overwrite Options from the drop-down list.

 7. (Optional) Enable Add attribute, then enter that attribute in the attribute field.

 8. (Optional) Enable Add file name as attribute to add the file name to the file attributes.

 9. (Optional) Enable Overwrite private TUs (WFServer TM only) if you are connected to a Wordfast Server TM

and want to overwrite the private translation units (TU).

 10. Select the TM(s) to Update from the table.

 11. Click Clean Up.

All the options selected for the Project Cleanup dialog settings are remembered for the current project and will
not apply to other existing projects or new projects.

 12. On the Info dialog, click OK.

When the cleaned files are saved at the designated location, a message displays indicating that the cleanup
finished successfully.

Remove a File
Use these steps to remove one or more files from a project.

 You can add a removed file back into a current project. Retrieve removed files from the project folder
on your computer using the Add Files action.

To remove a file from a project:

 1. In the Current Project view, select one or more files, then click Remove File(s) on the Project Files tab.

 2. On the Remove dialog, choose a removal option.

Remove from the list only Click to remove the selected files from the file list without moving
them to an Archive folder.
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Remove from the list and move the
following resources to Archive folder

Click to remove the selected files from the file list and to move
them into a local Archive folder. When this option is selected, a
warning displays to alert you that this option physically moves
the files from their current project folder into an Archive folder.

 3. Click OK.

The files are removed from the current project.
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7. Manage Submission Files
Once you have a project set up in Wordfast Pro, you are ready to work with the files. Access the project files
from the Current Project view. When you open a TXLF file, the view switches to the TXLF Editor view. In the
TXLF Editor view, you can translate, review, temporarily combine files by chaining them together, and work with
translation memories and terminology lists.

Save a File
As you work on a file, frequently save your changes to a local folder.

To save a file:

 1. Click the File tab, if you are not already on it, and then click the Save File as Translated, Save or Save As
button.

Save File As Translated Select to save the translated file to a local folder.

Save Select to save the .TXLF file to a local folder with the existing filename.

Save As Select to save the .TXLF file to a local folder under a different name.

A progress bar is displayed. After successful completion, the file is updated in a local folder.

 2. (Optional) Continue with your translation or review. When you have finished, it is time to complete the file.

Chain Files
To combine multiple files and view them as a single file, use Chain Files. For example, if you are translating or
reviewing ten files with ten segments each, you can temporarily chain them into a single file of 100 segments.
Chaining files is particularly useful when working with duplicate or similar content among files.

 
You cannot export or save chained files as a single TXLF file.

 You can open and work on a single chained file or multiple sets of chained files in the TXLF Editor
view. Each chained file displays on its own tab.
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To chain files:

 1. In the Current Project view, on the Project Files tab, select a set of files, then click Chain Files.

 
Use Shift+Click to select sequential files or Ctrl+Click to select individual files.

The chained file opens in the TXLF Editor.

 
To determine the related file name for a segment, hover over the segment ID.

 2. Click a segment to make it the active segment.
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The file name changes from the chained name to the source file name of the active segment.

 3. From the File tab, click Save.

 
If you need to review the files again, the chained files will open in the same order you saved them.

The segments are saved in the chained file and restored to their original files without the chained format. The
progress for each individual file will show on the Progress tab.

Translate a File
 

Save your work often by clicking Save on the File tab or by pressing Ctrl+S.

To translate a file:

 1. On the Project Files tab, select a file, then click Translate File or double-click the file name to open it.

 2. Select a target segment and enter the translation. If you have a translation memory (TM) added to the project,

you can leverage translations from it.
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 3. Once you are satisfied with the translation, click Next Segment or Alt + Down Arrow. This action updates

the TM and moves to the next target segment. The segment state changes to Translated. Segments that are

changed to Translated are calculated on the Progress Bar at the bottom of the window.

Translate Segments
When you convert a file to a translatable format, all complete sentences become separate segments, often
divided by formatting or punctuation. Segments may be sentences, words, or numbers, depending on the
formatting of the source file. After you save the segment translations, the application commits the segment
translations to the translation memory (TM). Leveraging the TM automatically and consistently reduces the time
and expense of future translations by translating reoccurring words and phrases.

 To facilitate rapid use of language-specific quotation marks, punctuation, and white space, select
Enable Smart Quotes in Preferences > General Preferences > Segment.

You can choose from two layout views for your TXLF Editor workspace.

• Table view — This layout view displays the source segment to the left and the target segment to the right.

• Stacked view — This layout view displays the source segment row directly above the target segment in a
spanned row.

You can select either layout view by clicking the drop-down list for the Switch Editor Layout action on the File
tab.

 If there are either split or merged segments, indicated in the Status column with  or , all split or
merged rows within the spanned row have the same ID column color.
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TRANSLATE SEGMENTS

Translate All Segments
The Translate All option completes the translation of all segments by leveraging content in the connected TMs.

To translate a project file using Translate All:

 1. In TXLF Editor view, click in a segment.

 2. On the Translation Tab, click Translate All.

This action leverages content in the connected TM and populates the target segments with translations. When
this process is complete, the screen refreshes and displays the results in the target column. The segment
states are all changed to Translated. The progress bar indicates the percentage of translation complete.
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TRANSLATE SEGMENTS

View Segment History
In TXLF Editor, view the record of segment changes to the open file on the Segment History tab of the Editor
pane. Changes to segments include segment updates, and lock actions.

TRANSLATE SEGMENTS

Commit to the TM
Once you have finished translating some or all of the file segments, update the translation memory (TM) with your
translation. This requires committing some or all of the translated target segments to the TM.

To update the translation memory:

 1. In the TXLF Editor view, choose one of the following:

• To commit a single segment to the TM, select a segment, then select Commit on the Translation tab.

• To commit all segments in the file to the TM, select Commit All on the Translation tab.

 2. (Optional) Verify that the updates you committed to the TM have a purple highlight.

 The highlighted color can be selected in the General Preferences from the Colors option by
selecting the listed Committed into TM item.

 3. (Optional) If you are updating the TM for the current segment only, continue your work and repeat as often as

necessary until you have committed all translated segments to the TM.
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TRANSLATE SEGMENTS

Copy Source Content
To copy source content to the target:

 1. In the TXLF Editor view, select a source segment.

 2. To copy the source content, choose one of the following:

• On the Translation tab, select Copy Source.

• As a shortcut, press Alt+S to copy the source content.

 3. Select a copy action from the resulting drop-down menu.

Option Action

Copy Source Select to copy from source all content and tags to the target.

Copy Source Text Select to copy only content from source to the target.

Copy Source, Tags and Term
Translations

Select to copy from source to target all content text, its tags, and
translated concordance glossary terms.

Copy Source and Term
Translations

Select to copy from source to target all content text and translated
concordance glossary terms.

Copy Source, Tags, Source and
Target Terms

Select to copy from source to target all content text, its tags, and both
source and translated concordance glossary terms.

Copy Source with Source and
Target Terms

Select to copy all source and translated concordance glossary terms to
the target.

The specified source content is copied to the selected target.

TRANSLATE SEGMENTS

Copy All Source Segments
To copy all source segments to all target segments:

 1. In the TXLF Editor view, on the Translation tab, click Copy All Sources.

All source segments are copied to all segments in the target column.

 2. (Optional) Begin translation in the target column.
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TRANSLATE SEGMENTS

Split or Merge a Segment
You can split or merge an existing segment to change segmentation. This is particularly useful for certain file
types or for languages where the next segment content may need to precede the previous segment. The best
time to split or merge a segment is early in the translation process.

To split or merge a segment:

 1. In the TXLF Editor view, select the segment to split or merge.

 2. On the Translation tab, select Merge or Split.

The segment is merged or split and the segment Status column contains either the Merge icon  or the Split

icon , respectively. If the merge includes an entire paragraph, this is denoted with the Merge Paragraph

icon .

TRANSLATE SEGMENTS

Lock a Segment
You can lock a segment to prevent any further changes to that segment. The best time to lock a segment is when
the translation is complete and the reviewer has confirmed the content after proofreading it. The Commit action
still updates the translation memory (TM) with the target segment content.

To lock a segment:

 1. Optionally, in the TXLF Editor view, use the table filter to filter out all unwanted segments.

 2. In the TXLF Editor view, select the segment to lock.
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 3. On the Translation tab, select the Lock/Unlock Segment drop-down and select one of the two options:

• Lock/Unlock Segment locks or unlocks a single selected segment.

• Lock/Unlock All Segments locks or unlocks all segments. If the table filter was used to filter segments,
only the filtered segments are locked or unlocked. When Lock/Unlock All Segments is selected, a
warning dialog is displayed warning that all segments will be locked or unlocked; select Yes to continue.

 is displayed in the segment Status column to indicate the segment or segments are locked.

TRANSLATE SEGMENTS

Clear Target Segments
To clear target segments:

 1. In the TXLF Editor view, select a target segment.

 2. On the Translation tab, select Clear Target.

 3. From the drop-down menu, select one of the following options:

• To clear the selected target segment, select Clear Target.

• To clear all target segments, select Clear All Targets.

 4. On the Clear Current Segment Target dialog, select Yes to agree to the target content removal.

The target content is removed.

TRANSLATE SEGMENTS

Do Not Write To TM
Translators or reviewers can use the Do Not Write To TM action to prevent a segment from being added to the
translation memory (TM).

To prevent a segment from being added to the TM:

 1. In the TXLF Editor view, place your cursor in a translation segment..

 2. On the Translation tab, select Do Not Write To TM, or press Alt + Enter.
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The TM is not updated with the target segment content.

The  icon is displayed in the segment Status column.

 3. (Optional) To later remove the restriction so the segment can be added to the TM, select Do Not Write To TM
again.

Find and Replace Content
Use Find/Replace to search for and replace text in translated content.

To find and replace content in a file:

 1. In the TXLF Editor view, click the Edit tab.

 2. Click Find/Replace.

 3. On the Find/Replace dialog, click in the Find what field, then enter your search text or select it from the drop-

down list.

 4. (Optional) Click the Expand icon  to expand the panel for additional options, or click the Collapse icon  to

collapse the additional options.

 
Search text can include regular expressions (Regex), wild card characters, and non-breaking spaces.

 5. Click Find Next to move through all instances of the content.

 6. (Optional) Click Reading Highlight and select the Highlight All action from the drop-down list to highlight all

instances of the content in all open files. Click Clear Highlighting to remove the highlighting from the previous

search.
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 7. (Optional) To replace regular expressions, wild card characters, or words, click the Replace icon . For

additional options, click the down arrow on the sidebar.

 8. Click in the Replace with field and enter the replacement text.

 9. (Optional) Select the direction of the search and any other options.

 You cannot use the Whole Words Only search option when entering multiple words or punctuation in
either search field.

 
Select Use Regex to search on regular expressions or wild card characters.

 10. (Optional) Click one of the following actions: Replace, Replace All, Find Next, or Close.

The content you found has been replaced with the new content.

Edit or Revert a Source Segment
Use Edit Source or Revert Source to edit or revert content in the Source column.

Depending on configuration settings, these buttons may not be present.
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 When the cursor is not on the source nor on the target segment then the Edit Source and Revert
Source buttons are disabled.

To edit content in the source segments:

 1. In the TXLF Editor view, place your cursor onto the source segment you want to edit.

 2. Select the Edit tab and then select Edit Source.

 3. Make edits to the source segment.

Editing the source adds the Edit Source status icon  to the Status column.

 4. (Optional) To revert changes to the source segment, select Revert Source.

 Selecting Revert Source keeps the Edit Source status icon for the edited source and also retains
segment history of the source.

Spell Check a File
You can use a spellchecker to verify translated content aligns with configured spell checking preferences. Refer
to Configure and Enable Spellchecker. You must verify that your Hunspell spelling dictionaries have the latest
updates. Refer to Licensure.

To spell check a file:

 1. On the Review tab, click Spellcheck File.

 2. On the Spelling dialog, review the suggestions and select one of the options.
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Item Action

Ignore Once Click to disregard the suggested change for a word only once.

Ignore All Click to disregard the suggested change for all occurrences of a word in the file.

Add to Dictionary Click to add word to personal dictionary.

Change Click to accept the suggested change for a word.

Change All Click to accept the suggested change for all occurrences of a word in the file.

 
If spell checking is not available for the target language, a warning message notifies you. Click OK.

 3. To view spell checking preferences, click Preferences or click Cancel to reject any changes.

 4. Close the Spelling dialog.

Leverage Translation Memory
Translation memory (TM) acts as a database to provide maximum re-use of previously translated content. It also
serves to facilitate collaboration between globally distributed localization resources.

Projects connected to a translation memory (TM) leverage content matches against an existing TM. TM matches
generally fall into three categories: 100% match, fuzzy repetitions, or no match. Your organization may choose to
alter or add more fuzzy repetition categories. The typical fuzzy repetition values are for 95% to 75% matches. The
segment highlight identifies the type of TM match.

Color Code Category

Green Indicates a 100% match.
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Color Code Category

Green, Dark Indicates a context match. A context match for a segment must meet one of the
following criteria:

• The segment has a correct checksum or attribute match.

• The previous and next segments also have a 100% match.

• The 100% matched segment is a single paragraph.

Grey Indicates there is no TM match.

Pink Indicates a modified segment.

Orange, Light Indicates the segment was a machine translation (MT) instead of a human translation.

Purple Indicates an update to the TM for a modified segment.

Purple, Light Indicates the update to the TM of a translated and committed segment automatically
updates other repetitive segments within the translation.

Yellow Indicates a fuzzy match.

LEVERAGE TRANSLATION MEMORY

Leverage a TM
Leveraging a segment involves selecting the best possible translation from the connected translation memories
(TMs) or machine translation engines to populate target segments.

To leverage a TM:

 1. In the TXLF Editor view, select the segments to leverage against the current TM.

 2. On the Translation tab, select an action to leverage the current TM.

Leverage Select to leverage a single segment.

Until Fuzzy Select to leverage segment content until reaching a fuzzy match.

Until No Match Select to leverage segment content until there is no match.

Translate All Select to leverage all content in all segments.

LEVERAGE TRANSLATION MEMORY

Conduct a Translation Memory Lookup
A translation memory (TM) lookup or concordance search looks for specific source segment text in a translation
memory. To view search results for both source and target segments, use the TM Lookup tab in the Editor pane.
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To conduct a TM lookup or concordance search:

 1. Search for a word or phrase by entering it in the TM Lookup field. Then, to conduct a search of both source

and target, press Enter. Instances of the search term are highlighted in the Editor pane, along with its bilingual

equivalents. To conduct a more specific search, click Find Source or Find Target.

 You can also select a word or phrase in the segment in the TXLF Editor view and then click
Concordance Search from the Translation tab, or press F8.

 Instances of the search term are highlighted in the Editor pane, along with its bilingual equivalents. To
conduct a more specific search, click Find Source or Find Target.

 You can reorder the columns of the TM Lookup results. That reorganization remains, even after you
exit the software.

 2. (Optional) To refine the search, select More Options and select a check box from the drop-down list.

Option Action

Match Case Select to filter by upper and lower case.

Exact Select to filter for only those terms organized in the same sequential order.

Automatic Leverage Select to automatically update target content when moving to a new segment.

Diff Highlight Select to highlight the difference between the submitted segment and the TM
source segment.

Include Private TU (GLTMS) Select to include private segments or translation units (TUs) when searching
a remote TM.

The refined search results for the word or phrase you selected are listed on the TM Lookup tab of the Editor
pane. You can use the results of your search in the related target segments.
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LEVERAGE TRANSLATION MEMORY

View TM Leverage Results
Leveraging the translation memory (TM) occurs automatically as you move through the target segments. This
provides you with the best possible segment matches from the TM and is the only search that uses scoring to
select the best match.

To view TM leverage results:

 1. In the TXLF Editor view, click on a source or target segment.

This populates the columns on the TM Lookup tab of the Editor pane and provides a score, based on TM
leverage results.

 2. Review TM leverage results in each TM Lookup column for that segment.

Item Behavior

Source Displays source segments provided by the TM. Any difference between the submitted
segment and the TM source segment is highlighted.

Target Displays target segments already in the TM.

Score Displays a TM leverage score.

• Percent (%) — 100% and fuzzy matches

• Plus (+) — Context matches

• Asterisk (*) — Secondary TM match

• Red outline — TM has assessed a penalty to the segment
Refer to Leverage Translation Memory for more information on TM color codes.

TM Name Identifies the name of the leveraged TM. If you are leveraging multiple TMs, it lists the
TMs in order of priority: primary, then secondary TMs.

Creation Date Identifies the TM segment creation date.

Creation User Identifies the username of the segment creator.

Last Modified Identifies the date of the last segment modification.
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Item Behavior

Modification User Identifies the user who last modified the segment.

Custom Attribute Identifies any segment custom attribute name and its associated values

 Actions Acts as a button to access score breakdown information, including penalties.

 3. (Optional) To constrain the columns within the pane, click on any column head, then deselect the names of the

columns you want to hide.

LEVERAGE TRANSLATION MEMORY

Leverage Machine Translations
The machine translation (MT) feature can automatically populate target segments whenever you open a file
or when there are no translation memory (TM) segment matches. Select a project for your MT and configure
Machine Translation options under Preferences > General Preferences.

To leverage MT:

 1. In TXLF Editor view, on the Translation tab, click Machine Translation to submit the source segment for MT

and populate the target segment with the results.

 2. (Optional) Verify that the quality of the translation for the source segments aligns with your requirements.

The target segments are populated with the MT for the source segments.

 3. (Optional) If you are updating the current segment only, continue your work and repeat as often as necessary

until you are ready to save and commit all translated segments to the TM.
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Leverage Terminology Lists
Terminology lists provide users with the ability to standardize term usage and to control the use of terms, variants
of terms, and parts of speech allowed for terms. A terminology list includes a glossary, a specialized list of source
terms, their definitions, and their preferred translations. It also includes alternate phrases for blocklisted terms.

Segment selection highlights terms from the terminology list on the Terminology pane along with potential
translation options.

 There are two possible methods for moving among terms on the Terminology pane.

• Click Next Term (Ctrl + 9) or Previous Term ( Ctrl + 8).

The term highlight identifies the type of translation match between the source term and the terminology list.

 
Use Highlight All Terms to view highlights for term matches in the open file.

Color Code Category

Green Exact term match

Yellow Fuzzy term match

Red Missing exact term match

Purple Missing fuzzy term match
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LEVERAGE TERMINOLOGY LISTS

Add a Term
You can add terms to both local and remote glossaries. You need read and write user permissions to add terms to
a remote glossary that is not read-only.

To add a term to a glossary:

 1. On the Terminology pane, select a word in the source segment and, optionally, the translation in the target

segment, then click .

 2. (Optional) On the Add Term dialog, enter content in the Description field.

Required fields are marked with a red asterisk.

 3. Select the proper Glossary from the drop-down list.

 4. Click OK.

The new term is added to the glossary.

LEVERAGE TERMINOLOGY LISTS

Edit a Term

 
You can only edit terms in the local glossary.

To edit a term:

 1. In the TXLF Editor view, on the Terminology pane, select a term.
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 2. Click the Edit term icon .

 3. On the Edit term dialog, make your edits.

 4. Click Modify.

The term is edited.

LEVERAGE TERMINOLOGY LISTS

Insert a Term
To insert a term into the current target segment:

 1. In the TXLF Editor view, click the location for term insertion.

 2. Select the term to insert from the Terminology pane.

 3. Click  on the upper left menu bar within the Terminology pane.

The term is inserted into the target segment.

LEVERAGE TERMINOLOGY LISTS

Search for a Term
To search for a term:

 1. On the Terminology pane, enter a term in the terminology filter field.

 2. Click the Search for Term icon .
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The search results from the connected glossaries are displayed.

LEVERAGE TERMINOLOGY LISTS

Copy a Term
To copy a term from the glossary into the current target:

 1. In the TXLF Editor view, click a segment that contains glossary terms.

 2. On the Terminology tab, click Previous Term or Next Term to select a source term.

 3. Click on the target location where you want to copy to the glossary term.

 4. Click Copy Term.

The glossary term is copied to the target segment.

LEVERAGE TERMINOLOGY LISTS

Copy a Synonym
To copy a synonym for a term:

 1. In the TXLF Editor view, select a source term in a segment that has a glossary term.
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This highlights and adds a border around the source and target terms. Synonyms display on a temporary pop-
up pane and on the Terminology pane.

 

 2. Click within the target segment at the location where you want to copy the term.

 3. Click the preferred target term from the Terminology pane. This copies the term to the cursor location in the

target segment.

 An alternative is to click Copy Term. This also copies the term to the cursor location in the target
segment.

The target synonym is copied to the target segment.

LEVERAGE TERMINOLOGY LISTS

Remove a Term

 
You can only remove terms from local glossaries, not read-only or remote glossaries.

To remove a term:

 1. In the TXLF Editor view, go to the Terminology pane.

 2. Select a term, then click .

 Use the Remove Term  at the top of the Terminology pane. Do not use the Reset Search . This
clears the filter.

A warning message notifies you of the pending deletion and asks you to agree to the term removal.

 3. Click Yes.

The term is removed from the local glossary.
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Manage Tags
Tags contain information related to a block of text, such as format or indentation. Tags are not translated and
come in pairs: an opening and a closing tag.

 
Translations must retain the same tags at the correct location within a target segment.

 Unless you have disabled Remove incomplete tag pairs in Preferences > General Preferences >
Tags, a warning message results when you try to save a target segment with a missing tag or an
open tag. An open tag is part of a tag pair in the target segment that is missing its matching close tag.
The warning will give you three choices: Fix Manually, Delete, or Always delete.

Hover over a tag to view tool-tip information.

Tags contain numerals to indicate their order in the segment.

Red This is a tag you currently selected, such as the first tag, , in the file.

Purple This is a tag that specifies formatting, such as 

Blue This is a tag that specifies non-formatting controls, such as .

MANAGE TAGS

Copy a Tag
Translated content retains the formatting of the source content, so tags are an important element in the final
translation. You can copy tags from the source to the target for formatting and indentation accuracy.

 Use Preferences > General Preferences > Tags to configure tags as full name, short name, or
numbered tags.

To copy a tag:

 1. Open a file.

 2.  In the TXLF Editor view, on the Translation tab, select a segment with tags.

 When the selected segment contains tags, the first tag is automatically selected. Red indicates
selection.
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 3. Choose one of the following actions:

• Click a source segment tag and drag it to the corresponding location in the target segment or press Ctrl
+Alt+Down Arrow.

• Click a source segment tag, then click in the corresponding target segment location and click Copy Tag.

• Right click a source segment tag, select Copy (Ctrl+C) in the drop-down menu, click in the corresponding
target segment location, then select Paste (Ctrl+V).

The target segment, highlighted in blue, contains the copied tag at the cursor location you selected in the
target segment.

 4. (Optional) Click Previous Tag or Next Tag to select another tag and repeat the process.

MANAGE TAGS

Copy All Tags

 
Use Preferences > General Preferences > Tags to configure tags as full-sized or shortened.

To copy all tags:

 1.  In the TXLF Editor view, open a file.

 2. On the Edit tab, click Copy All Tags.

 All copied tags display at the location of the cursor. Reorder them to mimic the source content order
using the drag-and-drop or copy-and-paste technique.

 3. Select Segment or Document from the drop-down menu.

Segment or Alt+A Select to copy only the tags for the selected segment to the target.

Document or Alt-Shift+P Select to copy all tags for the entire document.

All tags are copied to the segment or document.
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MANAGE TAGS

Edit a Tag
Most tags in your target content have specific formatting and indentation settings copied from the source. You can
modify tags to change content format in the translated file.

 
Do not edit tags in the source segment.

To edit a tag:

 1. Open a translation file.

 2.  In the TXLF Editor view, select a tag in a target segment.

 3. Choose one of the following actions:

• On the Translation tab, click Edit Tag.

• Right-click the tag and select Edit Tag from the drop-down menu.

 4. On the Edit Tag dialog, modify the tag.

 
Verify that all tag edits are valid. Otherwise, the file could become corrupt.

 5. Click OK.

Edits to the tag are saved.
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MANAGE TAGS

Clear All Tags

 
Use Preferences > General Preferences > Tags to configure tags as full-sized or shortened.

To clear all tags:

 1. Open a file.

 2. In the TXLF Editor view, on the Edit tab, click Clear All Tags.

 3. Select Segment or Document.

Segment or Ctrl-Shift+V Select to clear only the tags from the selected segment.

Document Select to clear all segment tags for all target segments in the file.

A warning message asks you to agree to clear all tags from the open file.

 4. Click Yes.

All tags are cleared for the target segment or for all target segments in the document.

MANAGE TAGS

Delete a Tag
You may choose to delete target tags, particularly if there are multiple copies of the same tag in the same target
segment. You can only delete target segment tags.

To delete a tag:

 1. Open a translation file.

 2.  In the TXLF Editor view, select a tag in a target segment.

 3. Choose one of the following actions:

• Press Delete or Backspace.

• On the Edit tab, click Cut, then paste the tag elsewhere.
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To undo the change, click Undo or press Ctrl + Z.

The target tag is deleted.

Manage Project Notes
You can add notes that are specific to each segment during the translation and review process. If you have
chained files together, you can review all notes for all files in the chain.

There are two ways to access the Notes editor.

• Use the Notes tab on the Editor pane to view and manage project notes.

• Use the Notes icons on the Review tab to view and manage project notes.

MANAGE PROJECT NOTES

View Notes
The Notes tab is on the Editor pane. Notes retain the same ID as the related segment.

 
Segments with notes include the Notes icon  in the Status column.

To view notes:

 1. Open a translation file.

 2. In the TXLF Editor view, click the Notes tab on the Editor Pane, then view note details for all file segments.

Notes for all file segments are displayed.

MANAGE PROJECT NOTES

Add a Note
To add a note:

 1. Open a translation file.
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 2. In the TXLF Editor view, select a segment.

 3. Choose one of the following actions:

• Click the Notes tab on the Editor pane, then click Add Note.

• On the Review tab, click Add Note, or right click on the target segment and select Add Note to open Add/
Edit Notes dialog.

 4. On the Add/Edit Notes dialog, select a Type from the drop-down list.

 
The selected note Type is saved for the next time Wordfast is run.
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Type Description

Translation Select to include data for the reviewer from the translator.

Review Select to includes data for the translator from the reviewer.

Question Select to solicit a response about the segment from a user.

Important Select to flag the data for the segment as a priority for other users.

 5. Enter the information in the note field.

 6. Click OK.

The note is saved and associated with the segment.

MANAGE PROJECT NOTES

Edit a Note
To edit a note:

 1. Open a translation file.

 2. In the TXLF Editor view, select a segment with a note.

 3. Choose one of the following actions:

• Click the Notes tab on the Editor pane, then click Edit Note.

• On the Review tab, click Edit Note.

 4. On the Add/Edit Notes dialog, edit the note.
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 5. Click OK.

The modified note is saved and associated with the segment.

MANAGE PROJECT NOTES

Delete a Note
To delete a note:

 1. Open a translation file.

 2. In the TXLF Editor view, select a segment with a note.

 3. Choose one of the following actions:

• Click the Notes tab on the Editor pane, then click Delete Note.

• On the Review tab, click Delete Note.



7. Manage Submission Files Wordfast

Copyright © Wordfast, LLC 2023.   Page 85 of 236

The note is no longer attached to the segment. If there are no other notes, the notes icon is removed from the
Status column for the segment.

MANAGE PROJECT NOTES

Export Notes
To export notes:

 1. Open a translation file.

 2. In TXLF Editor, choose one of the following actions:

• Click the Notes tab on the Editor pane, then click Export Note.

• On the Review tab, click Export Notes.

• Right-click the segment and click Export Notes.

 3. On the Export Notes dialog, browse and select a location for the exported notes file.

 4. Enter a file name and click Save.

All notes for the open file are saved in the selected folder location as a table in either MS Word or HTML file
format.
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Transcheck
You can use Transcheck to scan translated content for non-linguistic errors such as missing tags, empty targets,
numbers, and terminology within target segments.  is displayed in the Status column for segments with errors.

 To enable Transcheck and customize Transcheck options, configure in Preferences > Current
Project Preferences > Transcheck.

TRANSCHECK

Use Transcheck
After you have configured Transcheck options, you can begin using Transcheck when you translate or review a
segment and commit it to the TM. You can also use the Transcheck configuration option Transcheck segments
while translating to check for errors during the translation process.

To use Transcheck during translation:

 1. In the TXLF Editor view, select a segment and complete your translation of that segment.

 2. Select Next Segment or press Alt+Down Arrow to update the TM, move down one segment, and leverage

the next segment from the TM.

 3. (Optional) If Transcheck identifies an error in the segment, it posts a warning message. Choose one of the

following actions:

• Select Go back to fix issue to correct the error.

• Select Continue to continue translating without changes.

If you choose to correct the error, the Error Status icon  is removed from the Status column and from the
Transcheck tab.

If you do not correct the error, the Error Status icon  remains in the Status column and on the Transcheck
tab.

TRANSCHECK

Use Transcheck All
Use Transcheck All to scan all segments of a file for non-linguistic errors in the target segments and issue
warnings for missing and incorrect text. Configure and enable your Transcheck preferences under Preferences >
Current Project Preferences > Transcheck.

Do not use Transcheck All if you want Source and Target Consistency checks. Instead, use Transcheck Report
from the Project Files tab on the Current Project view.

 
Use the Transcheck All option before you complete a file.

To use Transcheck All:

 1. In the TXLF Editor view, finish translation of all segments in a file.



7. Manage Submission Files Wordfast

Copyright © Wordfast, LLC 2023.   Page 87 of 236

 2. Click the Review tab, then click Transcheck All.

In General Preferences under Warnings, if Transcheck All Warnings is selected a Transcheck All
Warning pop-up dialog appears. The "Do not warn me about this anymore" checkbox will turn off this pop-
up dialog. The Use Transcheck Report From Current Project view link will open the Project Transcheck
dialog.

 3. Click Continue.

A Transcheck report and summary results.

 4. (Optional) On the Transcheck Report, determine the terminology errors you want Transcheck to ignore from

highlighted terms in the Terminology Check report section.

 To best optimize the Transcheck Report, you can configure Transcheck to ignore highlighted terms
you identify under conditions you specify. The terms and conditions you select are in the Ignored
Terminology Errors section of the report.
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 5. (Optional) Click a highlighted term.

 6. (Optional) On the Ignore Terminology Transcheck Error dialog, compare the source string with the target

equivalents.

 7. (Optional) Select either When term is for source terms in the glossary or When target contains for target

terms.
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 8. (Optional) Either click Ignore to disregard the single instance of a string or Ignore All to disregard every

instance of a string.

 
The number following Ignore All contains the total number of instances within that file.

 9. (Optional) Review the terms in the Ignored Terminology Errors section of the Transcheck report.
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 10. (Optional) After closing the Transcheck report, select any remaining segments with the Error Status icon  in

the Status column.

 11. (Optional) Click the Transcheck tab to examine the details of the segment error.

 
The total number of errors in the segment is the number in parentheses on the Transcheck tab.
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 12. (Optional) Click Next error or Previous error on the Transcheck tab to view the next or prior segment error.

 13. Choose one of the following actions:

• Correct the error and click Refresh to complete the correction.

• Click Ignore warning to continue reviewing error warnings without making any changes.

If you correct the error, the Error Status icon  is removed from the Status column.

If you do not correct the error, the Error Status icon  remains in the Status column.

Leverage Auto-Propagation
The purpose of auto-propagation is to leverage repetitive segments and re-use content. Configure and enable
your auto-propagation preferences under Preferences > General Preferences > Auto-Propagation.

To leverage repetitive content:

 1. Select a segment for translation in the TXLF Editor. In this example, a filtered search locates and identifies

duplicate segments.

 2. Enter the translation for the first target segment.
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 3. Choose one of the following actions:

• Click Next Segment or press Alt+Down to update the TM, move down one segment, and leverage the
next segment from the TM.

• Click Commit or Commit All to commit one or all of the segments to the TM.

Once you commit the target segment, this action automatically propagates the TM updates to duplicate
segments throughout the file, based on segment preferences.

Leverage Auto-Suggestion
You can use auto-suggestion to propose target content based on specific source content, such as numbers,
URLs, and proper names. You can also use auto-suggestion to propose terms for the glossary, machine
translation (MT), translation memory (TM) matches, and sub-segment TM matches. Configure and enable your
autosuggestion preferences under Preferences > General Preferences > Auto-Suggestion.

Monitor Maximum Segment Length
Based on Project Director (PD) settings, your files may have a set maximum segment length. Any violation of
a segment that exceeds the maximum characters allowed results in a change to the segment Max value in the
progress is indicated by a flashing red box appearing around this value.

Users can monitor the progress bar for maximum segment length violations, and can also configure the
Transcheck Report to flag such violations.

Recalculate the Progress of a File
Use Recalculate Progress to calculate and update the progress of translated files and word count, especially
files created or edited in legacy versions. When you open a legacy file, the progress bar contains the N/A flag to
denote that it will not calculate progress.

 
Refer to Chain Files to recalculate progress of multiple files.
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To recalculate the progress of a file:

 1. On the File tab, click Recalculate Progress.

 2. Review the progress bar for current file status.

The progress bar is updated to display the % Complete status of the file.

Get an MS Word Table
You can preview and save the file you have open for translation as a bilingual table in MS Word format.

To get an MS Word table:

 1. In the TXLF Editor view, select a file with translated content.

 2. (Optionally) In the TXLF Editor view, use the table filter to filter out any unwanted segments.

 3. On the File tab, select Get MS Word Table.

 4. On the Get MS Word Table dialog, select Get MS Word Table.

 You can configure MS Word Table settings by clicking the hyperlink to the Preferences location. If
you want to disable the dialog, select Don't show this dialog anymore. If you need to re-enable
the warning dialog, select Show dialog to configure MS Word Table Preferences from General
Preferences > Warnings.

 5. If the segments were filtered, an Export Segments To MS Table dialog will appear. Select Continue to export

only the filtered segments to the MS Word table.

 Selecting Cancel will export all the segments to the MS Word table document regardless of any
segment filter applied.
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The file downloads as a Microsoft Word document containing a bilingual table of source and target segments.

 6. (Optional) Review the resulting file for completeness.

Preview a File
Use Preview to display the source content in its original format, such as MS Office, HTML, and Markdown source
formats.

To preview files:

 1. Open a file in the TXLF Editor view.

 2. On the File tab, click Preview, then select a preview type on the drop-down list.
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The preview of the source content is displayed in its original format.

Use Live Preview
Using Live Preview you can generate a dynamic preview of a translated file in its original format for the following
file types:

• MS Word .DOC and .DOCX files

• MS PowerPoint .PPT and .PPTX files

• Markdown .MD files

• JSON .JSON files

• MS Excel .XLS and .XLSX files

Live Preview is enabled by default in the TXLF Editor view. To collapse or expand the live preview pane, click
the Collapse icon  or the Expand icon  located on the top-right of the TXLF Editor view. To zoom in or out of

the live preview pane, select a percentage in the zoom drop-down list . To enable or disable automatic
opening of Live Preview, go to General Preferences > General, and select or deselect Automatically open Live
Preview for supported files.

To generate a Live Preview:

 1. Open a file in the TXLF Editor view.

 2. On the File tab, select Live Preview from the Preview drop-down menu.

 
Only one preview option is possible at a time.

 3. (Optional) Interact with the Live Preview of the file.

For MS Word files
The live preview pane docks to the right. For docking options, click the live preview panel's Settings icon: .
Live Preview highlights the active segment. Move to any other segment by clicking on that area of the Live
Preview.
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For MS Excel files
Excel documents display spreadsheets. Multiple sheets appear at the bottom of the live preview pane.
The live preview pane docks to the right. For docking options, click the live preview panel's Settings icon: .
Live Preview highlights the active segment. Move to any other segment by clicking on that area of the Live
Preview.

For MS PowerPoint files
PowerPoint files can be graphically intensive and may take time to load. The progress bar provides real-
time loading status. Select the View All Slides box to load the entire document. Click  to cancel the Live
Preview.

• Docking—The live preview pane docks to the right. For docking options, click the live preview panel's
Settings icon: . Live Preview highlights the active segment. Move to any other segment by clicking
that area of the Live Preview.

• Slide Access—Click the forward or back arrow to progress through the slide deck or type the deck
slide number in the Slide field. While in the editor, move back to the slide that correlates to the open

segment by clicking the Target icon: .
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For Markdown files
The live preview pane docks to the right. For docking options, click the live preview panel's Settings icon: .
Live Preview highlights the active segment. Move to any other segment by clicking on that area of the Live
Preview.

For JSON files
The live preview pane docks to the right. For docking options, click the live preview panel's Settings icon: .
Live Preview highlights the active segment. Move to any other segment by clicking on that area of the Live
Preview.
For JSON files, Live Preview shows the translatable text in bold and at a larger font size.
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 4. (Optional) Enter the translation or leverage the TM for any segment.

 5. (Optional) On the Translation tab, click Next Segment or press Alt+Down Arrow to update the TM, move

down one segment, and leverage the next segment from the TM.

The new translation is displayed.

 6. (Optional) Click Sync Preview to refresh the preview.

Use Office Preview
The Office Preview option allows you to generate a static preview of MS Office documents using the target
segments in your translation.

 If the MS Office file type you select can be opened in a Live Preview, this option is shown, if not you
see only the Office Preview option.

To generate an Office Preview:

 1. Open a file in the TXLF Editor view.

 2. On the File tab, select Office Preview from the Preview drop-down menu.

 3. (Optional) Interact with the newly opened Office Preview window. If you make changes to the target segments

and wish to view those changes, just select Office Preview again and a new preview is generated.
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Use HTML Preview
If you are working with an HTML submission, the translated document can be viewed using the HTML Preview.

To generate the HTML Preview:

 1. Open an HTML file in the TXLF Editor view.

 2. On the File tab, select  HTML Preview from the Preview drop-down menu.

 3. A new window opens and displays target content in context. To view new changes to target segments in

a translated view, select HTML Preview again and a new window with the updated translated document

generates.
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8. Leverage Project TMs
A translation memory (TM) provides maximum content re-use and facilitates collaboration among localization
resources. Users can leverage reusable content using one of two different types of TMs.

 Consider using a free, hosted service: WordFast Anywhere (WFA). WFA allows translators to connect
to a shared server and interact with a private, remote TM and glossary.

Local TM Located on your local computer system and only you can access it.

Remote TM Located on a server that other translators can access. This allows multiple
translators to leverage the available content and update the TM with new reusable
content.

 You can remove a TM from a project so it is no longer in the project TM list. When you remove a local
TM from a project, it remains in the TM folder on your computer system. To add a removed local TM
back to the project, use the Add Local action on the Project TM tab. To add a removed remote TM
to the project, use the Connect to Remote action on the Project TM tab.

Create a Local TM
Create a local translation memory (TM) for quick, local access. If it is possible you may need to share your TM
with other users, connect to a free, hosted service: Wordfast Anywhere (WFA). Refer to Connect to a Remote
Glossary.

To create a local TM:

 1. In the Project List view, on the Projects tab, select a project from the projects list to open it.

 2. On the Project TM tab, select Create Local.

 3. On the Translation Memory dialog, enter the required TM configuration.

 
Required fields are marked with a red asterisk.
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Field Action

Name Enter a unique TM name that includes the client or organization name and the
TM's language for easy identification.

Target Language Select target languages. Target languages are limited to those languages
configured in the project.

Location Select the destination where the application saves the new TM.

Priority Set the TM sequence used during translation, using the Primary TM first,
followed by any Secondary TMs.

Note: You can only select one TM as primary.

Selected (Optional) Select to use the current TM for the project.

Read-Only (Optional) Select to leverage the TM without updating it with the new translation.

 4. Select OK.

The new TM is created and is displayed in the Project TM list.

Add a Local TM to a Project
You can add a local TM to your project at the time of creation or as a separate action.

 You can add TMs created by Wordfast Pro 4 or 5 only. If you want to add TMs from Wordfast Classic
or Wordfast Pro 3, use the Import TM option.

To add a local TM to a project:

 1. On the Projects tab, double-click a project from the projects list.

 2. Select the Project TM tab, then select Add Local.
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 3. On the Opening TM dialog, browse to the local TM folder and select it.

 4. Select Select Folder.

The selected TM is added to the project and displayed in the Project TM list.

Add Project TMs
Some projects may use multiple local and remote translation memories (TMs). In such instances, it is more
efficient to add all of the TMs for the project with a single Add Project TMs action.

To add project TMs:

 1. In Project List view, on the Projects tab, double-click a project from the projects list.

 2. On the Project TM tab, select Add Project TMs.

 3. On the Add Project TMs dialog, enter the project TM information.

Field Action

Select a Project Select a project name from the drop-down list.

Source Language Leave the auto-populated source language.

Target Language(s) Leave the auto-populated target languages.
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Field Action

List of TMs Review the list of TMs associated with that project.

 4. Select OK.

The selected project TMs are added to the project and are displayed in the Project TM list.

Connect to a Remote TM
You can connect to one or more translation memories (TMs) on other computers, including a free, hosted service,
such as Wordfast Anywhere (WFA).

 WFA allows translators to connect to a shared server and interact with a private, remote TM and
glossary.

To connect to a remote TM:

 1.  On the Projects tab, double-click a project from the projects list to open it.

 2. In the Current Project view, and on the Project TM tab, click Connect To Remote.

 3. On the Connect to Remote TM dialog, select the appropriate tab, based on your server options.

• TM Server

• WF Server

• WFA Server

 4. (Optional) Add a TM Server on the TM Server tab, complete the required fields, then click OK.

Required fields are marked with a red asterisk.
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Field or Option Action

Symbolic Name Enter a unique name for the TM. The symbolic name can be automatically
populated from the URL String for remote TM connections.

URL Enter the remote TM URL using the following format: tms://address:port/
TMS?. The remaining URL Settings automatically populate when you enter the
URL string. Click Test to validate the connection. The symbolic name can also be
automatically populated from the URL String for remote TM connections.

TM Cleanup Passcode Enter the password to update the TM for the project.

Priority Select a priority from the drop-down list.
The priority determines the sequence of reference during translation, first
referencing the primary TM, then any secondary TMs. You can only designate
one TM as primary.

Selected (Optional) Select to use the current TM for the project.

Read-only (Optional) Select to leverage the TM without updating it with the new translation.

 5. (Optional) Add a WF Server on the WF Server tab, complete the required fields, then click OK.
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Required fields are marked with a red asterisk.

Field or Option Action

Symbolic Name Enter a unique name for the TM. The symbolic name can be automatically
populated from the URL String for remote TM connections.

URL Enter the remote TM URL using the following format: wf://
jsmith.password@address:port/TMS?. The remaining URL Settings
automatically populate when you enter the URL string. The symbolic name can
also be automatically populated from the URL String for remote TM connections.
(Optional) The Password and Workgroup ID fields depend on server settings.
Click Test to validate the connection.

Address Enter the address associated with the URL.

Port Enter the port associated with the URL.

Account Name Enter the username associated with the URL log in.

Account Password (Optional) Enter the password associated with the username.

Workgroup ID (Optional) Enter the workgroup ID for the project.
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Field or Option Action

Use TM (Write)
Password

Enable, if you are a PM or TM Administrator, to require a password to overwrite
the existing TM with new translations.

TM (Write) Password If enabled, enter the password to overwrite the existing TM with new translations.

Selected (Optional) Select to use the current TM for the project.

Read-only (Optional) Select to leverage the TM without updating it with the new translation.

 6. (Optional) Add a WFA Server on the WFA Server tab, complete the required fields, then click OK.

Required fields are marked with a red asterisk.

Field or Option Action

Symbolic Name Enter a unique name for the TM.

API key Enter the API key you obtain from WFA.

1. Log in to your free WFA account at https://www.freetm.com.
2. Click TMs & Glossaries, then Setup.
3. On the TMs and glossaries management dialog, select a TM or glossary.
4. Click Manage Sharing.
5. On the TMs and glossaries shares dialog, click the API key and copy the

text string.
6. Paste the API key into the Connect to Remote TM dialog using the

following format: username@1234567, then click Test to validate the
connection.

Priority Select a priority from the drop-down list.
The priority determines the sequence of reference during translation, first
referencing the primary TM, then any secondary TMs. You can only designate
one TM as primary.

Selected (Optional) Select to use the current TM for the project.
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Field or Option Action

Read-only (Optional) Select to leverage the TM without updating it with the new translation.

The new TM is added to the project and is displayed in the project TM list.

Open and Edit a Local TM
You can open and edit local translation memory (TM) entries at any time after TM creation.

 
You cannot open a remote TM in TM Editor.

To open and edit a local TM:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

 2. On the Project TM tab, select a translation memory and select Open TM.

 3. On the TM Editor tab, view the translation units (TUs) for both source and target languages.
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 4. (Optional) To search for source or target translation units (TUs), enter your search criteria in the appropriate

fields in the Filters sidebar, then select Find.

 You can make your filtered search case-sensitive or specify an exact match, then filter further by
creator, user, and modification date.

 5. (Optional) To reset your search criteria, select Clear.

 6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste to edit a TM entry.

Modify a TM
To rename, write-protect, or change the priority of a TM, use the Modify TM action.

To modify a local or remote TM:

 1.  In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

 2. On the Project TM tab, click a TM.

 3. Click Modify TM.

 4. On the Connect to Remote TM dialog, modify the details for your connection. Based on your selection, other

fields auto-populate. Refer to Connect to a Remote TM.

 
You can only select one primary TM for a project.

Required fields are marked with a red asterisk.
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 5. (Optional) Select the TM identified in the Name field for the current project using Selected.

 6. (Optional) Select Read-only to allow users to leverage the TM but not update it with new translation.

 7. Click OK.

Your modifications to the TM are saved.

Copy a Local TM
Copy a TM to use an existing TM for a new project.

 
The copied TM is in the Wordfast Pro TM format, regardless of the original TM format.

To copy a local translation memory:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

 2. On the Project TM tab, select a translation memory and select Copy TM.



8. Leverage Project TMs Wordfast

Copyright © Wordfast, LLC 2023.   Page 110 of 236

 3. On the Copy Translation Memory dialog, enter the TM Name.

 
Required fields are marked with a red asterisk.

 4. Browse and select the Location on your disk for the TM copy.

 5. (Optional) Select Flip Languages, to reverse the source and target languages, then select Copy.

A copy of the translation memory is saved in the selected folder location.

Import a Local TM
To use a local translation memory (TM) from another linguist, use the Import TM action.

To import a local TM:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

 2. Select Import TM on the Project TM tab.

 3. On the Import Translation Memory dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.
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Field Action

File Type Select an action from the drop-down list.

• TMX — Translation Memory eXchange file format provides compatibility
with all translation tools.

• WF TXT TM format (.txt) — File format provides backward compatibility
for Wordfast Classic and Wordfast Pro 3.

Import File Browse to select the file for import.

Create New TM Select to import the TM into a new TM file.

Import into Existing TM Select to import the TM into an available TM file, based on selection from the
drop-down list.

Existing TM Select an available TM file from the drop-down list.

If TU already exists Select a TM option from the drop-down list to import it into an available TM file.

Delete all TUs from
existing TM

Select to delete the existing TM and replace it with the new TM.

 4. Select OK.

The translation memory is imported and is displayed in the Project TM list.

Export a Local TM
To share a local translation memory (TM) with another linguist, use the Export TM action.

To export a local TM:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

 2. Select a TM assigned to that project.
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 3. Select Export TM on the Project TM tab.

 4. On the Export Translation Memory dialog, choose a location and export type for the TM export file.

 
Required fields are marked with a red asterisk.

Translation Memory Select a TM from the drop-down list.

Export Type Select the export file type from the drop-down list.

File Location Browse and select the folder location for the export.

 5. Select OK.

The selected translation memory exports to the selected folder location.
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9. Leverage Project Terminology Lists
Terminology is a phrase used to identify two distinct groupings: the glossary and the blocklist.

• Glossary—A database of preferred source terms, words, and phrases paired with their target equivalents
designated as preferred and client-specific

• Blocklist—A database of rejected target terms prohibited from use in the translation

Leverage Project Glossaries
A glossary includes source terms and a correlated list of preferred target terms.

LEVERAGE PROJECT GLOSSARIES

Create a Local Glossary
To create a local glossary:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

 2. In the Current Project view, on the Project Terminology tab, click Create Local.

 3. On the Create Glossary dialog, enter the glossary information.

 
Required fields are marked with a red asterisk.

Field Action

Name Enter a unique name for the glossary.

Source Language Do nothing, since the source language auto-populates.
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Field Action

Target Language Select a language from the target languages available for your project in drop-
down list.

Location Browse and select the folder location for the new glossary.

Selected (Optional) Select to use the current local glossary for the project.

Read Only (Optional) Select to leverage the glossary without updating it with new terms.

 4. Click OK.

The new glossary is displayed in the project glossary.

LEVERAGE PROJECT GLOSSARIES

Add a Local Glossary
You can only add glossaries created by Wordfast Pro 4 or 5. For glossaries from Wordfast Classic or Wordfast
Pro 3, use the Import Glossary action. Refer to Import a Local Glossary.

To add a local glossary:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list.

 2. In the Current Project view, on the Project Terminology tab, select Add Local.

 3. On the Creating Glossary dialog, browse to a glossary folder and select it.

 4. Select Select Folder.

The selected glossary is added to the project and is displayed in the project Glossaries list.

LEVERAGE PROJECT GLOSSARIES

Add Project Glossaries
Some projects may use multiple local and remote glossaries. In such instances, you can add all of the glossaries
from a previous project with a single Add Project Glossaries action.

To add project glossaries:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

 2. In the Current Project view, on the Project Terminology tab, select Add Project Glossaries.

 3. On the Add Project Glossaries dialog, enter the project glossaries information.
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Field Action

Select a Project Select a project name from the drop-down list.

Source Language Leave the auto-populated source language, based on the project.

Target Language(s) Leave the auto-populated target languages, based on the project.

List of Glossaries Review the list of glossaries associated with that project.

 4. Select OK.

The selected project glossaries are added to the project and displayed in the project Glossaries list.

LEVERAGE PROJECT GLOSSARIES

Connect to a Remote Glossary
You can connect to a glossary residing on another server, including a free hosted service, such as Wordfast
Anywhere (WFA).

 WFA allows translators to connect to a shared server and interact with a private, remote translation
memory (TM) and glossary.

To connect to a remote glossary:

 1. On the Projects tab, double-click a project from the projects list.

 2. On the Project Terminology tab, click Connect To Remote.

 3. On the Connect to Remote Glossary dialog, select the appropriate tab, based on your server options.
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• TMGR Server

• WF Server

• WFA Server

 4. (Optional) Add a Term Manager (TMGR) Server on the TMGR Server tab and complete the required fields.

 
Required fields are marked with a red asterisk.

Field or Option Action

Name Enter a unique name for the glossary. The name can be automatically populated
from the URL String for remote glossary connections.

Target Language Select a language from the drop-down list. This list is constrained by the available
target languages for your project.

URL Enter the remote glossary URL using the following format: tmgrs://
address:port/TMGR?.

Note: The remaining URL Settings automatically populate when you enter the
URL string. This includes the username, password, and project short code.
The name can also be automatically populated from the URL String for remote
glossary connections.
Click Test to validate the connection.

Selected (Optional) Select to use the current glossary for the project.

Read-only (Optional) Select to leverage the glossary without updating new terms.
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Field or Option Action

Create Blocklist
Connection

(Optional) Select to connect to an available blocklist already in TMGR.

 5. (Optional) Add a WF Server on the WF Server tab and complete the required fields.

Required fields are marked with a red asterisk.

Field or Option Action

Name Enter a unique name for the glossary. The name can be automatically populated
from the URL String for remote glossary connections.

URL Enter the remote glossary URL using the following format: wf://
jsmith:password@address:port/tmgr?. The remaining URL Settings
automatically populate when you enter the URL string. Click Test to validate the
connection. The name can be automatically populated from the URL String for
remote glossary connections.

Address Enter the address associated with the URL.

Port Enter the port associated with the URL.

Account Name Enter the username associated with the URL log in.

Account Password (Optional) Enter the password associated with the username.

Workgroup ID (Optional) Enter the workgroup ID for the project.
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Field or Option Action

Selected (Optional) Select to use the current glossary for the project.

Read-only (Optional) Select to leverage the glossary without updating new terms.

 6. (Optional) Add a WFA Server on the WFA Server tab and complete the required fields.

Field or Option Action

Name Enter a unique name for the glossary.

Target Language Select a language from the drop-down list.

Note: This list is constrained by the available target languages for your project.

API KEY Enter the API key you obtain from WFA.

1. Log in to your free WFA account at https://www.freetm.com.
2. Click on TMs & Glossaries, then Setup.
3. On the TMs and glossaries management dialog, select a glossary.
4. Click Manage Sharing.
5. On the TMs and glossaries shares dialog, click on the API key and copy

the text string.
6. Paste the API key into the Connect to Remote Glossary dialog on the

WFA Server tab using the following format: username@1234567, then
click Test to validate the connection.

Selected (Optional) Select to use the current glossary for the project.

Read-only (Optional) Select to leverage the glossary without updating new terms.

 7. Click OK.

The selected glossary is added to the project and is displayed in the project Glossaries list.



9. Leverage Project Terminology Lists Wordfast

Copyright © Wordfast, LLC 2023.   Page 119 of 236

LEVERAGE PROJECT GLOSSARIES

Open a Remote Glossary
You can open and view remote glossary entries at any time after a glossary is connected.

 
You can only view the terms in a remote glossary. You cannot edit the glossary.

To open a remote glossary from the TXLF Editor view:

 
1. In the TXLF Editor view, click Open Glossary on the Terminology tab, or click the Open Glossary icon 

on the Terminology pane.

The remote glossary will open in your default browser.

 2. (Optional) If you are connected to multiple remote glossaries, clicking Open Glossary or the Terminology List

button (from the Terminology tab) opens the Project Glossaries dialog; do one of the following:

• Click a remote glossary location link.

• Select a remote glossary, then click Open.

 3. (Optional) In the Currect Project view, on the Project Terminology tab, do one of the following:

• Click a remote glossary location link.

• Select a remote glossary, then click Open Glossary.

The remote glossary will open in your default browser.

LEVERAGE PROJECT GLOSSARIES

Open and Edit a Local Glossary
You can open and edit local glossary entries at any time after glossary creation.

To open and edit a local glossary:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

 2. In the Current Project view, on the Project Terminology tab, select a local glossary, and select Open
Glossary.
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 3. In the Glossary Editor, view the terms for both source and target languages. You can also filter, add, remove,

and update terms.

 4. (Optional) To search for source or target terms, enter your search criteria in the appropriate fields in the Filters
sidebar, then select Find.

 You can make your filtered search case-sensitive or specify an exact match, then filter further by
creator, user, and modification date.

 5. (Optional) To reset your search criteria, select Clear.

 6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste within the source and target columns.

LEVERAGE PROJECT GLOSSARIES

Import a Local Glossary
To exchange glossaries with other translators, save the exported glossary to a local drive, then use the Import
Glossary action to import it to your project.
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To exchange glossaries among projects on your local drive, use the Add Project Glossaries action.

To import a local glossary:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list.

 2. In the Current Project view, on the Project Terminology tab, select Import Glossary.

 3. On the Import Glossary dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.

Field Action

File Type Select a file format for importing raw text files.

• Term Base eXchange (TBX) — Use with other CAT tool glossaries

• Tab delimited text file (TXT) — Use with Wordfast Classic and Wordfast
Pro glossaries

Import File Select Browse to locate and select an Import File.

Create a new glossary Select to use the imported glossary to create a new glossary rather than add
terms to an existing glossary.

Import into existing
glossary

Select to use the imported glossary to add to the selected glossary.

Existing Glossary Select from the drop-down list to append the imported glossary to an existing
glossary file.
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Field Action

If term already exists Select from the drop-down list to import the term into an existing glossary file.

• Add as a new term — Add the term to the existing glossary file.

• Do not overwrite — Ignore the term and retain the term already in the
glossary file.

• Overwrite existing term — Use the new term to replace the term already
in the glossary file.

Delete all terms from
existing glossary

Select to delete the existing term and replace it with the new glossary term.

 4. Select OK.

The glossary is imported and is displayed in the project Glossaries list.

LEVERAGE PROJECT GLOSSARIES

Export a Local Glossary
To exchange glossaries with other translators, use the Export Glossary action and save it to a local drive, then
send it to another translator to import to their project.

 
To exchange glossaries among projects on your local drive, use the Add Project Glossaries action.

To export a local glossary:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list.

 2. In the Current Project view, on the Project Terminology tab, select a glossary and select Export Glossary.

 3. On the Export Glossary dialog, select a glossary from the drop-down list.

 4. Select the file Export Type from the drop-down list.

• Term Base eXchange (TBX) — Use with other computer-assisted translation (CAT) tool glossaries
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• Tab delimited text file (TXT) — Use with Wordfast Classic and Wordfast Pro 3 glossaries

 5. Select Browse to locate and select the export file location, then select Save.

 6. Select OK.

The glossary is exported to the specified file location.

Leverage Project Blocklists
You can use a blocklist to exclude words or phrases from use in the target segment.

LEVERAGE PROJECT BLOCKLISTS

Create a Local Blocklist
You can create a blocklist for your project on your local computer.

To create a local blocklist:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list.

 2. In the Current Project view, on the Project Terminology tab, select Create Local in the Blocklist group.

 3. On the Create Blocklist dialog, enter the required blocklist information.

 
Required fields are marked with a red asterisk.

Field Action

Name
Enter a unique blocklist name that includes the client or organization name and the
blocklist target language for easy identification.

Language
Select the blocklist's target language, which is limited to languages configured in
the project.

Location Select the destination for the new blocklist.
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Field Action

Selected (Optional) Select to use the current blocklist for the project.

Read-Only (Optional) Select to leverage the blocklist without updating it with the new
translation.

 4. Select OK.

The new blocklist is created and is displayed in the project terminology list.

LEVERAGE PROJECT BLOCKLISTS

Add a Local Blocklist
Use a local blocklist already created on your computer when you want to leverage a translation blocklist, but do
not want to collaborate with other users. You can add a local blocklist to your project at the time of creation or as a
separate action.

To add a local blocklist:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

 2. In the Current Project view, on the Project Terminology tab, select Add Local in the Blocklist group.

 3. On the Creating Blocklist dialog, browse to a blocklist file and select it.

 4. Select Select Folder.

The selected blocklist is added to the project and is displayed in the project terminology list.

LEVERAGE PROJECT BLOCKLISTS

Connect to a Remote Blocklist
You can connect to one or more blocklists on another computer or server.

To connect to a remote blocklist:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list.

 2. In the Current Project view, on the Project Terminology tab, click Connect To Remote.

 3. On the Connect to Remote Blocklist dialog, enter the required information, based on your server options.

Required fields are marked with a red asterisk.
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Field or Option Action

Name Enter a unique name for the blocklist.

Target Language Select a target language from the drop-down list.

URL Enter the remote TMGR URL using the following format: tmgrs://
address:port/TMS?. The remaining URL Settings automatically populate
when you enter the URL string. Click Test to validate the connection.

Address Enter the remote address.

Username Enter the username associated with the URL log in.

Password Enter the password associated with the username.

Project Short Code Enter the short code for the project, such as ABC0000001.

Selected (Optional) Select to use the current blocklist for the project.

 4. Click OK.

The new remote blocklist is displayed in the project terminology list.

LEVERAGE PROJECT BLOCKLISTS

Open and Edit a Local Blocklist
You can open and edit local blocklist entries at any time after blocklist creation.

 
You cannot open a remote blocklist in Wordfast Pro.

To open and edit a local blocklist:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.



9. Leverage Project Terminology Lists Wordfast

Copyright © Wordfast, LLC 2023.   Page 126 of 236

 2. In the Current Project view, on the Project Terminology tab, select a local blocklist, and select Open
Blocklist.

 3. On the Blocklist Editor tab, view the blocklist terms for both source and target languages. You can also filter,

add, remove, and update terms.

 4. (Optional) To search for source or target blocklist terms, enter your search criteria in the appropriate fields in

the Filters sidebar, then select Find.

 You can make your filtered search case-sensitive or specify an exact match, then filter further by
creator, user, and modification date.

 5. (Optional) To reset your search criteria, select Clear.

 6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste to edit entries within the forbidden

and suggested term columns.

LEVERAGE PROJECT BLOCKLISTS

Import a Local Blocklist
To use a local blocklist from another source, use the Import Blocklist action.

To import a local blocklist:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list.

 2. In the Current Project view, on the Project Terminology tab, select Import Blocklist.
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 3. On the Import Blocklist dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.

Field Action

File Type Select TXT as the file format for importing raw text files.

Import File Select Browse to locate and select an Import File.

Create a new blocklist Select to use the imported blocklist to create a new blocklist, rather than add
terms to an existing blocklist.

Import into existing
blocklist

Select to use the imported blocklist to add to the selected blocklist.

Existing Blocklist Select from the drop-down list to append the imported blocklist to an existing
blocklist file.

If term already exists Select from the drop-down list to import the term into an existing blocklist file.

• Add as a new term — Add the term to the existing blocklist file.

• Do not overwrite — Ignore the term and retain the term already in the
blocklist file.

• Overwrite existing term — Use the new term to replace the term already
in the blocklist file.

Delete all terms from
existing Blocklist

Select to delete the existing term and replace it with the new blocklist term.

 4. Select OK.

The blocklist is imported and displayed in the project Blocklist.
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LEVERAGE PROJECT BLOCKLISTS

Export a Local Blocklist
To share a local blocklist with another linguist, use the Export Blocklist action.

To export a local blocklist:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list.

 2. In the Current Project view, on the Project Terminology tab, select a blocklist from the project Blocklist.

 3. Select Export Blocklist on the Project Terminology tab.

 4. On the Export Blocklist dialog, choose a blocklist name, export type, and folder location for the blocklist

export file.

 
Required fields are marked with a red asterisk.

Blocklist Select a blocklist from the drop-down list.

Export Type Select the export file type from the drop-down list.

File Location Browse and select the folder location for the export file.

 5. Select OK.

The selected blocklist exports to the selected folder location.

Use Project Terminology Options
You can use the Project Terminology tab to modify and remove glossaries and blocklists.
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USE PROJECT TERMINOLOGY OPTIONS

Modify a Glossary or Blocklist
To modify a glossary or blocklist:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list.

 2. In the Current Project view, on the Project Terminology tab, select a glossary or blocklist.

 3. Select Modify.

 4. On the Create Glossary dialog, modify the details as required. Based on your selection, other fields auto-

populate.

 
Required fields are marked with a red asterisk.

Name Modify the name of the current glossary or blocklist.

Selected (Optional) Select to use the current glossary or blocklist for modification.

Read Only (Optional) Select to leverage the glossary or blocklist without updating it with the new
translation.

 5. Select OK.

Your modifications are saved.
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USE PROJECT TERMINOLOGY OPTIONS

Remove a Glossary or Blocklist
When you remove a glossary or blocklist from a project, the glossary or blocklist file remains in the glossary or
blocklist folder on your computer. You can add it again with the Add Local or Connect to Remote action.

To remove a glossary or blocklist:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list.

 2. In the Current Project view, on the Project Terminology tab, select a glossary or blocklist.

 3. Select Remove.

A warning message asks you to agree to the removal.

 4. Select Yes.

The selected glossary or blocklist is removed from the project terminology list.
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10. Monitor Reports
Use the Reports tab to open and to export auto-generated analysis and cleanup reports to .CSV, .HTML, .XLS,
and .PDF formats.

Open a Report
Use the Open Report action to open and view an auto-generated report.

To open a report:

 1. In the Current Project view, on the Reports tab, select a report.

 2. Double-click the report file name.
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 3. Review the report, then select OK to close the dialog.

Export a Report
You can export an auto-generated report to a CSV, HTML, XLS, or PDF file format before you view it.

To export a report:

 1. On the Reports tab, select a report.

 2. Select a format from the Export drop-down list.

 3. Browse to the location for the report, enter a file name, and select Save.

The report is saved to the designated location.
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11. Manage Project Reference Files
You can include reference files in a project to provide context. Typical reference files are additional instructions,
illustrations, workflow diagrams, certifications, or any file that might aid translators and reviewers. Reference files
remain untranslated.

 
Users cannot modify reference files once you attach them to the project.

Add Reference Files
To add reference files:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

 2. In the Current Project view, on the Reference Files tab, select Add Files.

 3. On the Open dialog, browse and select the reference file. To select multiple reference files, press Ctrl and

select them.

 4. Select Open.

The files are added to the reference files list for the project.
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Open a Reference File
To open a reference file:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

 2. In the Current Project view, on the Reference Files tab, select a reference file from the list.

 3. Select Open File.

The selected file is opened.

View Submission Instructions
Submitters can include instructions as part of the Package files imported into Wordfast Pro.

To view instructions:

 1. On the Projects tab, double-click a project from the projects list to open it.

 2. On the Reference Files tab, select Show Instructions.

 3. On the Instructions dialog, review the instructions on the first Instructions tab, then select the Background
Instructions tab for any project-related or more general information and instructions.

 4. Select OK.

The Instructions dialog is closed.

Remove a Reference File
You can remove a reference file from a project, but the file remains on your local computer.

 
To add a removed reference file, use the Add Files action on the Reference Files tab.

To remove a reference file:

 1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

 2. In the Current Project view, on the Reference Files tab, select the files you want to remove.

 3. Select Remove File(s).
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 4. On the Remove dialog, select one of the available buttons.

Remove from the list only Removes the reference file from the files list, but
retains the reference files resources in the project
folder on your computer

Remove from the list and move the following
resources to Archive folder

Removes the reference file from the files list and
moves them to the archive folder inside the project
folder on your local computer

 5. Select OK.
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12. Use Quick Tools
You can use Quick Tools to create and work with files outside of projects. Typically, Project Managers use Quick
Tools before cleaning up and sending files to translation.

 • When you first open Quick Tools, the default is the Analysis tab. Once you access Quick
Tools, the default Quick Tools tab is the last one you used.

• You can choose to run many Quick Tools actions in the background and continue your work.
This is useful when processing large numbers of files.

Analysis
You can use actions on the Analysis tab to create TXLF files or assess potential translation memory (TM)
matches and repetitions for selected source files.

Analyze without using the TM panel is a quick way to obtain the word count of the files before TM leveraging.
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 • Selected languages are not required when using Analyze without a TM.

You can pre-translate target segments using your TM and machine translation on No Match. You can also select
Maintain existing target (if present) to pre-translate only blank target segments and preserve any existing
translations in TXLF target segments with no TM match.

To analyze files:

 1. Select the Wordfast Pro drop-down menu, then select Quick Tools.

 2. Select the Analysis tab, if it is not already selected.

 3. On the Files panel, choose one of the following actions:

 To search the File Name column for a particular string, enter the search string in the available search

field next to  on the Files panel.

Add Files Select to browse and select a file from a folder.
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Add Folder Select to browse and select a folder and all its files.

Remove Files Select to remove a folder and all its files or all selected files from the list.

 4. (Optional) On the Translation Memories panel, select one or more TMs from the list of available TMs, then

choose one of the following actions:

 • To search the TM Name column for a particular string, enter the search string in the available

search field next to  on the Translation Memories panel.

• If you do not select a TM, the analysis report displays the word count without TM leverage and
the Language Selection option is not available.

Item Action

Create Local Select to open the Create TM dialog and create a local TM for quick, local
access. Refer to Create a Local TM.

Add Local TM Select, then select a local TM or a project TM from the project list from the drop-
down list. Refer to Add a Local TM to a Project and Add Project TMs.

Connect to Remote Select to open the Connect to Remote TM dialog and complete the appropriate
information to connect to a remote TM for the project. Refer to Connect to a
Remote TM for entering information into the TM Server and WF Server tabs.The
symbolic name can be automatically populated from the URL String for remote
TM connections.

Import TM Select to open the Import Translation Memory dialog and complete the
appropriate information to import a TM for the project. Refer to Import a Local TM.

Open TM Select to open and edit the selected TM. Refer to Open and Edit a Local TM.

Modify TM Depending on the TM you select, select to open either the Modify a Local
TM dialog or the Modify a Remote TM dialog, then complete the appropriate
information to rename, write-protect, or change the priority of a TM for the project.
Refer to Connect to a Remote Glossary.

Remove TM Select to remove the selected TM from the project list.

 5. (Optional) On the Analysis Options panel, select the method for bilingual source file creation from the Create
TXLF files drop-down list, such as InDesign or MS Word files.

 6. For Analyze without TM, select the appropriate languages from the Source Languages and Target
Languages drop-down list.

 The options are not available for TXLF source files, or for non-TXLF source files when you also select
a TM.

 7. (Optional) Complete Pretranslation Options.
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a) Select Pretranslate, then set the baseline match percentage for the TM leverage with the type of match

from the drop-down list.

Item Action

Copy Source (clears
existing target)

When there is no matching target content, select to insert source content in its
place.

Copy Tags (clears
existing target)

When there is no matching target content, select to insert source tags in its
place.

Primary MT (if
available, clears
existing target)

Select to leverage machine translation (MT) matches for all segments that do
not have a TM match.
If you have TM matches, but do not select the TM before you select Analyze,
the MT overwrites all target segments.

Maintain existing target
(if present)

When there is existing target content, retain it. Otherwise, insert source content
in its place.

Clear existing target
content

Overwrite target content with source content.

b) Select any of the following actions:

Item Action

Lock leveraged 100%
matches

Write-protect all leveraged matches that are 100% matches.

Lock leveraged context
matches

Write-protect all leveraged matches that are contextual matches.

Ignore locked
segments from report

Do not consider locked target segments identified in the Analysis report.

Ignore translated
segments from report

Do not consider target segments identified in the Analysis report.

Ignore translated exact
segments from report

Do not consider only exact match target segments identified in the Analysis
report.

 8. For the Report Settings, choose from the following actions:

Item Action

Calculate analysis report percentage by: Select Words or Segments as the means of
calculating analysis percentages from the drop-down
list.



12. Use Quick Tools Wordfast

Copyright © Wordfast, LLC 2023.   Page 140 of 236

Item Action

Calculate internal fuzzy matches • (Optional) Select according to the match
percentage you set or select an alternate
percentage.

• (Optional) Select Include internal fuzzy
matches as TM matches.

• (Optional) Select Include whitespace in total
character count (excludes CJK languages).
This is useful for including space counts in the
character count.

Report type Select a report type from the drop-down list.

Report location Select one of the following actions:

• Next to source

• Custom location, then browse to and select
an alternate location for the report on your local
computer.

 9. Select Analyze Files.

 10. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the

background batch action for future analysis actions, then select Run in Background.

 11. If you chose to run Analyze Files in the background, you can monitor its progress.

 If you choose to run more than one batch action in the background, each action will have its own
progress bar.

 12. After successful completion, view the report, then close the report browser window.

The Analysis Report is saved to your computer at the specified location.

Extract Uniques
You can use actions on the Extract Uniques tab to remove frequently occurring segments, control exclusions for
matches, and create a .TXLF file of these unique segments before sending it out for translation. It uses the action
for each file you selected in the TXLF Files panel.
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You can set the number of occurrences of a segment to be extracted to two or higher to create a file containing
only repeated segments. If you exclude context TM matches, 100% TM matches, and locked segments from the
extract, it further reduces the number of extracted segments.

To extract unique segments:

 1. In the Quick Tools view, select the Extract Uniques tab, if it is not already selected.

 2. On the TXLF Files panel, choose one of the following actions:

 To search the File Name column for a particular string, enter the search string in the available search

field next to  on the TXLF Files panel.

Add Files Select to browse and select a file from a folder.

Add Folder Select to browse and select a folder and all its files.

Remove Files Select to remove a folder and all its files or all selected files from the list.

 3. (Optional) On the Extract Unique Segments Options panel, select an Extract option:

Make one uniques file
per TXLF

Select to create a separate TXLF file for each selected file in the TXLF Files
panel.

New uniques file after #
segments

Select to split a TXLF file into smaller files, based on the number of unique
segments you specified. The default value is 250. For example, this option would
split a file with 1000 unique segments into four files of 250 segments each.
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 4. (Optional) Select an Extract Location, by choosing one of the following actions:

• Select Place unique segments next to TXLF.

• Select Place in subfolder, then browse to and select a location on your computer, then use the default
uniques prefix or create your own.

•  
If you changed the uniques prefix, it will have the prefix you designate at the location you select.

 5. (Optional) Select the type of segments you want to exclude in the Extract Uniques Options panel and the

minimum frequency of occurrence.

• Exclude context TM matches

• Exclude 100% TM matches

• Exclude locked segments

 6. (Optional) In the Report Options panel, add a report name prefix or use the default uniques-extracted.

 7. In the Report Options panel, select a Report Location, by choosing one of the following actions:

• Select Next to Original TXLF. This is the default Report location.

• Select Custom Location, then browse to and select the report location on your computer.

 8. Select Extract Uniques.

 9. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the

background batch action for future analysis actions, then select Run in Background.

 10. If you chose to run Extract Uniques in the background, you can monitor its progress.

 If you choose to run more than one batch action in the background, each action will have its own
progress bar.
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After successful completion, the TXLF files containing unique segments are saved to your computer at the
selected location a dialog box listing the number of extracted segments. If a file did not have any unique
segments, no file is created.

Populate Uniques
You can use actions on the Populate Uniques tab to add the target translation from the translated uniques file
back into the original TXLF file. After the uniques population, it creates a Populate Unique Segments report that
identifies all related segment errors. This is helpful when determining why certain target segments did not properly
populate.

To populate unique segments:

 1. In the Quick Tools view, select the Populate Uniques tab, if it is not already selected.

 2. On the Uniques Files and Original TXLF Files panels, choose one of the following actions to select a file or

files to receive unique segments that have a high frequency of occurrence as an import from the original TXLF

files you selected.

 • To search the File Name column for a particular string, enter the search string in the available

search field next to  on the Uniques Files and Original TXLF Files panels.
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• If you do not choose a new folder for this action, the populated files are placed in a separate
folder.

Add Files Select to browse and select a file from a folder.

Add Folder Select to browse and select a folder and all its files.

Remove Files Select to remove a folder and all its files or all selected files from the list.

 3. (Optional) Select from the following Populate Unique Segments Options:

• Populate TXLF in new folder

• Only report non-populated segments

 4. (Optional) Add a report name prefix or use the default uniques-populated prefix you used for the Extract

Uniques report.

 5. Select a Report Location, by choosing one of the following actions:

• Select Next to Original TXLF.

• Select Custom Location, then browse to and select the report location on your computer.

 6. Select Populate Uniques.

The uniques from the translated uniques file are populated into the original .TXLF file.

 7. After successful completion of the action, view any errors that occur in the Populate Unique Segments report

that have to do with the population of segments into the original TXLF file, then close the report browser

window.

The Populate Unique Segments report is saved to your computer at the selected location.

Quick Tools Transcheck
You can use Transcheck to scan translated content for non-linguistic errors such as missing tags, empty targets,
numbers, and terminology within target segments. Using the Quick Tools Transcheck action is best for running
on groups of files as a bulk batch.

 If you have specific terms you want Transcheck to ignore, you can mark those segments for exclusion
to reduce false positives during Transcheck error detection.
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To run Quick Tools Transcheck:

 1. In the Quick Tools view, select the Transcheck tab, if it is not already selected.

 2. On the TXLF Files panel, choose one of the following actions:

 To search the File Name column for a particular string, select the search icon  on the TXLF Files
panel and enter the search string in the available search field.

Add Files Select to browse and select a file from a folder.

Add Folder Select to browse and select a folder and all its files.

Remove Files Select to remove a folder and all its files or all selected files from the list.

 3. Select an action for the Glossary or Blocklist tabs.

 To search the Glossary Name or Blocklist Name column for a particular string, select the search

icon  on the Glossary or Blocklist panel and enter the search string in the available search field.

Option Action

Create Local Select to create a new glossary or blocklist and add it to the list of available ones.

Add Local Select and choose from the drop-down list to add to a local or project glossary or
blocklist.
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Option Action

Connect to Remote Select to connect a remote glossary or blocklist to the project. Refer to Connect
to a Remote Glossary for entering information into the TMGR Server and WF
Server tabs. The symbolic name can be automatically populated from the URL
String for remote glossary connections.

Import Glossary or
Import Blocklist

Select to import .TBX or tab-delimited files to a glossary or blocklist assigned to
the project.

Open Select to open a glossary or blocklist in the Editor view.

Modify Select to modify a glossary or blocklist assigned to the project.

Remove Select to remove a glossary or blocklist assigned to the project.

 4. On the Transcheck Options panel, select items within any of the major categories.

 • To search for an option, enter text in the search field above the options column list. To select
all, select the checkbox, and to clear all options, deselect the checkbox. Use the Up or Down
Arrow keys to move among the options, then the Spacebar to enable or disable.

• The Sub-options panel to the right of the Transcheck Options panel contains any sub-options
related to the selected category. Use the Tab key to enter and move among sub-options, then
the Spacebar to enable or disable. To enter the Sub-options panel, press Tab. To exit the Sub-
options panel, press Shift + Tab.

a) Select items for the Segment Content Checks category.

Option Action

Capitalization Select to identify any capitalization issues for translated segments in the edited
file.

Source Consistency Select for consistency of source content across a single file or multiple edited
files.

Target Consistency Select for consistency of target content across a single file or multiple edited
files.

Copied Source Select to identify any target segments that are identical to the source segment
in the edited file.

Empty Target Select to identify any empty target segments that do not contain a translation in
the edited file.

Note Select to identify any target segments in the edited file with related notes.

Number Difference Select to compare numerical values in source and target segments in the
edited file, then identify any discrepancies.

Punctuation Select to compare punctuation in source and target segments in the edited file,
then identify any discrepancies.

Repeated Word Select to identify any repetitions of words or subwords in target segments
within the edited file. Repeated subwords are found using a regular expression.



12. Use Quick Tools Wordfast

Copyright © Wordfast, LLC 2023.   Page 147 of 236

Option Action

Segment Length Select to compare source and target segment length in the edited file, then
identify any discrepancies.

Smart Punctuation Select to confirm the punctuation in the target segment is correct for that
language.

Tag Select to identify any target segments in the edited file with missing tags.

Whitespace Select to compare source and target segment white space usage in the edited
file, then identify any discrepancies.

b) Select items for the Segment Status Checks category.

Option Action

Edited Context Match Select to identify any changes to the context matches for translated segments
in the edited file.

Edited Exact Match Select to identify any changes to exact matches for translated segments in the
edited file.

Edited Source Select to identify any updates to the original segment content in the edited file.

Do Not Write to TM
Segment

Select to identify any translated segments marked as unconfirmed in the edited
file, so not committed to the translation memory.

Unedited Exact Match Select to identify any unedited or overlooked exact match segments in the
edited file.

Unedited Fuzzy Match Select to identify any unedited or overlooked fuzzy match segments in the
edited file.

c) Select items for the Reference Checks category.

Option Action

Blocklist Select to cross-reference the available blocklist with the edited file.

Forbidden Character Select to identify any provided forbidden characters remaining within the edited
file.

Mistranslated Text Select to identify any mistranslated or inaccurate translation in segments within
the edited file.

Spelling Select to identify any misspellings in translated segments within the edited file.

Terminology Select to identify any overlooked terminology matches for translated segments
in the edited file.

Untranslatable Text Select to identify all target segments that contain content that cannot be
translated in the edited file.

Untranslated MT Select to identify all target segments that contain untranslated machine
translation (MT) content in the edited file.

 5. Create your Report Settings.
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a) (Optional) Use the default transcheck prefix or create an alternate prefix for the report.

b) Select Next to TXLF to create the Transcheck Report next to the existing TXLF file location, or browse and

select an alternate Report Location on your local computer.

 6. Select Transcheck Files.

 7. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the

background batch action for future analysis actions, then select Run in Background.

 8. If you chose to run Transcheck in the background, you can monitor its progress.

 If you choose to run more than one batch action in the background, each action will have its own
progress bar.

 9. After successful completion, view the report, then close the report browser window.

The Project Transcheck Report is saved to your computer at the selected location.

TM Update
To clean up and convert bilingual .TXLF files to their original source format in the target language, use TM
Update. Refer to Translate Segments.

 
TM Update actions overwrite the translation memory (TM).

To use TM Update:

 1. Select the Wordfast Pro drop-down menu, then select Quick Tools.

 2. Select the TM Update tab, if it is not already selected.
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 3. On the TXLF Files panel, choose one of the following actions:

 To search the File Name column for a particular string, enter the search string in the available search

field next to on the TXLF Files panel.

Add Files Select to browse and select a file from a folder.

Add Folder Select to browse and select a folder and all its files.

Remove Files Select to remove a folder and all its files or all selected files from the list.

 4. On the Translation Memory panel, choose a TM or several TMs from the list, then choose one of the

following actions:

 • To search the TM Name column for a particular string, enter the search string in the available

search field next to on the Translation Memory panel.

• To better understand context matches or the TM, refer to Leverage Project TMs.

Item Action

Create Local Select to create a new TM and add it to the list of available TMs.
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Item Action

Add Local TM or Add
Project TMs

Select and choose from the drop-down list to add to a local TM or to a project
TM.

Note: If you choose a project TM, you can only add a TM to a locale already
assigned to the project.

Connect to Remote Select to connect a remote TM to the project. Refer to Connect to a Remote
TM for entering information into the TM Server and WF Server tabs. The
symbolic name can be automatically populated from the URL String for
remote TM connections.

Import TM Select to import .TMX or .TXT files to a TM assigned to the project.

Open TM Select to open a TM in the TM Editor view.

Modify TM Select to modify a TM assigned to the project.

Remove TM Select to remove a TM assigned to the project.

 5. (Optional) Configure the TM Update Options:

 
Use the search field next to a TM action to search that column above the search field location.

Item Action

Update Option Select one of the TM update options from the drop-down menu:

• Append

• Do not add to TM

• Do not overwrite TU to retain existing TUs

• Overwrite existing TU to overwrite existing translation units (TUs)

• Overwrite if attributes are identical

Add attribute Select to add an attribute to write to the TM for cleaned up segments.

Add file name as an
attribute

Select to add the TXLF file name as an attribute to write to the TM for
cleaned up segments.

Overwrite private TUs
(WFServer TM only)

Select to replace existing private TUs with new ones. This requires a Cleanup
password.

Write 'unedited fuzzy' to TM Select to write fuzzy matches to the TM without user modification.

Write 'unedited
autopropagated fuzzy' to
TM

Select to write automatically inserted fuzzy matches to the TM without user
modification.

Write 'context' matches to
TM

Select to write context matches to the TM without user modification.

Write 'exact' matches to TM Select to write exact matches to the TM without user modification.

Write 'unedited MT' to TM Select to write machine translation to the TM without user modification.
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 6. Select a Translated File Settings option for translation file creation from the drop-down list.

Item Action

Next to source with target
language suffix

Select to save translated files in the same location as the source TXLF files,
in original format, after appending the target language code to the file name
as a suffix.

Inside subfolder and
maintain folder structure for
folders

Select to save translated files in the same location as your TXLF files, but in a
subfolder that retains the source folder hierarchy.

Do not create translated
files

Select to prevent the creation of translated files and retain the source TXLF
files.

 7. Choose one of the following actions, when enabled for the options you selected:

Item Action

Update & Create Select to update the TM and create a translated TXLF file.

Create Translated Files Select to create a translated TXLF file without updating the TM.

Update TM Select to update the TM without creating a translated TXLF file.

 8. (Optional) On the Progress Bar dialog, you can select Always run in the background to preserve the

background batch action for future analysis actions, then select Run in Background.

 9. If you chose to run Update & Create in the background, you can monitor its progress.

 If you choose to run more than one batch action in the background, each action will have its own
progress bar.

The bilingual TXLF file is converted to its original source format in the target language.

Pseudo Translation
Pseudo-translation simulates the entire translation process. This is particularly useful for several situations.

• Use to verify successful completion of the extraction, translation, and creation of a translated file.

• Use to identify any text expansion issues that might occur during translation.

• Use to identify any font issues during creation of the translation file.

• Use to identify any formatting or missing content issues.
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You can copy the source content to the target content to preview translatable content for target languages and the
complexity of associated formatting. This preview is particularly useful when content has accented characters and
when the content is likely to expand during translation.

 • Pseudo-translation requires source files in a supported file format, such as .DOC or .TXT files.

• If you use Wordfast Pro in Demo Mode, the limit on processing pseudo translation is 20 files.
To simultaneously pseudo-translate more than 20 files, obtain a Wordfast Pro license.

To pseudo-translate files:

 1. In the Quick Tools view, select the Pseudo Translation tab, if it is not already selected.

 2. On the TXLF Files panel, choose one of the following actions:

 To search the File Name column for a particular string, enter the search string in the available search

field next to the Search icon on the TXLF Files panel.

Add Files Select to browse and select a file from a folder.

Add Folder Select to browse and select a folder and all its files.

Remove File(s) Select to remove a folder and all its files or all selected files from the list.

 3. Select a Source Language and Target Language for the Language Selection section.

 4. (Optional) In the Pseudo Translation Options section, select either or both options for creating a target file

and adding a suffix to the target filename, then select an option to either place it next to the source file or to

browse and select an alternate location.

 5. Select Pseudotranslate Files.
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 6. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the

background batch action for future analysis actions, then select Run in Background.

 7. If you chose to run Pseudotranslate Files in the background, you can monitor its progress.

 If you choose to run more than one batch action in the background, each action will have its own
progress bar.

The pseudo-translation is created and a successful completion message is displayed.

Quick Tools Bilingual Export
Use Bilingual Export to export the TXLF file with highlighted glossary terms to a .DOC or .DOCX format for edit
and translation of the content using Microsoft Word (Word).

 You must not edit the exported table format. This includes merging or expanding segments and
adding text outside of the target or notes column. Editing the exported table format will result in errors
during bilingual import.

To conduct a Quick Tools bilingual export:

 1. In the Quick Tools view, select the Bilingual Export tab, if not already selected.
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 2. On the TXLF Files panel, choose one of the following actions:

 To search the File Name column for a particular string, enter the search string in the available search

field next to on the TXLF Files panel.

Add Files Select to browse and select a file from a folder.

Add Folder Select to browse and select a folder and all its files.

Remove Files Select to remove a folder and all its files, or all selected files from the list.

  To search the File Name column for a particular string, enter the search string in the available search

field next to on the Glossaries panel.

3. On the Glossaries panel, choose one of the following actions:

Item Action

Create Local Create a glossary on your local computer.

Add Local or Add
Project Glossaries

Select and choose from the drop-down list to add to a local glossary or to a
project glossary.

Note: If you choose a project glossary, you can only add a glossary to a locale
already assigned to the project.

Import Glossary Select to import .TBX or tab-delimited files to a glossary assigned to the project.

Connect to Remote Select to connect a remote glossary to the project. Refer to Connect to a Remote
Glossary.

Open Select to open a glossary in the Glossary Editor view.

Modify Select to modify a glossary assigned to the project.

Remove Select to remove a glossary assigned to the project.

 4. On the Bilingual Export Options panel, choose your export options.

Option Action

Select export type from drop-
down

Select an export type option from the drop-down list:

• Bilingual Review Export — Creates a bilingual Word document.

• WFC Bilingual Export (Export only) — Creates a Wordfast
Classic compatible document solely for export.

• MS-Word Table — Creates a Word document with the source
and target in a two-column table.

• Bilingual Review Export - WFC (allows import) — Creates a
bilingual Word document for import by Wordfast Classic users.

Open report after export Select to automatically display the Export Report after action
completion.
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Option Action

Exclude the notes column Select to remove the Notes column from the exported Word document.
Instead, the export includes the notes from the TXLF file as Comments
in the Word document.

Track changes Select to track changes in the exported Word document.

Protect document (Word 2003+) Select to only allow content edits in the available table space.

Note: This helps avoid any import errors.

Export as DOCX Select to export bilingual file to a .DOCX Word file format.

Export all TXLF files as one
bilingual file

Select to export all converted TXLF files into a single bilingual Word
document.

 5. (Optional) Either browse to and select a Custom instructions text file, or choose any of the following options

to include in the file, using default instructions:

• App Name

• Instructions

• Legend

• This document

 6. Choose to either use the original file location, or browse and select an alternate location.

 7. Select Export Bilingual Files.

 8. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the

background batch action for future analysis actions, then select Run in Background.

 9. If you chose to run Export Bilingual Files in the background, you can monitor its progress.

 If you choose to run more than one batch action in the background, each action will have its own
progress bar.
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Each exported document is saved to the specified folder on your local computer. The example does not
include any custom content.
 

 10. (Optional) View the bilingual files at the location you specified on your computer.

Quick Tools Bilingual Import
Use Bilingual Import to re-import your translated or edited Microsoft Word (Word) bilingual export document.

Bilingual Import options allow you to open a report, accept tracked changes, and create a merged file from a
translated Word document.

 You must upload both the translated or edited bilingual Word document and the source TXLF file you
used during export.

 Since imports overwrite content from the export, create a backup of the original TXLF file for
reference.

 • For bilingual files, the first number in the Counter column indicates the count of TXLF files
in the bilingual file that are paired with the added files in the TXLF Files panel. The second
number indicates the total count of TXLF files that were used during bilingual export.

• For TXLF Files, when the bilingual Word document and the corresponding TXLF file are paired,

 is displayed. If the files are not paired,  is displayed.
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To conduct a Quick Tools bilingual import:

 1. In the Quick Tools view, select the Bilingual Import tab, if not already selected.

 2. On the Bilingual Files panel, choose one of the following actions:

 To search the File Name column for a particular string, enter the search string in the available search

field next to on the Bilingual Files panel.

Add Files Select to browse and select a TXLF file from a bilingual export folder, such as
Sample.txlf.doc, and add it to the Bilingual Files list.

: You must select the correct file format from the drop-down list. Select MS
Word Document when uploading the bilingual Word document and WF TXLF
Document when uploading the TXLF file.

Add Folder Select to browse and select a folder and all its files from a bilingual export folder
to add to the available TXLF Files list.

Remove Files Select to remove a folder and all its files or all selected files from the list.

 3. On the Bilingual Import Options panel, choose your import options.

Open report after import Select to automatically open a report after bilingual import.

Accept Tracked Changes Select to accept tracked changes in a bilingual Word document.

Create merged file Select to create a single merged file as a bilingual Word document.

 4. Browse to and select a TXLF files import location.

 5. Select Import Bilingual Files.
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Files excluded during export are ignored during import.

 6. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the

background batch action for future analysis actions, then select Run in Background.

 7. If you chose to run Import Bilingual Files in the background, you can monitor its progress.

 If you choose to run more than one batch action in the background, each action will have its own
progress bar.

The translations and edits in the bilingual export Word document are imported into the specified TXLF file on
your local computer.

 
The import overwrites the TXLF file content with the imported bilingual Word document content.

Segment Changes
You can run a Segment Changes Report on one or more project files to view the history of changes to a segment.
The report includes the segment ID, TM score, source and target content with the highlighted changes, username,
time stamp, and translator notes. This is particularly useful in workflows that involve multiple people.
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To generate a segment changes report:

 1. In the Quick Tools view, select the Segment Changes tab, if it is not already selected.

 2. On the TXLF Files panel, choose one of the following actions:

 To search the File Name column for a particular string, enter the search string in the available search

field next to on the TXLF Files panel.

Add Files Select to browse and select a file from a folder.

Add Folder Select to browse and select a folder and all its files.

Remove Files Select to remove a folder and all its files, or all selected files from the list.

 3. Select one or more files for the Segment Changes Report.
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 4. On the Segment Changes Report Options pane, choose from the following options:

• Show Columns option—Select any of the column options. The report does not include any columns you
do not select with this option.

• Enable Difference highlighting

• Show all segments (including unmodified)

• Show latest changes in each phase

• Open report after export

• Filter Phase-name(s)—Select a phase name from the drop-down list to filter by the project's workflow
phases.

• Filter Process-name(s)—Select a process name from the drop-down list to filter by the project's
processes.

• Include all phases before selected phase-Name(s)

 5. (Optional) Use the default prefix of segmentchanges or enter a custom prefix.

 6. Choose one of the following actions:

• Select Next to Original TXLF to save the segment changes report next to the original TXLF file.

• Browse and select the Custom location folder where you want to save the segment changes report.

 7. Select Run Segment Changes.

The Segment Changes Summary is displayed.

 8. After review, select OK.

 9. (Optional) Go to the designated location and view the Segment Changes Report.
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Advanced Quick Tools
The Advanced tab gives you access to several advanced features, each with its own independent action or set of
actions.

ADVANCED QUICK TOOLS

Lock or Unlock Segments
You can quickly lock or unlock segments in the .TXLF files you select. You can lock 100% or context matches to
prevent translators or editors from making changes to them.
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To lock or unlock segments:

 1. In the Quick Tools view, select the Advanced tab, if it is not already selected.

 2. On the TXLF Files panel, choose one of the following actions:

 To search the File Name column for a particular string, enter the search string in the available search

field next to on the TXLF Files panel.

Add Files Select to browse and select a file from a folder.

Add Folder Select to browse and select a folder and all its files.

Remove Files Select to remove a folder and all its files, or all selected files from the list.

 3. On the Lock/Unlock Segments area, select one or both of the Lock/Unlock Segments options:

• Lock 100% matches

• Lock context matches

 4. Select either Unlock Segments or Lock Segments.

The segments you selected are locked or unlocked.
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ADVANCED QUICK TOOLS

Swap the Source and Target
You can swap the source and target in translation files to create a back translation that validates the translated
content.

To swap the source and target:

 1. In the Quick Tools view, select the Advanced tab, if it is not already selected.

 2. On the TXLF Files panel, choose one of the following actions:

 To search the File Name column for a particular string, enter the search string in the available search

field next to the Search icon on the TXLF Files panel.

Add Files Select to browse and select a file from a folder.

Add Folder Select to browse and select a folder and all its files.

Remove Files Select to remove a folder and all its files, or all selected files from the list.

 3. On the Advanced Options panel in the Swap source and target area, select Swap.

 4. (Optional) Select either or both of the following options before selecting Swap.
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Clear target Select to clear target language when Swap is selected. For example, swapping
an English to German translation, German will be the source language and the
target language column will be empty.

Remove notes Select to remove all notes from each segment when Swap is selected.

The source and target content is swapped.

ADVANCED QUICK TOOLS

Split or Merge a TXLF File
You can split files to break a large file into smaller files. You can set a specific number of translation units (TUs),
parts, or words the translated content for each file. For example, you can break a file of 1,000 TUs into four files of
250 TUs each. If there is a remainder, the last file contains the remnant.

You can use a file merge to either update the original file or create a new merged file.

With either option, you designate a specific location to split or merge the files to.
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To split or merge a TXLF file:

 1. In the Quick Tools view, select the Advanced tab, if it is not already selected.

 2. On the TXLF Files panel, choose one of the following actions:

 To search the File Name column for a particular string, enter the search string in the available search

field next to on the TXLF Files panel.

Add Files Select to browse and select a file from a folder.

Add Folder Select to browse and select a folder and all its files.

Remove Files Select to remove a folder and all its files, or all selected files from the list.

 3. On the Advanced Options panel in the Split/Merge TXLF area, select one of the following:

• Split TXLF in new folder

• Place split files in the original files location

• To Choose location for the split files, select Browse... to select a folder.
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 4. Select one of the following Split File Options:

• Split after x TUs (approx.)

• Split to x parts (approx.)

• Split after x words (approx.)

 5. If you have already split files, you can merge them back into a single TXLF file. To do so, on the TXLF Files
panel, Add Files to be merged, then choose one of the following Merge File Options:

Original files location: Select Browse... to select the folder the original files are in.

Update existing file Select to browse and select a folder and all its files.

Create new merged file The new file will be created in the original file location.

Merge TXLF in new
folder

The merge TXLF file will be in a new folder in the original files location.

Choose location for the
merged files

Select Browse... to select a folder you want the merged file to be create.

 6. Select either Split TXLF or Merge TXLF.

The files you selected are split into multiple .TXLF files or are merged into a single .TXLF file format.
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13. Configure Preferences
User preference options control the functions available to you in the user interface. Configure preferences at
either the project level or the file level.

Preferences fall into primary categories:

• General Preferences

• Current Project Preferences

General Preferences
Use General Preferences to configure user interface and TXLF Editor view preferences.

GENERAL PREFERENCES

Configure Color Settings
The Colors preferences control color customization for specific types of content in TXLF Editor view.

 When you change preferences from the default options, select OK to activate your selection.

If you wish to return to the defaults, select Restore Defaults in Advanced Settings.

To configure colors used in the translation table:

 

1. On the Sidebar, select the Preferences icon .

 2. On the Preferences dialog, select Colors under General Preferences.
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 3. Select the color box for any Item Name, then select another color from the color palette on the Color Picker
dialog.

 4. Select OK to close the dialog.

 5. Select OK.

GENERAL PREFERENCES

Configure General Settings
General preferences link a specific username to project-related content changes.

To customize general settings:

 

1. On the Sidebar, select the Preferences icon .

 2. On the Preferences dialog, select General under General Preferences.
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 3. Enter the User Name for user identification on notes, TM, and segment changes.

 4. Select one of the source file locations.

 
If the source file is a TXLF file, a copy is saved.

Option Action

Copy Source or TXLF Files into Project Folder
Structure

Select to create a sub-folder within the project
language folder for storing source files.

Create TXLF File with language suffix next to the
Source File

Select to create a TXLF copy of the source file at the
same location with the target language code as a
suffix.

Create Folder with language suffix next to the
Source File where TXLF file will be stored

Select to create a TXLF copy of the source file in a
source file sub-folder using the target language code
as a suffix.

 5. Select the Quick Project Options to show the Open TXLF choices dialog during the process of creating a

Quick Project. Refer to Open a TXLF File.

 6. Select columns to include in the Get MS Word Table Options, then set the tag mode.

Option Action

Segment ID Select to include the Segment ID column in the MS
Word table.
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Option Action

Source Select to include the Source column in the MS Word
table.

Score Select to include the Score column in the MS Word
table.

Set Tag mode to: Select the tag mode from the drop-down list.

• Show supported text formatting

• Show formatting as Tags

• Do not show Tags

 7. Select the Bilingual Review Export options to export a file with highlighted glossary terms in a Microsoft

Word .DOC or .DOCX format.

Option Action

Open report after export Select to automatically open the Bilingual Report after
the export completes.

Exclude the notes column Select to exclude the notes column from the exported
MS Word document.

Track changes Select to enable track changes in the exported MS
Word document.

Protect document (Word 2003+) Select to write-protect the document. This allows
users to edit only the target segment content and add
notes.

Export as Docx Select to export the bilingual report in the
Word .DOCX file format.

Export all TXLF files as one bilingual file Select to export all submission files as a single
bilingual file.

 8. Select the option to display the dialog for running Quick Tools analysis and cleanup as batch actions that run

in the background.

 9. To automatically provide a live preview of the translated file when working in the TXLF Editor, enable the

Live Preview option. This option supports MS Word .DOC and .DOCX, MS Powerpoint .PPT and .PPTX, and

Markdown .MD source file formats.

 10. Set the search depth when using the remote TM for your connected TM server type. The search depth is the

number of segment results that can be viewed for a particular search within a remote TM.

GENERAL PREFERENCES

Configure Fonts
Fonts preferences control customization of font type and size for application-wide functions, such as notes.
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To configure fonts:

 

1. On the Sidebar, select the Preferences icon .

 2. Select Fonts under General Preferences.

 3. Select an application-specific font and size for an item name, such as Segment History Font.

 4. Select Change. A sample of the selected font displays in the Preview: pane.

 5. Select a language-specific font.

 6. Add, remove, or change the language-specific font

 7. Select OK.

GENERAL PREFERENCES

Configure Icon Settings
Icons preferences control the relative size of the icon and include or exclude the icon title.

To configure icon settings:

 

1. On the Sidebar, select the Preferences icon .

 2. On the Preferences dialog, select Icons under General Preferences.
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 3. Select a size for application icons.

 4. (Optional) Clear Display text to exclude icon description text.

 5. Select OK.

GENERAL PREFERENCES

Configure Layout Options
Layout preferences control the arrangement of user interface views.

To configure layout options:

 

1. On the Sidebar, select the Preferences icon .

 2. Select Layout under General Preferences.
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 3. Modify the Table View layout to hide or show columns and headers. The default setting has none of these

items selected.

 4. Modify the TM Score Column Position layout for before or after the target column. The default setting is After
Target.

 5. Modify the TM Difference Highlight to highlight differences in TM Lookup and Segment History tabs

based on words or characters. The default setting is Words except for CJK languages where the default is

Characters.

 6. Modify the Current Project layout to include the target language name or use a language code in the view.

 7. Modify the Status Bar Representation layout in the Current Project view.

Language Codes Select to include language codes on the Status Bar.

Full Language Name Select to include the complete language name on the Status Bar.

 8. Select OK.
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GENERAL PREFERENCES

Configure Segment Actions
Segment Actions preferences control segment action behaviors, such as Smart Quotes or Smart Punctuation.

To configure segment actions:

 

1. On the Sidebar, select the Preferences icon .

 2. On the Preferences dialog, select Segment under General Preferences.

 3. Select a segment option.

Option Action

Next/Previous Segment action
leverages next/previous segment

Select to automatically leverage the TM for the segment as you
make the segment active.

Commit changes the segment state
to Translated

Select to change the segment state to Translated when you select
Commit. You can toggle back to Needs Translation by selecting
the segment state.

Open the last edited segment when
opening a file

Select to go to the last segment edited after reopening a file.
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Option Action

Leverage the first opened segment
on click

Select to automatically leverage the TM for the first open segment
you click after opening a file for translation.

Capitalize the first letter of the target
segment (Except Asian Languages)

Select to convert translated segments to sentence case. Not
applicable for Asian languages.

Enable Smart Quotes Select to activate both Smart Quote and Smart Punctuation
features.

• Smart Quotes—Changes the quotation marks to smart
quotes, depending on the target language.

• Smart Punctuation—Changes white space and punctuation
mark elements to those appropriate for the target language,
with the exception of Chinese, Japanese, and Korean (CJK)
languages and those that read from right-to-left (RTL), such
as Arabic, Hebrew, Persian, and Urdu.

Note: The white space group includes spaces, non-breaking
spaces, and white space representations: the middot and overring.
The white space group also includes cases where an exclamation
point or question mark exists in isolation at the beginning of the
segment, sentence, or paragraph.

Copy source with number
conversions

Select to enable suggesting the correct number conversion as the
top suggestion and copy source numbers into the target with the
correctly converted numbers for the language.

Skip Unedited 100% Matches Select to ignore 100% matched segments.

Skip Unedited Context Matches Select to ignore segments with context matches.

Commit changes of the state of
empty segments to Translated

Select to have all empty segments in the source show as
Translated

Cursor position on segment opening Select to place the cursor at the beginning or end of the active
segment.

• Start—The default places the cursor at the beginning of the
segment on segment selection.

• End—Places the cursor at the end of the segment on
segment selection.

Number conversion character
selection (overrides default):

Select to override the default number conversion character for all
languages in the project.

• Digit Grouping Character: Space, Period, Comma, Non-
breaking Space, Apostrophe, or Blank

• Decimal Character: Period, or Comma

• Enable digit grouping for numbers having less than
five digits:  will not group numbers less than five digits, for
example: 9999.00 instead of 9,999.00
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GENERAL PREFERENCES

Customize Keyboard Shortcuts
Shortcuts preferences control keyboard shortcuts for the commands that you frequently use.

To customize keyboard shortcuts:

 

1. On the Sidebar, select the Preferences icon .

 2. On the Preferences dialog, select Shortcuts under General Preferences.

 3. Select a style Scheme from the drop-down list.

  You cannot change the standard Windows keyboard shortcuts such as copy, paste, bold, or italic.

When changing or creating new shortcut key sequences, the sequence must either begin with a Ctrl,
Alt, or Shift, must use a function key, or use a combination of these.

4. Select a Command from the command list and enter a new sequence of keys in the Shortcut column, then

select OK.

 5. (Optional) If you choose a shortcut key sequence already in use, a warning message notifies you that it will

override the prior key sequence. Click Yes to save the new shortcut for a command.

The new shortcut key sequence is saved.



13. Configure Preferences Wordfast

Copyright © Wordfast, LLC 2023.   Page 177 of 236

GENERAL PREFERENCES

Configure Warning Messages
Warnings preferences control the type of warning notifications you receive.

To configure warning messages:

 

1. On the Sidebar, select the Preferences icon .

 2. On the Preferences dialog, select Warnings under General Preferences.

 3. Select your warning notifications.

 4. Select OK.

GENERAL PREFERENCES

Configure Tags and Formatting
Tags and Formatting preferences control the tag mode, representation, and font size in the TXLF Editor view.

To configure tag and formatting options:

 

1. On the Sidebar, select the Preferences icon .

 2. On the Preferences dialog, select Tags under General Preferences.
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 3. Modify Text Formatting options.

Option Action

Show supported text
formatting

Select to display formatted content in the TXLF Editor view, along with a
sample of the formatted content in Preview.

Show formatting as Tags Select to display content with formatting tags in the TXLF Editor view,
along with a sample of the formatted content and tags in Preview.

 4. Modify Tag Naming options.

Option Action

Full Name Select to view the tag's full name, for example Font.

Short Name Select to view the tag's short name, for example F.

Numbered Tags Select to view the tag's number, for example 3.

Remove incomplete tag pairs Select to delete incomplete or incorrect tags from the file.

Apply source segment
formatting to target segment

Select to apply segment formatting within a tag from the source segment
to the target segment.
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GENERAL PREFERENCES

Configure Auto-Propagation
Auto-Propagation preferences control the automatic update of TXLF segments with specified types of repeated
content.

To configure auto-propagation:

 

1. On the Sidebar, select the Preferences icon .

 2. On the Preferences dialog, select Auto-Propagation under General Preferences.

 3. Select Enable Auto-Propagation for repetitions to activate additional auto-propagation options (default).

 4. Select Enable Auto-Propagation across all open files to allow the user to apply the proposed propagation

to all files that are open.

 5. Select any of the Auto-Propagation overwrite options.

Option Action

Context matches Select to overwrite context leveraged translation memory (TM) matches.

100% matches Select to overwrite 100% leveraged TM matches, enabled by default.

Fuzzy matches Select to overwrite partial TM matches, enabled by default.

No match Select to overwrite the target segment for segments that have no match, enabled
by default.



13. Configure Preferences Wordfast

Copyright © Wordfast, LLC 2023.   Page 180 of 236

Option Action

Auto-propagated
matches

Select to overwrite all auto-propagated matches, enabled by default.

Note: If there are multiple segments with the same content, editing a segment
auto-propagates the change to all matching segments.

Edited segments Select to overwrite edited segments.

Machine translated
segments

Select to overwrite machine translated segments, enabled by default.

Committed segments Select to overwrite all translated segments that are committed to the TM.

GENERAL PREFERENCES

Configure Auto-Suggestion
Auto-Suggestion preferences control automatic recommendations for source content, such as numbers, URLs,
and proper names. It can also recommend terms for the glossary, Translation Memory (TM) matches, and
machine translation (MT) matches.

To configure auto-suggestion:

 

1. On the Sidebar, select the Preferences icon .

 2. On the Preferences dialog, select Auto-Suggestion under General Preferences.
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 3. Select the Enable Auto-Suggestion check box and suggestion options, then select OK.

Option Action

Capitalized source
words

Select for source segment suggestions: numbers and capitalized words only.

Glossary terms Select for glossary suggestions, based on the project.

TM Select for translation suggestions from the TM.

TM sub-segments Select for sub-segment translation suggestions from the TM.

MT Select for machine translation (MT) translation suggestions.

GENERAL PREFERENCES

Configure and Enable Spellchecker
Spellchecker preferences control the interaction between the application and Microsoft Office, Hunspell, or Bing.
The Hunspell option requires software installation on your computer.

To configure and enable Spellchecker:

 

1. On the Sidebar, select the Preferences icon .



13. Configure Preferences Wordfast

Copyright © Wordfast, LLC 2023.   Page 182 of 236

 2. Select Spellchecker in the General Preferences group.

 3. Select Enable Spellchecking to activate the spellchecker in TXLF Editor. This option is selected by default,

and makes the Spellcheck File option available on the Review tab in TXLF Editor. You need to configure

the spellchecker for Microsoft Office, Hunspell, or Bing language engines. Hunspell is selected by default, and

comes with several languages already preset: English, German, French, and Spanish.

 Clear Enable Spellchecking to disable the spellchecker. Disabling the spellchecker clears all
spellchecker preferences. You must reconfigure your preferences the next time you enable
Spellchecker.

 
Bing requires a paid subscription.

 

To install additional Hunspell languages, select  on the Sidebar, then select Update Wordfast
Pro. Select Check For Updates. Select the languages to update, then select Update. You will then
need to restart the application. Hunspell is available for the following languages.

Language Code Language Code

Arabic AR Korean (South Korea) KO-KR

Basque (Basque) EU-ES Latvian (Latvia) LV-LV

Bosnian (Bosnia) BS-BA Lithuanian (Lithuania) LT-LT

Bulgarian (Bulgaria) BG-BG Malaysian (Malaysia) MS-MY
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Language Code Language Code

Catalan (Catalan) CA-ES Norwegian (Bokmål Norway) NB-NO

Croatian (Croatia) HR-HR Norwegian (Nynorsk Norway) NN-NO

Czech (Czech Republic) CS-CZ Polish (Poland) PL-PL

Danish (Denmark) DA-DK Portuguese (Brazil) PT-BR

Dutch (Netherlands) NL-NL Portuguese (Portugal) PT-PT

English (Canada) EN-CA Romanian (Romania) RO-RO

English (United Kingdom) EN-GB Russian (Russia) RU-RU

English (United States) EN-US Scottish Gaelic (United Kingdom) GD-GB

Estonian (Estonia) ET-EE Serbian (Serbia) SR-RS

Farsi (Iran) FA-IR Slovak (Slovakia) SK-SK

Finnish (Finland) FI-FI Slovenian (Slovenia) SL-SI

French (Canada) FR-CA Spanish (Mexico) ES-MX

French (France) FR-FR Spanish (Spain) ES-ES

Galician (Spain) GL-ES Swedish (Sweden) SV-SE

German (Germany) DE-DE Swahili (Kenya) SW-KE

Greek (Greece) EL-GR Tagalog (Philippines) TL-PH

Hebrew (Israel) HB-IL Thai (Thailand) TH-TH

Hindi (India) HI-IN Turkish (Turkey) TR-TR

Hungarian (Hungary) HU-HU Ukrainian (Ukraine) UK-UA

Indonesian (Indonesia) ID-ID Urdu UR

Irish (Ireland) GA-IE Vietnamese (Vietnam) VI-VN

Italian (Italy) IT-IT Welsh (United Kingdom) CY-GB

Japanese (Japan) JA-JP Zulu (South Africa) ZU-ZA

Kazakh (Kazakhstan) KK-KZ

 4. Select Check for spelling errors as you type to auto-check text as you type it into TXLF Editor.

 5. Select OK to save your spellchecker configuration.

GENERAL PREFERENCES

Configure Machine Translation
Machine Translation (MT) preferences control automatic population of target segments with translations that
have no translation memory (TM) segment matches using a machine translation engine.
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To configure machine translation:

 

1. On the Sidebar, select the Preferences icon .

 2. On the Preferences dialog, select Machine Translation under General Preferences.

 3. Select one of the following:

• Show MT results in TM Lookup when there is no TM match, to show machine translated content without
local or remote TM matches.

• Always show MT results in TM Lookup, to show machine translated content with leveraged segments.
TM matches display in TM Lookup with the MT matches.

 4. Select check boxes to allow All unedited segments in active document to be leveraged with MT, and to

Remove MT score from score column when a segment is edited.

 5. Select Enable DeepL Pro, Enable Google Translator, Enable Microsoft Translator, Enable SYSTRAN
Pure Neural Server,Enable WorldLingo or, Enable Custom MT as the primary machine translator. You can

enable all five, but you can only designate one as the primary machine translator.

 6. Select MT options for each machine translator, then perform the designated setup tasks associated with each

machine translator.

 WorldLingo has a limited set of source languages for MT.
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• Arabic

• Chinese Simplified

• Chinese Traditional

• Dutch

• English

• French

• German

• Greek

• Italian

• Japanese

• Korean

• Portuguese

• Russian

• Spanish

• Swedish

Translator Options

Enable DeepL Pro

Enable Google
Translator

Enable Microsoft
Translator
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Translator Options

Enable SYSTRAN
Pure Neural Server

Enable WorldLingo

WorldLingo MT has a limited source language set.

Enable Custom MT

If your remote Machine Translation provider is not listed as a provider tab, use the
Custom MT to create a custom connector. A Custom MT is only possible if the API of
your MT provider uses a REST standard, and returns results in JSON or similar format.
That is the case with major MT providers currently available with WFP, for example,
Google, Microsoft, WorldLingo, deepL, etc..
Note: This section is Do-It-Yourself. Our hotline cannot assist with the customization of
an MT engine because that requires knowledge of the remote provider specifications.
Public discussion groups may offer help.

 7. Select Test to validate the connection to the external machine translation provider.

 8. Read the disclaimer and select OK.

Your machine translation preferences are configured.

Current Project Preferences
Current Project Preferences control settings unique to individual projects. Either you or your Project Manager
can set project preferences.

 
New Project Preferences displays if a project is not opened in the Project List view.
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CURRENT PROJECT PREFERENCES

Configure Replacement
Replacement preferences allow you to select certain types of content in the source translation units (TUs) that
will be replaced with the correct target language format in the translation memory (TM). These replacements
provide better TM matches when the files are analyzed.

To enable replacements:

 

1. On the Sidebar, select the Preferences icon .

 2. Select Replacement in the Current Project Preferences group.

 3. Select Enable replacement of detected text in TM results for higher TM matches, then enable specific

content type replacement options. You can select one or more options. All options are selected by default.

Options include:

• Number replacement

• URL replacement

• Punctuation replacement
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• Email address replacement

 4. Select OK.

CURRENT PROJECT PREFERENCES

Configure a Translation Memory
Translation Memory (TM) preferences control project-level TM behaviors.

To configure a translation memory:

 

1. On the Sidebar, select the Preferences icon .

 2. Select Translation Memory in the Current Project Preferences group.

 3. Configure how TMs are used in your project. After all segment and TM options are selected, select OK to

activate them.

Option Action

Segment State Use these options to tell TXLF Editor how to handle segments that have high
leverage from the TM. The default setting has the following options selected.

Set segments to Translated with leveraged Context Matches — When
a translated segment has a context match from the TM, this option sets the
segment state to Translated.

Set segments to Translated with leveraged 100% Matches — When a
translated segment has a 100% Match from the TM, this option sets the segment
state to Translated.
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Option Action

Set segments to Translated for Auto-propagated segments — When
segment is auto-propagated, this option sets the segment state to Translated.

Translation Memory Use these options to determine TM behavior during translation in TXLF Editor.

Write 'context' matches to TM — Automatically add context matched segments
to the TM. This action changes the segment state to Translated.

Write 'exact' matches to TM — Automatically add exact matched segments to
the TM. This action changes the segment state to Translated.

Write 'unedited MT' to TM — Automatically add unedited machine translated
segments to the TM. This action changes the segment state to Translated.

Write 'unedited fuzzy' to TM — Automatically add unedited fuzzy matched
segments to the TM. This action changes the segment state to Translated.

Write 'unedited autopropagated fuzzy' to TM — Automatically add unedited
autopropagated fuzzy matched segments to the TM. This option is only available
when the Write 'unedited fuzzy' to TM option is selected.

Copy source to Target on no match — Automatically copy the source content
into the target translation field when there is no matching from the TM. This
option allows the translators to replace the source text as they translate in the
target language.
Select an option from the drop-down list to specify which elements from the
source segments will be copied to the target fields:

• Copy Source

• Copy Source Text

• Copy Source, Tags And Term Translations

• Copy Source And Term Translations

• Copy Source, Tags, Source And Target Terms

• Copy Source with Source And Target Terms

Set Fuzzy match threshold (%): — Select or type the baseline percentage for
fuzzy TM matches in the percentage box. The default is 75%. This percentage
specifies the TM leverage limit for a fuzzy match. For example, with a threshold
of 75%, all segment translations between 75 to 99% match with the TM are
considered Fuzzy Match segments. Any segment matches below 75% are
considered No Match segments.
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Option Action

Report Settings — The settings in this box are used for narrowing the
calculations in TM analysis reports.

• Calculate analysis report percentage by: — Select either Words or
Segments. Words is the default setting.

• Calculate internal fuzzy matches and set threshold to (%) — Use this
option to calculate internal fuzzy matches in the analysis report. Internal
fuzzy matches are segments that are translated in the current project but
not yet incorporated into the TM. Select or type the threshold percentage
for internal fuzzy matches in the percentage box. The default is 75%. They
will be included in a separate report category unless the next option is
selected as well.

• Include internal fuzzy matches as TM matches — Select this option
to include internal fuzzy matches as fuzzy matches in the project TM
analysis. This option is only available when the previous option is
selection. Internal fuzzy matches will be included in the fuzzy match
percentage instead of broken out into a separate category.

When Updating an existing TU — The settings in the box determine how you
want the TM to behave when editing an existing translation unit (TU).

• Add to TM by overwriting the existing TU — This option overwrites the
previous translation in the TM.

• Add to TM; overwrite the existing TU if attributes are identical
(default) — If all attributes of the TU are identical, this option overwrites
the previous translation in the TM.

• Add new segments to TM; do not overwrite the existing TU — This
option adds edited segments to the TM as new segments instead of
overwriting the previously translated segment.

• Add to TM; do not overwrite the existing TU — This option adds the
translation to the TM without overwriting the existing translation. Instead of
creating a new segment, the translation will be offered as another possible
translation of the same source segment.

• Do not add to TM — Edits to existing TUs are not committed to the TM.
The segment state will remain as Needs Translation.

TM Lookup Settings — Select or type the total number of TUs to be shown in
the TM Lookup pane during translation.

CURRENT PROJECT PREFERENCES

Configure Terminology
Terminology preferences control terminology lists for leveraging previously translated content.

To select terminology options:

 1. On the Sidebar, select the Preferences icon .
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 2. Select Terminology under Current Project Preferences. All options are enabled by default.

 3. Select Enable fuzzy term recognition to view fuzzy matches.

 4. Select Enable term highlighting when typing terms to indicate terminology matches by highlight when

entered in the translation.

 5. Select Ignore case for term highlighting to ignore case difference in terminology matches.

 6. Select the number of matches you can view, then select OK.

CURRENT PROJECT PREFERENCES

Configure TM Penalties
Penalties preferences help maintain a high quality of content leveraged from a translation memory (TM). This
involves assessing a penalty to TM matches to provide a relative score for those TM matches. You can assign
a relative value to each penalty type when calculating the translation score. This score helps users differentiate
between 100% match, fuzzy match, and no match content.

To configure penalties for TM matches:

 1. On the Sidebar, select the Preferences icon .
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 2. On the Preferences dialog, select Penalties under New Project Preferences.

 3. Select a penalty, supply a threshold, then select OK.

Penalty Action

Case Select to consider differences in case.

Non Literal Select to consider differences in special characters, including
punctuation, space, apostrophe, dash, and quote.

Tag Select to consider differences in tagging.

Whitespace Select to consider differences in blank spacing.

Align Select to consider differences in translation units (TUs) with
alignment attributes.

Machine
Translation

Select to consider differences in TUs based on machine
translation (MT).

Multiple
Translation

Select to consider differences in TUs based on duplicates within
the TM with different translations.

Local TM Select to consider differences in TUs from the local desktop
copy.

Remote TM Select to consider differences in TUs from a remote TM.

Private TU Select to consider differences in work-group TUs from a remote
TM.
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Penalty Action

Public TU Select to consider differences in non-work-group TUs from a
remote TM.

Secondary TM Select to indicate that the translation leverages a secondary TM.

Attribute Select to consider differences in attributes.

If attribute is not Select for when a custom attribute in a TU does not match the
text box attribute.

If filename
attribute does not
match

Select for when the file name attribute in a TU does not match
the TXLF file name.

CURRENT PROJECT PREFERENCES

Configure Transcheck
Transcheck preferences control how Transcheck verifies target segments and issues warnings about common
translation errors within a project. For example, if a translated term conflicts with the designated glossary, the
Error Status icon  displays in the Status column in the TXLF Editor view.

To configure Transcheck:

 

1. On the Sidebar, select the Preferences icon .

 2. On the Preferences dialog, select Transcheck under New Project Preferences.

 • To search for an option, enter text in the Transcheck search field above the options column
list. To select all, select the Transcheck check box. To clear all options, deselect the check
box. Use the Up or Down Arrow keys to move among the options, then the Spacebar to
enable or disable.

• The Sub-options panel to the right of the Transcheck Options panel contains any sub-options
related to the selected category. Use the Tab key to enter and move among the sub-options,
then the Spacebar to enable or disable. To exit the Sub-options panel, press Shift+Tab.
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 3. Enable Transcheck segments while translating to use Transcheck during translation.

 4. On the Transcheck Options panel, select items within any of the major categories.

a) Select items for the Segment Content Checks category.

Option Action

Capitalization Select to identify any capitalization issues for translated segments in the edited
file.

Source Consistency Select for consistency of source content across a single file or multiple edited
files.

Target Consistency Select for consistency of target content across a single file or multiple edited
files.

Copied Source Select to identify any target segments that are identical to the source segment
in the edited file.

Empty Target Select to identify any empty target segments that do not contain a translation in
the edited file.

Note Select to identify any target segments in the edited file with related notes.

Number Difference Select to compare numerical values in source and target segments in the
edited file, then identify any discrepancies.

Punctuation Select to compare punctuation in source and target segments in the edited file,
then identify any discrepancies.

Repeated Word Select to identify any repetitions of words or subwords in target segments
within the edited file. Repeated subwords are found using a regular expression.
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Option Action

Translation Length Select to set a character length restriction on the translated segment or to
check character and word expansion percentages.

Smart Punctuation Select to confirm the punctuation in the target segment is correct for that
language.

Tag Select to identify any target segments in the edited file with missing tags.

Whitespace Select to compare source and target segment white space usage in the edited
file, then identify any discrepancies.

b) Select items for the Segment Status Checks category.

Option Action

Edited Context Match Select to identify any changes to the context matches for translated segments
in the edited file.

Edited Exact Match Select to identify any changes to exact matches for translated segments in the
edited file.

Edited Source Select to identify any updates to the original segment content in the edited file.

Do Not Write To TM
Segment

Select to identify any translated segments marked not to be committed to the
translation memory.

Unedited Exact Match Select to identify any unedited or overlooked exact match segments in the
edited file.

Unedited Fuzzy Match Select to identify any unedited or overlooked fuzzy match segments in the
edited file.

Unedited MT Select to identify all target segments that contain unedited machine translation
(MT) content in the edited file.

c) Select items for the Reference Checks category.

Option Action

Blocklist Select to cross-reference the available blocklist with the edited file.

Forbidden Character Select to identify any provided forbidden characters remaining within the edited
file.

Mistranslated Text Select to identify any mistranslated or inaccurate translation in segments within
the edited file.

Spelling Select to identify any misspellings in translated segments within the edited file.

Terminology Select to identify any overlooked terminology matches for translated segments
in the edited file.

Untranslatable Text Select to identify all target segments that contain content that cannot be
translated in the edited file.

Untranslated Text Select to identify all target segments that contain untranslated content in the
edited file.
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 5. Select OK.

Transcheck is configured for the current project.

CURRENT PROJECT PREFERENCES

Configure Segmentation
Segmentation preferences control how the TXLF editor separates file content into logical segments for a project.

To select segmentation options:

 

1. On the Sidebar, select the Preferences icon .

 2. Select Segmentation under Current Project Preferences.

 3. Change Segmentation based on your preferences. After all segmentation preferences are selected, select

OK.

Option Description

Segmentation on break Select this option to enable segmentation on line breaks.

Select segmentation
type

Select APPLICATION from the drop-down list to use application-specific
segmentation rules.
Select SRX from the drop-down list to use SRX segmentation rules.
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Option Description

Define end-of-segment
markers (ESM)

Enter specific characters into the ESM field to specify custom segment end
characters, such as .?!:.
Select checkboxes for any additional end-of-segment markers. Select as many or
as few as you prefer.
Options include:

• Space

• Tab

• Non-Breaking Space

• Line Feed

• Carriage Return

Define rules for ending
segments

Select the rules you want for ending segments. Select as many or as few as you
prefer.
Options include:

• A number followed by an ESM

• An ESM without a trailing space should end a segment

• An ESM followed by a space and a lower-case letter should end a segment

Select abbreviations
that should not be
segmented on

This area allows you to define which abbreviations should not be considered as
end-of-segment markers (ESM). To do so, first select a language from the Select
a language the drop-down list.
Standard abbreviations for that language will be displayed in the text box below
the language selection. You can edit, add, or delete abbreviations in the box.
In the Segmentation Preview box, type a few lines of text that contain
abbreviations or an ESM.
Select Check it out to view how the text will be segmented in the bilingual files
for translation.

CURRENT PROJECT PREFERENCES

Configure a File Format Filter
Filters preferences control the file format filters for importing source content to Wordfast Pro.

To configure a file format filter:

 

1. On the Sidebar, select the Preferences icon .

 2. On the Preferences dialog, select Filters under Current Project Preferences.
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 3. Select a file format filter configuration from the Extract numbers drop-down list to define the filter action on

source segments that contain only numbers.

all Select to extract all segments with only numbers for translation.

time_date_measure Select to extract only segments with a measurement value or the time and date.

none Select to ignore any segments that contain only numeric values during extract.

 4. To select the file filter settings for the open project, select a filter to list the current settings on the Format
Settings pane.

 
To search the filters, enter the search string in the Available filters search field.

 5. (Optional) Highlight a filter name and change settings on the Format Settings pane. The available options are

specific to the file filter you select.

 6. (Optional) Add a custom file filter for a filter you need that is not already in the list by selecting Add or

Remove.

 7. On the New Filter dialog, select a format from the Choose file format drop-down list to use as a template for

the new filter.

 
The Format Settings options vary, depending on the file format you choose.
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 8. Enter a filter name in the Filter Name field, then verify your configuration is correct on the Format Settings
pane.

 9. (Optional) Browse for and select any of the related Format Settings for that file format.

 10. Select OK.

The file format filter you selected is configured.

User Preferences
You can manage your user preferences, including restoring them to the default state and exporting or importing
them.

USER PREFERENCES

Configure Advanced Settings
Advanced Settings preferences allow you to restore a Wordfast Pro installation to factory or default settings,
migrate preferences between computers, and customize strings.

To configure advanced settings:

 

1. On the Sidebar, select the Preferences icon .

 2. Select Advanced Settings under User Preferences.
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 3. Change Advanced Settings based on your preferences.

Option Description

Default Settings Restore Original reverts all the preferences to their original factory settings.

Note: Once you select this option, all general preferences and custom new
project preferences will be lost.
Restore Defaults reverts the preferences only for the current project to the
default new project preferences.

Note: You must have a project open for this option to take effect.

Export/Import
Preferences Settings

Export allows you to export the settings values that you currently have applied in
Preferences for general settings and for a current project. You can select specific
preferences or export them all. You will be asked to browse to a path where the
export file will be saved with a .pref extension.
Import allows you to browse to a saved .pref file and import it. When the file is
selected, a dialog displays the preferences that will be imported. The imported
settings will not be activated in Preferences until you select OK.

Customization String
List

This field is primarily for developer's use. Select the Plus icon , type an option
in the Customization String List field, then select OK. Highlight an option and

select the Minus icon  to delete it from the list.

Note: You must restart the application for the customized strings to be applied or
removed.
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14. Appendix

Formatting Tools
The Formatting tab in the TXLF Editor includes formatting tools you can use to edit the target content format.

Formatting tools fall into three categories: format, tags, and options.

FORMATTING TOOLS

Format

 
Format category options are only available for MS Office source file formats.

Button Keyboard Shortcut Description

Ctrl+B Format the selected text as bold.

Ctrl+I Format the selected text as italic.

Ctrl+U Format the selected text as underlined.

Ctrl+= Format the selected text as subscript.

Ctrl+Shift+= Format the selected text as superscript.

No shortcut Format the selected text to display as strikethrough
(deleted), without actually deleting the text.

FORMATTING TOOLS

Tags

Button Keyboard Shortcut Description

No shortcut Display actual formatting associated with tags for the
active segment (when supported.)

No shortcut Display the content of the formatting tags for the active
segment.
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FORMATTING TOOLS

Options

Button Keyboard Shortcut Description

Ctrl+Shift+Space Insert a non-breaking space at the cursor location.

No shortcut Insert a marker to indicate left-to-right reading direction.

No shortcut Insert a marker to indicate right-to-left reading direction.

Ctrl+D Attach and detach the Formatting toolbar. When
attached, the toolbar is displayed as a tab. When
detached, the toolbar is displayed as a minimized
toolbar that can be moved to any area of the TXLF
Editor.

Format Filters
The Filters selection on the Preferences dialog box configures how translatable content is parsed from source
files.

FORMAT FILTERS

Filters

Format and Extension

Active Server Page (*.asp)

Adobe FrameMaker Interchange Format (*.mif)

Adobe InCopy Markup language (*.icml)

Adobe InDesign Interchange (*.inx)

Adobe InDesign Markup Language (*.idml)

Flat OPC XML Word Document Format (*.xml)

Hypertext Markup Language (*.htm)

Hypertext Markup Language (*.html)

JSON files (*.json)

Java Server Page (*.jsp)

MS Excel 2007 Spreadsheet (*.xlsx)
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Format and Extension

MS Excel Open XML Macro-Enabled Spreadsheet (*.xlsm)

MS Excel Open XML Spreadsheet Template (*.xltx)

MS Excel Open Spreadsheet (*.xls)

MS Excel Spreadsheet template (*.xlt)

MS PowerPoint 2007 Presentation (*.pptx)

MS PowerPoint 97-2003 Template (*.pot)

MS PowerPoint Macro-Enabled Presentation (*.pptm)

MS PowerPoint Macro-Enabled Show (*.ppsm)

MS PowerPoint Macro-Enabled Template (*.potm)

MS PowerPoint Presentations (*.ppt)

MS PowerPoint Show (*.ppsx)

MS PowerPoint Template (*.potx)

MS Visio Document (*.vdx)

MS Visio Document (*.vsd)

MS Visio Document (*.vsdx)

MS Word 2007 Document (*.docx)

MS Word Document (*.doc)

MS Word Open XML Macro-Enabled Document (*.docm)

MS Word Open XML Macro-Enabled Template (*.dotm)

MS Word Open XML Template (*.dox)

MS Word Template (*.dot)

Markdown file (*.md)

MemoQ XLIFF (*.mqxliff)

Microsoft Word 2003 WordprocessingML document (*.xml)

PO files (*.po)

Plain Text (*.txt)

Portable Document Format (*.pdf)

Quark Documents (*.tag)

Rich Text Format (*.rtf)

SDL XLIFF (*.sdlxliff)

SubRip (*.srt)

TXML (*.txml)

Trados TTX (*.ttx)
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Format and Extension

WF TXLF Document (*.txlf)

XLIFF (*.xlf)

XLIFF 2.0 (*.xlf)

XLIFF 2.0 (*.xliff)

Keyboard Shortcuts
This topic includes the keyboard shortcuts that are available for PC and Apple users for Wordfast Pro, Wordfast
Classic, SDLX, and Trados.

KEYBOARD SHORTCUTS

PC Scheme - Wordfast Pro Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blocklist Alt+C Project

Add Glossary Alt+O Project

Add Note Alt+Shift+N Editor

Add Project Ctrl+Shift+A Home

Add Project TMs Ctrl+Shift+B Quick Tools

Add Term Ctrl+Alt+T Editor

Add TM Ctrl+N Project

Analyze Ctrl+Space Editor

Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor

Clear all tags (Segment) Ctrl+Shift+V Editor

Clear Target Document Alt+Shift+Delete Editor

Clear Target Segment Ctrl+Alt+X Editor

Close Ctrl+W Editor

Close project from home window Ctrl+Shift+X Home

Close segment Esc Editor

Commit All Segments to TM Ctrl+Alt+End Editor

Commit Current Segment Alt+End Editor

Confirm/Unconfirm Segment Alt+Enter Editor
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Commands Shortcut View

Confirm All Segments Ctrl+Shift+Enter Editor

Copy Ctrl+C Blocklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources Ctrl+Alt+Insert Editor

Copy All Tags (Document) Alt+Shift+P Editor

Copy All Tags (Segment) Alt+A Editor

Copy selected text to target Alt+F12 Editor

Copy Source Alt+S Editor

Copy Tag Ctrl+Alt+Down Editor

Copy Term Ctrl+0 Editor

Copy TM Ctrl+Shift+C Project

Create Blocklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage Alt+- Editor

Cut Ctrl+X Blocklist Editor, TM Editor, Glossary Editor, Editor

Delete Note Alt+Shift+D Editor

Edit Note Alt+Shift+E Editor

Edit Term Ctrl+E Editor

Export Blocklist Alt+K Project

Export Glossary Alt+E Project

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Find/Replace Ctrl+F Editor

Get Bilingual Table Ctrl+Alt+P Editor

Go To Segment Ctrl+G Editor

Help Ctrl+Alt+H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist Alt+J Project

Import Glossary Alt+I Project

Import TM Ctrl+Shift+I Project

Insert a cent sign Ctrl+; Editor

Insert Copyright Symbol Ctrl+Alt+C Editor

Insert Ellipsis Ctrl+Alt+. Editor
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Commands Shortcut View

Insert em dash Alt+Shift+- Editor

Insert en dash F10 Editor

Insert non-breaking hyphen Ctrl+Shift+- Editor

Insert non-breaking space Ctrl+Shift+Space Editor

Insert Registered Trademark
symbol

Ctrl+Alt+R Editor

Italic Ctrl+I Editor

Key Assist Panel Ctrl+Shift+L Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Leverage Previous TU Alt+Left Editor

Leverage the first TM Lookup
match

Alt+1 Editor

Leverage the second TM
Lookup match

Alt+2 Editor

Leverage the third TM Lookup
match

Alt+3 Editor

Leverage the fourth TM Lookup
match

Alt+4 Editor

Leverage the fifth TM Lookup
match

Alt+5 Editor

Leverage the sixth TM Lookup
match

Alt+6 Editor

Leverage the seventh TM
Lookup match

Alt+7 Editor

Leverage the eighth TM Lookup
match

Alt+8 Editor

Leverage the Next TU Alt+Right Editor

Machine Translate Ctrl+Shift+M Editor

Merge Segments Alt+Page_Down Editor

Modify Alt+M Project

Modify TM Ctrl+Shift+T Project

Move the cursor between the
source and the target

Shift+Tab Editor

Next Segment (Commit to TM) Alt+Down Editor

Next Segment (No Commit) Ctrl+Down Editor
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Commands Shortcut View

Next Tag Ctrl+Alt+Right Editor

Next Term Ctrl+9 Editor

Next View Alt+W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) Ctrl+Up Editor

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctrl+Alt+Left Editor

Previous Term Ctrl+8 Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools

Quick Tools Alt+Q Home

Redo Ctrl+Y Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove TM Ctrl+Shift+R Project

Replace/Find Ctrl+H Editor

Run Transcheck Ctrl+Shift+Q Editor

Save Ctrl+S Editor

Save As F12 Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters Ctrl+Shift+8 Editor

Simple Project Creator Ctrl+P Home

Source TM Lookup Ctrl+Shift+F Editor

Spell Check F7 Editor

Split Segment Alt+Page_Up Editor

Strikethrough Ctrl+K Editor
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Commands Shortcut View

Subscript Ctrl+= Editor

Superscript Ctrl+Shift+= Editor

Term Info Alt+T Editor

Terminology Highlight Ctrl+F5 Editor

TM Concordance F8 Editor

Toggle uppercase/lowercase Shift+F3 Editor

Translate All Ctrl+Shift+End Editor

Translate File Ctrl+O Project

Translate Until Fuzzy Ctrl+Alt+F Editor

Translate Until No Match Ctrl+Shift
+Page_Down

Editor

Unconfirm All Segments Alt+Shift+Enter Editor

Underline Ctrl+U Editor

Undo Ctrl+Z Blocklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment Ctrl+Alt+V Editor

KEYBOARD SHORTCUTS

PC Scheme - Wordfast Classic Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blocklist Alt+C Project

Add Glossary Alt+O Project

Add Project Ctrl+Shift+A Home

Add Project TMs Ctrl+Shift+B Quick Tools

Add Reference Files Alt+1 Project

Add Term Ctrl+Alt+T Editor

Add TM Ctrl+N Project

Analyze Ctrl+Space Quick Tools

Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor

Clear Target Document Alt+Shift+Delete Editor

Clear Target Segment Ctrl+Alt+X Editor
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Commands Shortcut View

Close project from home window Ctrl+Shift+X Home

Commit All Segments to TM Ctrl+Alt+End Editor

Commit Current Segment Alt+Q Editor

Confirm/Unconfirm Segment Alt+Enter Editor

Confirm All Segments Ctrl+Shift+Enter Editor

Copy Ctrl+C Blocklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources Ctrl+Alt+Insert Editor

Copy All Tags (Segment) Alt+P Editor

Copy Source Alt+Insert Editor

Copy Tag Alt+Shift+Down Editor

Copy Tag Ctrl+Alt+Down TM Editor

Copy Term Ctrl+Alt+0 Editor

Copy TM Ctrl+Shift+C Project

Create Blocklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage Alt+- Editor

Cut Ctrl+X Blocklist Editor, TM Editor, Glossary Editor, Editor

Export Blocklist Alt+K Project

Export Glossary Alt+E Project

Export Package Ctrl+E Home

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Find/Replace Ctrl+F Editor

Go To Segment Ctrl+G Editor

Help Ctrl+Alt+H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist Alt+J Project

Import Glossary Alt+I Project

Import TM Ctrl+Shift+I Project

Insert non-breaking space Ctrl+Shift+Space Editor

Italic Ctrl+I Editor

Key Assist Panel Ctrl+Shift+L Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home
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Commands Shortcut View

Last Modified Segment Shift+F5 Editor

Leverage Previous TU Alt+Left Editor

Leverage the Next TU Alt+Right Editor

Merge Segments Alt+Page_Down Editor

Modify Alt+M Project

Modify Project Ctrl+Shift+M Home

Modify TM Ctrl+Shift+T Project

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctrl+Alt+Right Editor

Next Term Ctrl+Alt+9 Editor

Next Update Alt+Down Blocklist Editor

Next View Alt+W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open Reference Files Alt+2 Project

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctrl+Alt+Left Editor

Previous Term Ctrl+Alt+8 Editor

Pseudo translate Ctrl+Shift+Y Quick Tools

Redo Ctrl+Y Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Project Ctrl+Alt+R Home

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove tag Ctrl+Alt+Up Editor

Remove TM Ctrl+Shift+R Project

Replace/Find Ctrl+H Editor
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Commands Shortcut View

Save Ctrl+S Editor

Save As F12 Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters Ctrl+Shift+8 Editor

Simple Project Creator Ctrl+P Home

Spell Check F7 Editor

Split Segment Alt+Page_Up Editor

Strikethrough Ctrl+K Editor

Subscript Ctrl+= Editor

Superscript Ctrl+Shift+= Editor

Term Info Alt+T Editor

Terminology Highlight Ctrl+F5 Editor

TM Concordance Ctrl+Shift+F Editor

Translate File Ctrl+O Project

Translate Until Fuzzy Ctrl+Alt+F Editor

Translate Until No Match Ctrl+Shift
+Page_Down

Editor

Unconfirm All Segments Alt+Shift+Enter Editor

Underline Ctrl+U Editor

Undo Ctrl+Z Blocklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment Ctrl+Alt+V Editor

KEYBOARD SHORTCUTS

PC Scheme - SDLX Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blocklist Alt+C Project

Add Glossary Alt+O Project

Add Note Alt+Shift+N Editor

Add Project Ctrl+Shift+A Home

Add Project TMs Ctrl+Shift+B Quick Tools

Add Term Ctrl+Alt+T Glossary Editor
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Commands Shortcut View

Add Term Ctrl+T Editor

Add TM Ctrl+N Project

Analyze Ctrl+Space Editor

Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor

Clear Target Document Alt+Shift+Delete Editor

Clear Target Segment Ctrl+Alt+X Editor

Close Ctrl+Shift+W Editor

Close project from home window Ctrl+W Home

Commit All Segments to TM Alt+End Editor

Commit Current Segment Alt+Q Editor

Confirm/Unconfirm Segment Alt+Enter Editor

Confirm All Segments Ctrl+Shift+Enter Editor

Copy Ctrl+C Blocklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources Ctrl+Alt+Insert Editor

Copy All Tags (Document) Alt+Shift+P Editor

Copy All Tags (Segment) Alt+P Editor

Copy selected text to target Alt+F12 Editor

Copy Source F4 Editor

Copy Tag Ctrl+Alt+Down Editor

Copy Term Ctrl+Alt+0 Editor

Copy TM Ctrl+Shift+C Project

Create Blocklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage F8 Editor

Cut Ctrl+X Blocklist Editor, TM Editor, Glossary Editor, Editor

Delete Note Alt+Shift+D Editor

Edit Note Alt+Shift+E Editor

Edit Term Ctrl+E Editor

Export Blocklist Alt+K Project

Export Glossary Alt+E Project

Export Report as PDF format Alt+U Project
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Commands Shortcut View

Export TM Ctrl+Shift+E Project

Find/Replace Ctrl+F Editor

Go To Segment Ctrl+L Editor

Help Ctrl+Alt+H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist Alt+J Project

Import Glossary Alt+I Project

Import TM Ctrl+Shift+I Project

Insert copyright symbol Ctrl+Alt+C Editor

Insert ellipsis F11 Editor

Insert em dash Ctrl+F10 Editor

Insert en dash F10 Editor

Insert non-breaking hyphen Ctrl+F9 Editor

Insert non-breaking space Ctrl+Shift+Space Editor

Insert Registered Trademark
symbol

Ctrl+Alt+R Editor

Italic Ctrl+I Editor

Key assist panel Ctrl+Shift+L Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Leverage previous TU Alt+Left Editor

Leverage the first TM Lookup
match

Alt+1 Editor

Leverage the second TM
Lookup match

Alt+2 Editor

Leverage the third TM Lookup
match

Alt+3 Editor

Leverage the fourth TM Lookup
match

Alt+4 Editor

Leverage the fifth TM Lookup
match

Alt+5 Editor

Leverage the 6th TM Lookup
match

Alt+6 Editor

Leverage the 7th TM Lookup
match

Alt+7 Editor
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Commands Shortcut View

Leverage the 8th TM Lookup
match

Alt+8 Editor

Leverage the Next TU Alt+Right Editor

Machine Translate Ctrl+Shift+F8 Editor

Merge Segments Ctrl+J Editor

Modify Alt+M Project

Modify Project Ctrl+Shift+M Home

Modify TM Ctrl+Shift+T Project

Move the cursor between the
source and the target

Shift+Tab Editor

Next Segment (Commit to TM) Alt+Down Editor

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctrl+Alt+Right Editor

Next Term Ctrl+Alt+9 Editor

Next View Alt+W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) Ctrl+Up Editor

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctrl+Alt+Left Editor

Previous Term Ctrl+Alt+8 Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools

Redo Ctrl+Y Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove Tag Ctrl+Alt+Up Editor

Remove TM Ctrl+Shift+R Project
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Commands Shortcut View

Replace/Find Ctrl+H Editor

Run Transcheck F12 Editor

Save Ctrl+S Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters Ctrl+Shift+8 Editor

Simple Project Creator Ctrl+P Home

Source TM Lookup Ctrl+Shift+F Editor

Spell Check F6 Editor

Split Segment Ctrl+Enter Editor

Strikethrough Ctrl+K Editor

Subscript Ctrl+= Editor

Superscript Ctrl+Shift+= Editor

Term Info Alt+T Editor

Terminology Highlight Ctrl+F5 Editor

TM Concordance F7 Editor

Toggle uppercase/lowercase Shift+F3 Editor

Translate All Ctrl+Shift+End Editor

Translate File Ctrl+O Project

Translate Until Fuzzy Ctrl+Alt+F Editor

Translate Until No Match Ctrl+Shift
+Page_Down

Editor

Unconfirm All Segments Alt+Shift+Enter Editor

Underline Ctrl+U Editor

Undo Ctrl+Z Blocklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment Ctrl+Alt+V Editor

KEYBOARD SHORTCUTS

PC Scheme - Trados Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blocklist Alt+C Project

Add Glossary Alt+O Project
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Commands Shortcut View

Add Project TMs Ctrl+Shift+B Quick Tools

Add Reference Files Alt+1 Project

Add Term Ctrl+Alt+T Glossary Editor

Add Term Ctrl+F11 Editor

Add TM Ctrl+N Project

Analyze Ctrl+Space Quick Tools

Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor

Clear Target Document Alt+Shift+Delete Editor

Clear Target Segment Ctrl+Alt+X Editor

Close Ctrl+W Editor

Close project from home window Ctrl+Shift+X Home

Commit All Segments to TM Ctrl+Shift+U Editor

Commit Current Segment Alt+Q Editor

Confirm/Unconfirm Segment Alt+Enter Editor

Confirm All Segments Ctrl+Shift+Enter Editor

Copy Ctrl+C Blocklist Editor, TM Editor, Glossary Editor, Editor

Copy All Tags (Segment) Alt+P Editor

Copy selected text to target Alt+F12 Editor

Copy Source F4 Editor

Copy Tag Ctrl+F4 Editor

Copy Term Ctrl+Alt+Down Editor

Copy TM Ctrl+Shift+C Project

Create Blocklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage Alt+Space Editor

Cut Ctrl+X Blocklist Editor, TM Editor, Glossary Editor, Editor

Export Blocklist Alt+K Project

Export Glossary Alt+E Project

Export Package Ctrl+E Home

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project
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Commands Shortcut View

Go To Segment Ctrl+L Editor

Help Ctrl+Alt+H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist Alt+J Project

Import Glossary Alt+I Project

Import TM Ctrl+Shift+I Project

Insert en dash F10 Editor

Insert non-breaking space Ctrl+Shift+Space Editor

Italic Ctrl+I Editor

Key Assist Panel Ctrl+Shift+L Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Machine Translate Ctrl+Shift+F8 Editor

Merge Segments Ctrl+J Editor

Modify Alt+M Project

Modify Project Ctrl+Shift+M Home

Modify TM Ctrl+Shift+T Project

Move the cursor between the
source and the target

Shift+Tab Editor

Next Segment (Commit to TM) Enter Editor

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctrl+Alt+Right TM Editor

Next Update Alt+Down Blocklist Editor

Next View Alt+W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open Reference Files Alt+2 Project

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Tag Ctrl+Alt+Left Editor
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Commands Shortcut View

Previous Update Alt+Up Blocklist Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools

Redo Ctrl+Y Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Project Ctrl+Alt+R Home

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove TM Ctrl+Shift+R Project

Save Ctrl+S Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters Ctrl+Shift+8 Editor

Simple Project Creator Ctrl+P Home

Source TM Lookup Ctrl+Shift+F Editor

Spell Check F6 Editor

Split Segment Alt+S Editor

Strikethrough Ctrl+K Editor

Subscript Ctrl+= Editor

Superscript Ctrl+Shift+= Editor

Term Info Alt+T Editor

Terminology Highlight Ctrl+F5 Editor

TM Concordance F7 Editor

Translate All Ctrl+Shift+A Editor

Translate File Ctrl+O Project

Unconfirm All Segments Alt+Shift+Enter Editor

Underline Ctrl+U Editor

Undo Ctrl+Z Blocklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment Ctrl+Alt+V Editor

KEYBOARD SHORTCUTS

Mac Scheme - Wordfast Pro Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.
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Commands Shortcut View

Add Blocklist ⌥C Project

Add Glossary ⌥O Project

Add Note ⌥⇧N Editor

Add Project ⌘⇧A Home

Add Project TMs ⌘⇧B Quick Tools

Add Term ⌘⌥T Editor

Add TM ⌘N Project

Analyze ⌘Space Editor

Attach/Detach Toolbar ⌘D Editor

Bold ⌘B Editor

Clear all tags (Segment) ⌘⇧V Editor

Clear Target Document ⌥⇧⌦ Editor

Clear Target Segment ^⌥X Editor

Close ⌘W Editor

Close project from home window ⌘⇧X Home

Close segment # Editor

Commit All Segments to TM ⌘⌥↘# Editor

Commit Current Segment ⌥↘# Editor

Confirm/Unconfirm Segment ⌥↩# Editor

Confirm All Segments ⌘⇧↩# Editor

Copy ⌘C Blocklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources ⌘⌥Insert Editor

Copy All Tags (Document) ⌥⇧P Editor

Copy All Tags (Segment) ⌥A Editor

Copy selected text to target ⌥F12 Editor

Copy Source ⌥S Editor

Copy Tag ⌘⌥↓ Editor

Copy Term ⌘0 Editor

Copy TM ⌘⇧C Project

Create Blocklist ⌥B Project

Create Glossary ⌥N Project

Create TM ⌘⇧N Project

Current Segment Leverage ⌥Q Editor
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Commands Shortcut View

Cut ⌘X Blocklist Editor, TM Editor, Glossary Editor, Editor

Delete Note ⌥⇧D Editor

Edit Note ⌥⇧E Editor

Edit Term ⌘E Editor

Export Blocklist ⌥K Project

Export Glossary ⌥E Project

Export Report as PDF format ⌥U Project

Export TM ⌘⇧E Project

Find/Replace ⌘F Editor

Get Bilingual Table ⌘⌥P Editor

Go To Segment ⌘G Editor

Help ⌘⌥H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist ⌥J Project

Import Glossary ⌥I Project

Import TM ⌘⇧I Project

Insert a cent sign ⌘; Editor

Insert copyright symbol ⌘⌥C Editor

Insert ellipsis ⌘⌥. Editor

Insert em dash ⌥- Editor

Insert en dash ⌥⇧- Editor

Insert non-breaking hyphen ⌘⇧- Editor

Insert non-breaking space ⌘⇧Space Editor

Insert Registered Trademark
symbol

⌘⌥R Editor

Italic ⌘I Editor

Key Assist Panel ⌘⇧L Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment ⇧F5 Editor

Leverage Previous TU ⌘← Editor

Leverage the first TM Lookup
match

⌥1 Editor

Leverage the second TM
Lookup match

⌥2 Editor



14. Appendix Wordfast

Copyright © Wordfast, LLC 2023.   Page 221 of 236

Commands Shortcut View

Leverage the third TM Lookup
match

⌥3 Editor

Leverage the fourth TM Lookup
match

⌥4 Editor

Leverage the fifth TM Lookup
match

⌥5 Editor

Leverage the sixth TM Lookup
match

⌥6 Editor

Leverage the seventh TM
Lookup match

⌥7 Editor

Leverage the eighth TM Lookup
match

⌥8 Editor

Leverage the Next TU ⌘→ Editor

Machine Translate ⌘⇧M Editor

Merge Segments ⌥⇟ Editor

Modify ⌥M Project

Modify TM ⌘⇧T Project

Move the cursor between the
source and the target

⇧⇥ Editor

Next Segment (Commit to TM) ⌥↓ Editor

Next Segment (No Commit) ⌘↓ Editor

Next Tag ⌘⌥→ Editor

Next Term ⌘9 Editor

Next View ⌥W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist ⌥H Project

Open Glossary ⌥G Project

Open Project ⌘⇧P Home

Open TM ⌘⇧G Project

Paste ⌘V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) ⌘↑ Editor

Previous Segment (TM Commit) ⌥↑ Editor

Previous Tag ⌘⌥← Editor
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Commands Shortcut View

Previous Term ⌘8 Editor

Pseudo Translate ⌘⇧Y Quick Tools

Redo ⌘Y Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ⌥R Project

Remove Reference Files ⌥0 Project

Remove Report ⌥Z Project

Remove TM ⌘⇧R Project

Replace/Find ⌘H Editor

Run Transcheck ^Q Editor

Save ⌘S Editor

Save As F12 Editor

Save File As Translated ⌘⌥S Editor

Show White Space Characters ⌘⇧8 Editor

Simple Project Creator ⌘P Home

Source TM Lookup ⌘⇧F Editor

Spell Check F7 Editor

Split Segment ⌥⇞ Editor

Strikethrough ⌘K Editor

Subscript ⌘= Editor

Superscript ⌘⇧= Editor

Term Info ⌥T Editor

Terminology Highlight ⌘F5 Editor

TM Concordance F8 Editor

Toggle uppercase/lowercase ⇧F3 Editor

Translate All ⌘⇧↘# Editor

Translate File ⌘O Project

Translate Until Fuzzy ⌘⌥F Editor

Translate Until No Match ⌘⇧⇟ Editor

Unconfirm All Segments ⌥⇧↩# Editor

Underline ⌘U Editor

Undo ⌘Z Blocklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment ⌘⌥V Editor
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KEYBOARD SHORTCUTS

Mac Scheme - Wordfast Classic Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blocklist ⌥C Project

Add Glossary ⌥O Project

Add Note ⌥⇧N Editor

Add Project ⌘⇧A Home

Add Project TMs ⌘⇧B Quick Tools

Add Reference Files ⌥1 Project

Add Term ⌘⌥T Editor

Add TM ⌘N Project

Analyze ⌘Space Quick Tools

Attach/Detach Toolbar ⌘D Editor

Bold ⌘B Editor

Clear Target Document ⌥⇧⌦ Editor

Clear Target Segment ^⌥X Editor

Close project from home window ⌘⇧X Home

Commit All Segments to TM ⌘⌥↘# Editor

Confirm/Unconfirm Segment ⌥↩# Editor

Confirm All Segments ⌘⇧↩# Editor

Copy ⌘C Blocklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources ⌥⇧Insert Editor

Copy All Tags (Segment) ⌥P Editor

Copy Source ⌥Insert Editor

Copy Tag ⌘⌥↓ TM Editor

Copy Tag ⌥⇧↓ Editor

Copy Term ⌘⌥0 Editor

Copy TM ⌘⇧C Project

Create Blocklist ⌥B Project

Create Glossary ⌥N Project

Create TM ⌘⇧N Project
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Commands Shortcut View

Current Segment Leverage ⌥Q Editor

Cut ⌘X Blocklist Editor, TM Editor, Glossary Editor, Editor

Delete Note ⌥⇧D Editor

Edit Note ⌥⇧E Editor

Edit Term ⌘E Editor

Export Blocklist ⌥K Project

Export Glossary ⌥E Project

Export Package ⌘E Home

Export Report as PDF format ⌥U Project

Export TM ⌘⇧E Project

Find/Replace ⌘F Editor

Go To Segment ⌘G Editor

Help ⌘⌥H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist ⌥J Project

Import Glossary ⌥I Project

Import TM ⌘⇧I Project

Insert non-breaking space ⌘⇧Space Editor

Italic ⌘I Editor

Key Assist Panel ⌘⇧L Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment ⇧F5 Editor

Leverage Previous TU ⌘← Editor

Leverage the Next TU ⌘→ Editor

Merge Segments ⌥⇟ Editor

Modify ⌥M Project

Modify Project ⌘⇧M Home

Modify TM ⌘⇧T Project

Next Segment (No Commit) ⌘↓ Editor

Next Tag ⌥⇧→ Editor

Next Term ⌘⌥9 Editor

Next Update ⌥↓ Blocklist Editor

Next View ⌥W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home
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Commands Shortcut View

Open Blocklist ⌥H Project

Open Glossary ⌥G Project

Open Project ⌘⇧P Home

Open Reference Files ⌥2 Project

Open TM ⌘⇧G Project

Paste ⌘V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (TM Commit) ⌥↑ Editor

Previous Tag ⌘⌥← Editor

Previous Term ⌘⌥8 Editor

Pseudo Translate ⌘⇧Y Quick Tools

Redo ⌘Y Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ⌥R Project

Remove Project ⌘⌥R Home

Remove Reference Files ⌥0 Project

Remove Report ⌥Z Project

Remove tag ⌘⌥↑

Remove TM ⌘⇧R Project

Replace/Find ⌘H Editor

Save ⌘S Editor

Save As F12 Editor

Save File As Translated ⌘⌥S Editor

Show White Space Characters ⌘⇧8 Editor

Simple Project Creator ⌘P Home

Spell Check F7 Editor

Split Segment ⌥⇞ Editor

Strikethrough ⌘K Editor

Subscript ⌘= Editor

Superscript ⌘⇧= Editor

Term Info ⌥T Editor

Terminology Highlight ⌘F5 Editor

TM Concordance ⌘⇧F Editor
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Commands Shortcut View

Translate File ⌘O Project

Translate Until Fuzzy ⌘⌥F Editor

Translate Until No Match ⌘⇧⇟ Editor

Unconfirm All Segments ⌥⇧↩# Editor

Underline ⌘U Editor

Undo ⌘Z Blocklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment ⌘⌥V Editor

KEYBOARD SHORTCUTS

Mac Scheme - SDLX Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blocklist ⌥C Project

Add Glossary ⌥O Project

Add Note ⌥⇧N Editor

Add Project ⌘⇧A Home

Add Project TMs ⌘⇧B Quick Tools

Add Term ⌘T Editor

Add Term ⌘⌥T Glossary Editor

Add TM ⌘N Project

Analyze ⌘Space Editor

Attach/Detach Toolbar ⌘D Editor

Bold ⌘B Editor

Clear Target Document ⌥⇧⌦ Editor

Clear Target Segment ^⌥X Editor

Close ⌘⇧W Editor

Close project from home window ⌘W Home

Commit All Segments to TM ⌥↘# Editor

Confirm/Unconfirm Segment ⌥↩# Editor

Confirm All Segments ⌘⇧↩# Editor

Copy ⌘C Blocklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources ⌘⌥Insert Editor
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Commands Shortcut View

Copy All Tags (Document) ⌥⇧P Editor

Copy All Tags (Segment) ⌥P Editor

Copy selected text to target ⌥F12 Editor

Copy Source F4 Editor

Copy Tag ⌘⌥↓ Editor

Copy Term ⌘⌥0 Editor

Copy TM ⌘⇧C Project

Create Blocklist ⌥B Project

Create Glossary ⌥N Project

Create TM ⌘⇧N Project

Current Segment Leverage ⌥Q Editor

Cut ⌘X Blocklist Editor, TM Editor, Glossary Editor, Editor

Delete Note ⌥⇧D Editor

Edit Note ⌥⇧E Editor

Edit Term ⌘E Editor

Export Blocklist ⌥K Project

Export Glossary ⌥E Project

Export Report as PDF format ⌥U Project

Export TM ⌘⇧E Project

Find/Replace ⌘F Editor

Go To Segment ⌘L Editor

Help ⌘⌥H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist ⌥J Project

Import Glossary ⌥I Project

Import TM ⌘⇧I Project

Insert copyright symbol ⌘⌥C Editor

Insert ellipsis F11 Editor

Insert em dash ⌥- Editor

Insert en dash ⌥⇧- Editor

Insert non-breaking hyphen ⌘F9 Editor

Insert non-breaking space ⌘⇧Space Editor

Insert Registered Trademark
symbol

⌘⌥R Editor
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Commands Shortcut View

Italic ⌘I Editor

Key Assist Panel ⌘⇧L Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment ⇧F5 Editor

Leverage Previous TU ⌘← Editor

Leverage the first TM Lookup
match

⌥1 Editor

Leverage the second TM
Lookup match

⌥2 Editor

Leverage the third TM Lookup
match

⌥3 Editor

Leverage the fourth TM Lookup
match

⌥4 Editor

Leverage the fifth TM Lookup
match

⌥5 Editor

Leverage the sixth TM Lookup
match

⌥6 Editor

Leverage the seventh TM
Lookup match

⌥7 Editor

Leverage the eighth TM Lookup
match

⌥8 Editor

Leverage the Next TU ⌘→ Editor

Machine Translate ⌘⇧F8 Editor

Merge Segments ⌥J Editor

Modify ⌥M Project

Modify Project ⌘⇧M Home

Modify TM ⌘⇧T Project

Move the cursor between the
source and the target

⇧⇥ Editor

Next Segment (Commit to TM) ⌥↓ Editor

Next Segment (No Commit) ⌘↓ Editor

Next Tag ⌘⌥→ Editor

Next Term ⌘⌥9 Editor

Next View ⌥W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist ⌥H Project
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Commands Shortcut View

Open Glossary ⌥G Project

Open Project ⌘⇧P Home

Open TM ⌘⇧G Project

Paste ⌘V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) ⌘↑ Editor

Previous Segment (TM Commit) ⌥↑ Editor

Previous Tag ⌘⌥← Editor

Previous Term ⌘⌥8 Editor

Pseudo Translate ⌘⇧Y Quick Tools

Redo ⌘Y Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ⌥R Project

Remove Reference Files ⌥0 Project

Remove Report ⌥Z Project

Remove tag ⌘⌥↑ Editor

Remove TM ⌘⇧R Project

Replace/Find ⌘H Editor

Run Transcheck F12 Editor

Save ⌘S Editor

Save File As Translated ⌘⌥S Editor

Show White Space Characters ⌘⇧8 Editor

Simple Project Creator ⌘P Home

Source TM Lookup ⌘⇧F Editor

Spell Check F6 Editor

Split Segment ⌥↩# Editor

Strikethrough ⌘K Editor

Subscript ⌘= Editor

Superscript ⌘⇧= Editor

Term Info ⌥T Editor

Terminology Highlight ⌘F5 Editor

TM Concordance F7 Editor

Toggle uppercase/lowercase ⇧F3 Editor
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Commands Shortcut View

Translate All ⌘⇧↘# Editor

Translate File ⌘O Project

Translate Until Fuzzy ⌘⌥F Editor

Translate Until No Match ⌘⇧⇟ Editor

Unconfirm All Segments ⌥⇧↩# Editor

Underline ⌘U Editor

Undo ⌘Z Blocklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment ⌘⌥V Editor

KEYBOARD SHORTCUTS

Mac Scheme - Trados Style

 
This section only includes shortcuts with a default application-assigned keystroke sequence.

Commands Shortcut View

Add Blocklist ⌥C Project

Add Glossary ⌥O Project

Add Project TMs ⌘⇧B Quick Tools

Add Reference Files ⌥1 Project

Add Term ⌘F11 Editor

Add Term ⌘⌥T Glossary Editor

Add TM ⌘N Project

Analyze ⌘Space Quick Tools

Attach/Detach Toolbar ⌘D Editor

Bold ⌘B Editor

Clear Target Document ⌥⇧⌦ Editor

Clear Target Segment ^⌥X Editor

Close ⌘W Editor

Close project from home window ⌘⇧X Home

Commit All Segments to TM ⌘⇧U Editor

Confirm/Unconfirm Segment ⌥↩# Editor

Confirm All Segments ⌘⇧↩# Editor

Copy ⌘C Blocklist Editor, TM Editor, Glossary Editor, Editor

Copy All Tags (Segment) ⌥P Editor
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Commands Shortcut View

Copy selected text to target ⌥F12 Editor

Copy Source F4 Editor

Copy Tag ⌘F4 Editor

Copy Term ⌘⌥↓ Editor

Copy TM ⌘⇧C Project

Create Blocklist ⌥B Project

Create Glossary ⌥N Project

Create TM ⌘⇧N Project

Current Segment Leverage ⌥Q Editor

Cut ⌘X Blocklist Editor, TM Editor, Glossary Editor, Editor

Export Blocklist ⌥K Project

Export Glossary ⌥E Project

Export Package ⌘E Home

Export Report as PDF format ⌥U Project

Export TM ⌘⇧E Project

Go To Segment ⌘L Editor

Help ⌘⌥H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist ⌥J Project

Import Glossary ⌥I Project

Import TM ⌘⇧I Project

Insert en dash ⌥⇧- Editor

Insert non-breaking space ⌘⇧Space Editor

Italic ⌘I Editor

Key Assist Panel ⌘⇧L Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment ⇧F5 Editor

Machine Translate ⌘⇧F8 Editor

Merge Segments ⌘J Editor

Modify ⌥M Project

Modify Project ⌘⇧M Home

Modify TM ⌘⇧T Project

Move the cursor between the
source and the target

⇧⇥ Editor
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Commands Shortcut View

Next Segment (Commit to TM) ↩# Editor

Next Segment (No Commit) ⌘↓ Editor

Next Tag ⌘⌥→ TM Editor

Next Update ⌥↓ Blocklist Editor

Next View ⌥W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist ⌥H Project

Open Glossary ⌥G Project

Open Project ⌘⇧P Home

Open Reference Files ⌥2 Project

Open TM ⌘⇧G Project

Paste ⌘V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Tag ⌘⌥← Editor

Previous Update ⌥↑ Blocklist Editor

Pseudo Translate ⌘⇧Y Quick Tools

Redo ⌘Y Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ⌥R Project

Remove Project ⌘⌥R Home

Remove Reference Files ⌥0 Project

Remove Report ⌥Z Project

Remove TM ⌘⇧R Project

Save ⌘S Editor

Save File As Translated ⌘⌥S Editor

Show White Space Characters ⌘⇧8 Editor

Simple Project Creator ⌘P Home

Source TM Lookup ⌘⇧F Editor

Spell Check F6 Editor

Split Segment ⌥S Editor

Strikethrough ⌘K Editor

Subscript ⌘= Editor

Superscript ⌘⇧= Editor
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Commands Shortcut View

Term Info ⌥T Editor

Terminology Highlight ⌘F5 Editor

TM Concordance F7 Editor

Translate All ⌘⇧A Editor

Translate File ⌘O Project

Unconfirm All Segments ⌥⇧↩# Editor

Underline ⌘U Editor

Undo ⌘Z Blocklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment ⌘⌥V Editor

FAQs
How do I obtain a Wordfast Pro License and install the application?

  Wordfast products are try-before-you-buy. You can download a free 30-day Demo mode of Wordfast
Pro from wordfast.com. Demo mode has limited functionality until you enter the activation key. When
you purchase a Wordfast license, you can generate an activation key at wordfast.net by logging in
with your login email and password. Copy and save the activation key.

To activate Wordfast Pro, click on the Sidebar. Click either Online Registration or Manual
Registration and follow the instructions to activate your product using the activation key. Once
activated, Wordfast Pro changes from Demo mode to the full unlocked version.

What does Wordfast Pro Demo mode mean?

  When in Demo mode, you are limited to creating bilingual projects and storing up to 500 translation
units in your Translation Memory. To get a full version, you must upload a license. Refer to
Activation.

Why is my completed project now showing as less than 100% complete in my Projects List?

The latest version of Wordfast Pro contains a new segment state feature and an improved Progress
Bar. As a result, projects from legacy versions of Wordfast Pro might register as less than 100%
complete or N/A in the Projects List. To resolve the issue, open the project, then open the
translation file. If you have multiple translation files, chain them together. In the TXLF Editor view,
click Mark All Translated. Save and close the project. In the Project List view, click Recalculate
Progress. The project should now register as 100% complete.

What happens if I upload a corrupt file for translation when creating a project?

  If one of the files is corrupt or invalid, you can still create a project with clean files. The corrupt or
invalid file will not upload and you receive a warning message.

How do I chain individual files?

http://www.wordfast.com
http://www.wordfast.net
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  Instead of opening files one-by-one to display in individual tabs, you can chain files to open in a
single tab as long as these files are in the same batch. You cannot chain files across batches.
Chaining files has the following main advantages:

• Open hundreds of files within seconds.

• Filter or search and replace in one pass as opposed to once per individual file.

Why is the Analyze button inactive when I open a chained file for translation?

  The Analyze action you can normally access in TXLF Editor view is inactive when you open a
chained file because the translation memory cannot provide the best results.

What are the different ways to analyze files?

  The analysis process converts source files into TXLF, leverages the content against existing
translation memories, and generates a report listing matches, non-matches, word count, character
count, and segment count. You can analyze source files in the following ways:

• Analyze files within a project in the Current Projects view.

• Analyze any files outside of the project files on the Analysis tab in the Quick Tools view.

• Analyze a file open for translation in TXLF Editor view by clicking the Analyze button on the
Translation tab.

Refer to Analysis

How do I use Skip 100% and 100%+ Segments when using TXLF Editor view?

  To skip 100% and 100%+ segments when moving to a segment that requires linguistic changes, you
have two options:

• (Preferred) Set preferences to Skip 100% and 100%+ segments. This allows you to view the
100% and 100%+ segments for context while editing adjacent No Match and Fuzzy match or
MT pre-translations.

• Filter for All except 100% and Context match segments.

How do I update a TM with my translations?
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  To update a TM after you finish translating or editing a segment in TXLF Editor view, you must
commit it to the TM. Committing a segment will turn the color highlight from pink to purple. You can
commit a segment to the TM as follows:

• Move to the next segment clicking the Next Segment button, or by using Alt + Down Arrow.

• While your cursor is in a segment, click Commit on the Translation tab.

• Click Commit All on the Translation tab to add all the segments in the file to the TM.
If a segment does not require any changes, for example, if the 99% match or the MT match is
linguistically correct, you can change the Translation Memory settings in Preferences to add these
items to the TM. To change the TM settings:

•
Click .

• Click Translation Memory in the Current Project Preferences section.

• Select the items you would like to have committed to the TM when working in your project:

◦ Write 'exact' matches to TM

◦ Write 'unedited MT' to TM

◦ Write 'unedited fuzzy' to TM

How do I keep translations from updating the master TM?

  To prevent a segment from updating the TM:

1. Open the file for translation and click on the segment that you do not want to write to the TM.
2. In the TXLF Editor view, click Do Not Write To TM on the Translation tab. The Status

column displays , and does not update the TM.
3. To write the segment to the TM, select the segment and click Do Not Write To TM again. The

 is removed from the Status column, and the segment may then be updated to the TM.

How do I correctly apply inline formatting?

  You can apply inline formatting to the target segment in two ways:

1. You can enter tag(s) from the source language segment for basic styles such as bold and italic
using the buttons on the Formatting tab. However, these formatting buttons could introduce
tags in the target that do not match the source. Unless the linguist identifies these mismatched
tags using Transcheck and corrects them, they will prevent affected TXLF files from converting
into monolingual files at the align stage.

2. To avoid the mismatched tags, after opening a file for translation, go to Preferences > Tags
and select Show Formatting as Tags.
Since this preference persists from one WFP session to another, you only have to set it once.
This preference enables you to reuse tags from the source using the Copy button under the
Translation tab. If the tag preference is set to Show Text Formatting (when supported), you
must apply formatting using the buttons in the Formatting tab, unless you toggled segment-
by-segment from Tag Formatting to Tag Non-Formatting.

Why is the Whole Words Only check box inactive on the Find/Replace dialog?

  In the Find and Replace dialog, the Whole Words Only check box is inactive if you added multiple
words or punctuation to the Find field.
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What are Preferences and how do I access them?

  You can customize all user interface options and features in the preferences section.

To access preferences, on the Sidebar click .

• Configure preferences that will apply to all projects in the General Preferences section.

• Configure preferences that apply only to the currently active project in the Current Project
Preferences section.

• Configure advanced settings in the User Preferences section.
Refer to Configure Preferences.

How can I preview a file during translation?

  In TXLF Editor, on the File tab, click Preview, then select Live Preview, Office Preview, or Html
Preview from the drop-down menu. Live Preview works with Word, PowerPoint, or Markdown files.
It opens a preview of the target content for comparison to your source content. If you click on a line of
text in the preview document, your cursor will move to that segment in the TXLF file. Office Preview
will open a PDF preview of the current translation file. Html Preview will open a preview as an HTML
file, only if the source file was HTML.
Another option is to click Preview File, and a translated file will open if the source is available.
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